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Introduction
This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important
Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:
bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.
The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Caution:
Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Trademarks
Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.
Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.
PowerPC is a registered trademark of International Business Machines Corporation.
PCL® is a registered trademark of Hewlett-Packard Company.
3Com is a trade mark of 3Com corporation.
Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc
UPnP is a trademark of the UPnP Implementers Corporation.
Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and TrueType are trademarks of Apple Computer,
Inc., registered in the U.S. and other countries.
BonjourTM is a trademark of Apple Computer, Inc.,
UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.
IPS-PRINTTM Printer Language Emulation Copyright© 2000, Oak Technology, Inc., All Rights Re-
served.
The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.
Novell, NetWare are registered trademarks of Novell, Inc.
Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.
PictBridge is a trademark.
Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.
The proper names of the Windows operating systems are as follows:
• The product name of Windows® 95 is Microsoft® Windows 95.
• The product name of Windows® 98 is Microsoft® Windows 98.
• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).
• The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

Some illustrations in this manual might be slightly different from the machine.
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Manuals for This Printer

For particular functions, see the relevant parts of the manual.

❖ Safety Information
Provides information on safe usage of this machine. To avoid injury and pre-
vent damage to the machine, be sure to read this.

❖ Quick Installation Guide
Contains procedures for removing the printer from its box, connecting it to a
computer, and installing its driver.

❖ Hardware Guide
Contains information about paper and procedures such as installing options,
replacing consumables, responding to error messages, and resolving jams.

❖ Software Guide (This manual)
Contain procedures for using this machine in a network environment, utiliz-
ing the software, and using security functions.

❖ Security Guide
This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use. Also refer to this manual for the
procedures for registering administrators, as well as setting user and admin-
istrator authentication.
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Description for the Specified Model

In this manual, the following items explain about the printer for the specified
models:

This explains about the 220–240 V model printer. You can identify the model by
checking the label on the rear of the printer.
Read if you purchase this model.

This explains about the 120 V model printer. You can identify the model by
checking the label on the rear of the printer.
Read if you purchase this model.

Note
❒ You can identify the printer's model by checking the label on the rear of the

printer as shown.

AQC065S
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the Safety Information.

Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
Safety Information.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the printer’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.
[ ]
Indicates the names of keys that appear on the printer’s display panel.
{ }
Indicates the names of keys on the printer’s control panel.
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1. Preparing for Printing
1

Quick Install

Windows 95/98/Me/2000/XP, and Windows Server 2003, users can easily in-
stall this software using the CD-ROM provided.
Using Quick Install, the PCL printer driver and/or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

Important
❒ To install printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrator.

❒ The Quick Install is not available when using this printer under USB connection.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.

E After reading the agreement, click [I accept the agreement.], and then click
[Next >].

F Select the printer model you want to use in the [Select Printer] dialog box.
For network connection via TCP/IP, select the printer whose IP address is
displayed in [Connect To].
For parallel connection, select the printer whose printer port is displayed in
[Connect To].

G Click [Install].
The printer driver installation starts.

H Click [Finish].
A message about restarting the computer may appear. Restart the computer
to complete installation.

I Click [Exit] in the first dialog box of the installer, and then take out the CD-
ROM.
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ Select a printer to whose IP address is displayed in [Connect To] to install

SmartDeviceMonitor for Client when using TCP/IP.
❒ Download the printer driver from the supplier's web site when using un-

der Windows NT 4.0.

Reference
Quick Install is not available unless bidirectional communication between
the printer and computer is enabled via parallel connection. See p.54 “If Bi-
directional Communication is Disabled” for details about bidirectional
communication between printer and computer.
If you connect using USB, see p.39 “Installing the Printer Driver Using
USB”.
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Confirming the Connection Method

This printer supports network and local connection.
Before installing the printer driver, check how the printer is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This printer can be used as a Windows printing port or network printer.

Using this printer as the Windows printing port

Network connections can be established through Ethernet and IEEE 802.11b.
Available ports are determined based on the combination of Windows operating
system version and connection method used.

❖ Windows 95/98

❖ Windows Me

❖ Windows 2000

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

Ridoc IO Navi

 -TCP/IP

  -IPP

Ridoc IO Navi

 -TCP/IP

  -IPP

Standard TCP/IP

LPR

Ridoc IO Navi

 -TCP/IP

 -IPP

Standard TCP/IP

LPR

Ridoc IO Navi

 -TCP/IP

  -IPP

LPR

Windows 95/98/Me Windows XP/
Server 2003

Windows NT 4.0Windows 2000

ZZZ036S
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❖ Windows XP

❖ Windows Server 2003

❖ Windows NT 4.0

Reference
See the explanation of how to install the printer driver for each type of port.
For the SmartDeviceMonitor for Client port, see p.7 “Using the SmartDevice-
Monitor Port”.
For the Standard TCP/IP port, see p.21 “Using the Standard TCP/IP Port”.
For the LPR port, see p.26 “Using the LPR Port”.

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

Standard TCP/IP

LPR port

Connection Method Available Ports

Ethernet/IEEE 802.11b SmartDeviceMonitor for Client port

LPR port
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Using as a network printer

This printer can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Important
❒ In an IPv6 environment, Netware servers cannot be used.

Reference
See the explanation of how to install the printer driver for each type of net-
work printer.
For the Windows network printer, see p.30 “Using as the Windows Network
Printer”.
For the NetWare print server and remote printer, see p.35 “Using as the Net-
Ware Print Server/Remote Printer”.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server

Windows 95/98/Me Windows 2000 Windows XP/
Server 2003

Windows NT 4.0

NetWare
Print Server

NetWare
File Server

ZZZ003S
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Local Connection

Local connections can be established via parallel, USB, and Bluetooth connec-
tions.
Windows operating system version determines the available connection meth-
ods.
• Windows 95:

• Parallel connection
• Windows 98:

• Parallel connection
• Windows 98 SE/Me:

• USB, Parallel, and Bluetooth connections
• Windows 2000:

• USB, Parallel, and Bluetooth connections
• Windows XP:

• USB, Parallel, and Bluetooth connections
• Windows Server 2003:

• USB, Parallel, and Bluetooth connections
• Windows NT 4.0:

• Parallel connection

Reference
See the explanation of how to install the printer driver for each method of
connection.
For the USB connection, see p.39 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.44 “Printing with Parallel Connection”.
For the Bluetooth connection, see p.48 “Printing with Bluetooth Connec-
tion”.
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Using the SmartDeviceMonitor Port

Installing DeskTopBinder-SmartDeviceMonitor for Client

Important
❒ To install SmartDeviceMonitor for Client under Windows 2000/XP Profes-

sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [DeskTopBinder - SmartDeviceMonitor for Client].

E Select an interface language, and then click [Next >].
The default interface language is English.

F The message to quit all other applications appears. Quit all applications,
and then click [Next >].

G Click [Yes]

H The DeskTopBinder Lite Setup dialog appears, and then click [Next >].

I The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

J Click [Full install] or [Custom Install].
[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.
[Custom Install] installs selected applications.

K Follow the instructions on the display and click [Next>] to proceed next step.

L After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
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Installing the PCL or RPCS Printer Driver (TCP/IP)

Important
❒ To install this printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the printer model you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [SmartDeviceMonitor], and then click [OK].

L Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

M Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IP address
or host name of the printer.

N Check that the port of the selected printer is displayed in [Port:].

O Set a [User Code], if necessary.
Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols are available.
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P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
Installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ Under Windows 95/98/Me, you cannot add an IPv4 address partially sim-

ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used.

❒ This allows a SmartDeviceMonitor for Admin user to display and check
statistics about the number of sheets which each user prints. For details,
see SmartDeviceMonitor for Admin Help.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, install using [Add Printer]. See
p.51 “If a Message Appears during Installation”.

Installing the PCL or RPCS Printer Driver (IPP)

Important
❒ To install printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.
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G Select the printer model you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

I Click [Port:], and then click [Add].

J Click [SmartDeviceMonitor], and then click [OK].

K Click [IPP].

L In the [Printer URL] box, enter “http://printer's address/printer” as the printer's
address.
If the server authentification is issued, to enable SSL( a protocol for encrypted
communication), enter “https://printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://printer's address/ipp” as the printer's address.
If you are using Firefox or Netscape under Windows XP SP2 or Windows
Server 2003, you can enter IPv6 address as “http:// IPv6 printer's ad-
dress/printer”.

M Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

N Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

O Click [OK].

P Check that the port of the selected printer is displayed in [Port:].

Q Set a [User Code], if necessary.
Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

R Select the [Default Printer] check box to configure the printer as default.

S Click [Continue].
Installation starts.

T After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ This allows a SmartDeviceMonitor for Admin user to display and check

the number of sheets each user prints. For details, see SmartDeviceMonitor
for Admin Help.

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.51 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].
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M On the [Details] tab, click [Add Port…].

N Click [DeskTopBinder-SmartDeviceMonitor] in the [Other] list, and then click [OK].

O Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

P Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.
You cannot add an IPv4 address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

Q Click [OK].

R Check that the selected port is highlighted in [Printer to the following port], and
then click [OK].

S Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ A User Code can be set after the printer driver installation. For information

about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

Important
❒ IPv6 cannot be used under Windows 95/98/Me.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.
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G Select the name of the printer whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

M On the [Details] tab, click [Add Port…].

N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

O Click [IPP].

P In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's
address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

Q Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

R Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

S Click [OK].

T Check that the selected port is highlighted in [Printer to the following port], and
then click [OK].

U Restart the computer to complete installation.
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [next >].

G Click [Create a new port...].

H Click [DeskTopBinder-SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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M Specify whether or not to share the printer, and then click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ IPv6 cannot be used under Windows 2000.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTopBinder-SmartDeviceMonitor], and then click [Next >].

I Click [IPP].
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J In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's
address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

L Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].

N Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

O Change the printer name if you want, and then click [Next >].

P Click [Next >].

Q Specify whether or not to print a test page, and then click [Next >].

R Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - TCP/IP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTopBinder-SmartDeviceMonitor], and then click [Next >].

I Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

J Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a printer not listed here, click [Specify Address], and then enter the IPv4 ad-
dress or host name of the printer.

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Specify whether or not to print a test page, and then click [Next >].

N Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe”on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - IPP)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [DeskTopBinder-SmartDeviceMonitor], and then click [Next >].

I Click [IPP].

J In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's
address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).
(example IPv4 address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter “http://(printer's address)/ipp” as the printer's address.
If you are using Firefox or Netscape under Windows XP SP 2 or Windows
Server 2003, you can enter IPv6 address as “http://IPv6 printer's ad-
dress/printer”.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

L Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.
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M Click [OK].

N Check that the name of the printer driver you want to install is selected, and
then click [Next >].

O Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

P Specify whether or not to print a test page, and then click [Next >].

Q Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95/98:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C Click the [Details] tab, and then click [Configure Port].
The [Port Settings] dialog box appears.

Windows 2000/Windows NT 4.0:

A Open [Printers] window from [Start] menu.

B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port...].
The [Port Configuration] dialog box appears.
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Windows XP, Windows Server 2003:

A Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties]. The printer properties appear.

C Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

Note
❒ For TCP/IP, timeout setting can be configured.
❒ User, proxy, and timeout settings can be configured for IPP.
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow the

procedure below.
A Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the SmartDe-

viceMonitor for Client icon on the tasktray.
C Point to [Properties], and then click [Extended Features Settings].
D Select the [Set Recovery/Parallel Printing for each port] check box.
E Click [OK] to close the [Extended Features Settings] dialog box.

Reference
For information about these settings, see SmartDeviceMonitor for Client
Help.
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Using the Standard TCP/IP Port

Installing the PCL or RPCS Printer Driver

Important
❒ To install printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the printer model you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [Standard TCP/IP Port], and then click [OK].
Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

L Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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M Enter the printer name or IPv4 address in the [Printer Name or IPv4 Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

N Click [Next >].

O Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

P Check that the port of the selected printer is displayed in [Port:].

Q Configure the default printer as necessary.

R Click [Continue].
The printer driver installation starts.

S After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.51 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
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C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IPv4 address in the [Printer Name or IPv4 Address]
box, and then click [Next >].
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

K Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

L Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

N Click [Next >].

O Specify whether or not to print a test page, and then click [Next>].

P Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation . For informa-
tion about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the

SmartDeviceMonitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this printer], and then click [Next >].

G Click [Create a new port:].

H Click [Standard TCP/IP Port] in [Create a new Port], and then click [Next >].

I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

J Enter the printer name or IPv4 address in the [Printer Name or IPv4 Address] box.
The [Port Name] text box automatically obtains a port name. Change this name
if necessary.
When screen for Device selection appears, select “RICOH NetworkPrinter
Driver C Model”.

K Click [Next >].

L Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

M Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

N Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

O Specify whether or not to print a test page, and then click [Next >].
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P Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using the LPR Port

Installing the PCL or RPCS Printer Driver

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-
Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

G Select the printer model you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

H Click [Next >].

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].

K Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

L Enter the printer's IPv4 address in the [Name or address of server providing lpd] box.

M Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].
The port is added.
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N Check that the port of the selected printer is displayed in [Port:].

O Configure the default printer as necessary.

P Click [Finish].
The printer driver installation starts.

Q After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.51 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-

Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer], and then click [Next >].

G Click [Create a new port:].
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H Click [LPR Port], and then click [Next >].

I Enter the printer's IPv4 address in the [Port Name] box, and then click [OK].

J Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to share the printer, and then click [Next >].

M Specify whether or not to print a test page, and then click [Next >].

N Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ In an IPv6 environment, you cannot use the LPR Port. Use the SmartDevice-

Monitor port.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].



Using the LPR Port

29

1

F Click [Local Printer attached to this computer.], and then click [Next >].

G Click [Create a new port:].

H Click [LPR Port] in [Create a new Port], and then click [Next >].

I Enter the printer's IP address in the [Name or address of server providing lpd] box.

J Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].

K Check that the name of the printer whose driver you want to install is se-
lected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].

N Specify whether or not to print a test page, and then click [Next >].

O Click [Finish].
The printer driver installation starts.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PCL or RPCS Printer Driver

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000/XP, or Windows Server 2003 shared
printer.
This section assumes that the client has already been configured to communicate
with a Windows 2000/XP, or Windows Server 2003 print server. Do not begin
the following procedure before the client is set up and configured correctly.

Important
❒ To install printer driver under Windows 2000/XP Professional, and Win-

dows Server 2003, you must have an account that has Manage Printers per-
mission. For this, log on as an Administrators or Power Users group member.

❒ If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

❒ If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next].

F Select a printer driver you want to use in the [Printer Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Click [Port:], and then click [Add].
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K Click [Network Printer], and then click [OK].

L Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

M Select the printer you want to use, and then click [OK].

N Check that the port of the selected printer is displayed in [Port:].

O Configure the [User Code] as necessary.
For an RPCS printer driver, a User Code can be set after the printer driver in-
stallation. For information about User Code, see the printer driver Help.

P Select the [Default Printer] check box to configure the printer as default.

Q Click [Continue].
The printer driver installation starts.

R After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.51 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

Important
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
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D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network Printer], and then click [Next >].

G Click [Browse].

H Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

I Select the printer you want to use, and then click [OK].

J Check the location of the selected printer is shown, and then click [Next >].

K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].

M Restart the computer.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.
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D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Network printer], and then click [Next >].

G Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers:] window.

I Select the printer you want to use, and then click [Next].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the SmartDevice-

Monitor port, the client cannot use Recovery Printing and Parallel Printing.
❒ If you print with a Windows XP or Windows Server 2003 print server, Smart-

DeviceMonitor notification functions may not be possible for the client.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
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C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [A network printer, or a printer attached to another computer], and then click
[Next >].

G Select [Browse for a printer], then click [Next].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].

J The printer driver installation starts.

K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Using as the NetWare Print Server/Remote 
Printer

This explains how to set up the Windows computer used as the NetWare client.

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

❒ In an IPv6 environment, Netware servers cannot be used.
The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.
Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:
• Operating system: Windows 98
• NetWare version: 4.1
• File server name: CAREE
• Queue name: R-QUEUE

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

C Click [PCL/RPCS Printer Drivers].

D The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

F Click [Next >].

G Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

H Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.
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I Click [Port:], and then click [Add].

J Click [Network Printer], and then click [OK].

K Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

L Select the print queue, and then click [OK].

M Check that the port of the selected printer is displayed in [Port:].

N Click [Continue].
The printer driver installation starts.

O Click [Finish] in the [Select Program] dialog box.

P After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
Restart the computer to complete installation.

Q After restarting the computer, launch the [Printers] window, and then open
the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

R Click [Finish] in the [Introduction complete] dialog box.

S In the [Printers] window, open the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

T On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.
Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.
Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

U Click [OK] to close the printer properties dialog box.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.
❒ The protocol is set to inactive as default. Enable it using Web Image Mon-

itor or Telnet
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When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

Important
❒ In an IPv6 environment, Netware servers cannot be used.

A In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.
When using Windows 2000/XP or Windows NT 4.0, click the [Device Settings]
tab, and then proceed to step to clear the check box.

C Click [Advanced].

D Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

E Click [OK] to close the printer properties dialog box.

Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly.
Follow the procedure below to disable form feed according to the operating sys-
tem used:
• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-

tings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear

the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.
Follow the procedure below to disable banner pages according to the operating
system used:
• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer

Settings] tab in the printer properties dialog box.
• Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, clear

the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.
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Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.
To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.
Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.
The printer drivers can be installed from the CD-ROM provided with this printer.

Windows Me - USB

Important
❒ Installation via USB is not possible under Windows 95/98. Upgrade to Win-

dows Me or later.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

A Download USB Printing Support from the supplier's Web site.
Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.
Save it where you can locate it easily.

B Check that the power of the printer is off.

C Connect the printer and computer using the USB cable.
Connect the USB cable firmly.

D Turn on the power of the printer.
The plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the op-
erating system.

E Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

F Specify the location where USB Printing Support is located, and then click
[Next >].

G Check the location, and then click [Next >].
USB Printing Support is installed.

H Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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I Insert the printer driver. Click [Search for the best driver for your device. [Recom-
mended]], and then click [Next >].

J Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

K Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

L Specify the location where USB Printing Support is located, and then click
[Next >].
If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:
• RPCS

D:\DRIVERS\RPCS\WIN9X_ME\(Language)\DISK1
• PCL 5c (for colour printing)

D:\DRIVERS\PCL5C\WIN9X_ME\(Language)\DISK1
• PCL 6

D:\DRIVERS\PCL6\WIN9X_ME\(Language)\DISK1
• PostScript 3

D:\DRIVERS\PS\WIN9X_ME\(Language)\DISK1

M Check the location, and then click [Next >].
Add Printer Wizard starts.

N Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

Note
❒ The number after “USB” varies depending on the number of printers con-

nected.
❒ It is not necessary to reinstall USB Printing Support when connecting a dif-

ferent printer via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,

follow the plug-and-play instructions of the printer.
❒ Install the printer driver from the CD-ROM provided with the printer.
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Windows 2000 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Check that the power of the printer is off.

B Connect the printer and computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the printer.
Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

E Select the [Specify location] check box, and then click [Next >].

F Insert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

G Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c

D:\DRIVES\PCL5c\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVES\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

H Check the printer driver location, and then click [OK].

I Click [Next >].

J Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB001” port is added to the [Printers] window.

Note
❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM into the

drive and keep it pressed until the computer finishes reading from the CD-ROM.
❒ The number after “USB” varies depending on the number of printers connected.
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Windows XP, Windows Server 2003 - USB

Important
❒ Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
The printer drivers can be installed from the CD-ROM provided with this printer.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Check that the power of the printer is off.

B Connect the printer and computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the printer.
Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

E Insert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

F Select the [Include this location in the search] check box under [Search for the best driver
in these location], and then click [Browse] to select the printer driver location.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• RPCS

D:\DRIVES\RPCS\WIN2K_XP\(Language)\DISK1
• PCL 5c

D:\DRIVES\PCL5c\WIN2K_XP\(Language)\DISK1
• PCL 6

D:\DRIVES\PCL6\WIN2K_XP\(Language)\DISK1
• PostScript 3

D:\DRIVES\PS3\WIN2K_XP\(Language)\DISK1

G Check the printer driver location, and then click [Next >].

H Click [Continue].

I Click [Finish].
If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.
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Note
❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

❒ The number after “USB” varies depending on the number of printers con-
nected.

Troubleshooting USB

Problem Solutions

The printer is not recognized auto-
matically.

Turn off the power of the printer, reconnect the USB cable, 
and then turn it on again.

Windows has already configured 
the USB settings.

Open Windows' Device Manager, and then, under [Univer-
sal Serial Bus controllers], remove any conflicting devices. 
Conflicting devices have a [!] or [?] icon by them. Take 
care not to accidentally remove required devices. For de-
tails, see Windows Help.

When using Windows 2000/XP or Windows Server 2003, 
an erroneous device is displayed under [USB Controller] in 
the [Device Manager] dialog box.

Windows ME and the printer can-
not be connected.

Download USB Printing Support from the supplier's web-
site.

Search the model name you use on the supplier's website, 
and download USB Printing Support.
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Printing with Parallel Connection

To use a printer connected using a parallel interface, click [LPT1] when installing
the printer driver.

Installing the PCL or RPCS Printer Driver

Important
❒ To install this printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PCL/RPCS Printer Drivers].

E The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [I accept the agreement.], and then click [Next >].

F Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

G Click [Next >].

H Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for  'Printer Name'] box.

I Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

J Check that [LPT1:] is shown in [Port:].

K Select the [Default Printer] check box to configure the printer as default.

L Click [Finish].
The printer driver installation starts.

M After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].
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Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ To stop installation of the selected software, click [Cancel] before installa-

tion is complete.

Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See p.51 “If a
Message Appears during Installation”.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the printer whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].

I Change the printer name if you want, and then click [Next].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].

K Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].

H Select whether or not to share the printer, and then click [Next >].

I Select the name of the printer whose driver you want to install, and then
click [Next >].

J Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

K Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important
❒ Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].

F Click [Local printer attached to this computer], and then click [Next >].

G Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

H Select the name of the printer whose driver you want to install, and then
click [Next >].

I Click [Close] to close the [Printer Port] dialog box.

J Click [Next >].

K Change the printer name if you want, and then click [Next >].

L Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

M Restart the computer to complete installation.

Note
❒ Auto Run may not work with certain operating system settings. If this hap-

pens, launch “Setup.exe” on the CD-ROM root directory.
❒ The printer driver with the selected language will be installed. The English

printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

❒ A User Code can be set after the printer driver installation. For information
about User Code, see the printer driver Help.
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Printing with Bluetooth Connection

Supported Profiles

❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers

can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• Conditions for bidirectional communications
• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.

❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in

the printer.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-

nected via BIP.
• Only JPEG images that can be printed using BIP.
• User Codes are disabled for BIP.

You cannot print if print functions are restricted.
• Some printers do not support BIP.

Note
❒ In this manual, the instruction referred to print using SPP. To print using

HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

Important
❒ To install the printer driver under Windows 2000/XP Professional, Windows

Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

A Start 3Com Bluetooth Connection Manager.

B Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.
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C On the [Tool] menu, click [COM port].

D Check that the message “Bluetooth Serial Client (COMx) ” appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].

F On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

G Click the icon of the printer you want to use.

H On the [File] menu, click [Properties].

I Click the [Ports] tab.

J Under [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

K Click [OK].
Close the [Printers] window.

Note
❒ System requirements vary depending on the Bluetooth standard and spec-

ifications. For details, see the manuals provided with each product.
❒ For information about setting up Bluetooth under other operating systems

or using it with different utilities, see the manuals provided with those op-
erating systems or utilities.

❒ To always use the same printer, select the [Always use for this connection]
check box.

❒ If a dialog box appears while transmitting a print job, reestablish network
connection as follows:
A Select the printer you want to use in the [Printers and Faxes] box.
B Click [Connect].

Reference
For details, see the manuals provided with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to configure the security mode settings.

A Start 3Com Bluetooth Connection Manager.

B On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.50 “Send the print job to the printer in use.”.
For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals provided with the utility.

D Click [OK].
Close the [Security Mode] dialog box.

Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.50 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

A Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.

C Enter the Bluetooth password, and then click [OK].
As the Bluetooth password, enter the last four digits of the printer's serial
number. You can find the serial number on the label on the back of the printer.
For example, if the serial number is 00A0-001234, the Bluetooth password is
1234.

D The print job is sent.

Note
❒ The Bluetooth password differs for each printer and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].

B Double-click the Add Printer icon.

C Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is either \DRIVERS\RPCS\WIN9X_ME, or \DRIVERS\RPCS\WIN2K_XP.
If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

A On the [Start] menu, click [Printers and Faxes].

B Click [Add a printer].

C Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.

For Windows XP Home Editions:

A On the [Start] menu, click [Control Panel].

B Click [Printers and Other Hardware].

C Click [Printers and Faxes].

D Click [Install Printer].

E Follow the instructions in Add Printer Wizard.

Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver

is \DRIVERS\RPCS\WIN2K_XP. If the installer starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the printer using the printer driver when bidirectional
communication is disabled.

Reference
For details about making option settings for the printer, see p.54 “If Bidirec-
tional Communication is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check printer sta-
tus from your computer.
• Bidirectional communication is supported by Windows 95/98/Me/2000/XP,

Windows Server 2003, and Windows NT 4.0.
• If you use the RPCS printer driver and bidirectional communication is ena-

bled under Windows 2000, the [Change Accessories...] tab is unavailable.

Note
❒ The RPCS printer driver supports bidirectional communications and updates

the printer status automatically.
❒ The PCL printer driver supports bidirectional communications. You can up-

date printer status manually.
❒ The PostScript 3 printer driver does not support bidirectional communications.
To support bidirectional communication, the following conditions must be met:

❖ When connected with parallel cables
• The computer must support bidirectional communication.
• The printer must support bidirectional communication.
• The interface cable must support bidirectional communication.
• The printer must be connected to the computer using the standard parallel

cables and parallel connectors.
• Under Windows 2000, [Enable bidirectional support] must be selected, and

[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.
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❖ When connected with the network
• The printer must support bidirectional communication.
• SmartDeviceMonitor for Client included on the CD-ROM must be in-

stalled, and TCP/IP must be used.
• Under Windows 2000, [Enable bidirectional support] must be selected, and

[Enable printer pooling] must not be selected on the [port] tab with the RPCS
printer driver.

• In addition to the above, one of the following conditions must also be met:
• The SmartDeviceMonitor for Client port and the TCP/IP protocol must

be used.
• The standard TCP/IP port must be used without changing the default

port name (for Windows 2000/XP and Windows Server 2003).
• Microsoft TCP/IP print IPv4 address must be specified for use (for Win-

dows NT 4.0).
• IPP port name must include the IPv4 address when using the IPP pro-

tocol.

❖ When connected with USB
The printer must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

Note
❒ Install SmartDeviceMonitor for Client from the CD-ROM provided.



Preparing for Printing

54

1

If Bidirectional Communication is Disabled

Set up option settings when bidirectional communications are disabled.

Important
❒ Under Windows 2000/XP and Windows Server 2003, Manage Printers per-

mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

D Click the [Change Accessories] tab.
If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.
If you are using the RPCS printer driver, click the [Change Accessories...] tab.
If you are using the PS printer driver, click the [Device Settings] tab.

E Select options installed from the [Option] area, and then make the necessary
settings.

F Select the total amount of the memory in [Total Memory:], when the optional
SDRAM module is added.

G Under [Paper source tray settings], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

H Click [OK] to close the printer properties dialog box.
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Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.
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CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

CMake the necessary settings, and then click [OK] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
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DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.
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CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.
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RPCS - Accessing the Printer Properties

Windows 95/98/Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.
“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

❖ Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

❖ Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details about settings, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].

D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.
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A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.



RPCS - Accessing the Printer Properties

65

2

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.
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DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Apply] to start printing.
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Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.
When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.
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Making Printer Default Settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [Apply].

D Click [OK] to start printing.
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Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.
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PostScript 3 - Setting Up for Printing

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

E Click [OK].

Note
❒ With some applications, the printer driver settings are not used, and the

application's own default settings are applied.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].
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D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

Important
❒ You cannot change the printer default settings for each user. Settings made in

the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

A On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.

CMake the necessary settings, and then click [Print] to start printing.

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary de-

pending on the application. For details, see the manuals provided with the
application you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears .

B Click the icon of the printer you want to use.

C On the [File] menu, click [Properties].
The printer properties dialog box appears.

DMake the necessary settings, and then click [OK].
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Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].

Reference
For details about settings, see the printer driver Help.

Making Printer Default Settings - Default

Important
❒ To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

DMake the necessary settings, and then click [OK].

Note
❒ Settings you make here are used as the default settings for all applications.

Reference
For details about settings, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name:] list, and then click [Properties].
The printer properties dialog box appears.

CMake the necessary settings, and then click [OK].
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D Click [OK] to start printing.

Note
❒ The procedure to open the printer properties dialog box may vary depend-

ing on the application. For details, see the manuals provided with the ap-
plication you use.

❒ With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

Reference
For details about settings, see the printer driver Help.

Mac OS - Setting Up for Printing

Making Paper Settings from an Application

A Open the file you want to print.

B On the [File] menu, click [Page Setup].

C Check that the printer you want to use is displayed in [Printer:], and then se-
lect the paper size you want to use in [Paper:].
Under Mac OS X, select the paper size in [Paper Size].
If the printer you want to use is not displayed in [Printer:], select the printer
you want to use.

D Configure the settings, and then click [OK].

Reference
The [Page Setup] dialog box varies depending on the application you use.
For details, see the manuals provided with the Mac OS.

Setting up for Printing from an Application

A Open the file you want to print.

B On the [File] menu, click [Print].

C Check that the printer is selected in the [Printer] list, and then make the
printer settings.

D Configure the settings, and then click [OK].
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Printing a PDF File Directly

You can send PDF files directly to this printer for printing, without having to
open a PDF application.

Important
❒ This function is possible for genuine Adobe PDF files only.
❒ Version 1.3, 1.4, 1.5, and 1.6 PDF files are compatible.
❒ Transparency (function of PDF version 1.4) may not be printed.
❒ Crypt Filter and 16bit colour image (functions of PDF version 1.5) are not

compatible.
❒ PDF version 1.6 exclusive functions are not compatible. 
❒ Some types of High Compression PDF files may not be printed. Consult your

sales representative about the supported file types.

Note
❒ Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing DeskTopBinder Lite or by entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].

D Click [DeskTopBinder - SmartDeviceMonitor for Client] , and then click [Next >].

E Follow the instructions on the display to install DeskTopBinder Lite.
If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.

Note
❒ Auto Run may not work under certain operating system settings. In this

case, launch “Setup.exe” located on the CD-ROM root directory.
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DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files di-
rectly.

A On the [Start] menu, click [Programs], [DeskTopBinder Lite], and [Extended Fea-
tures Wizard].

BWhen [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Function3] screen appears.

C On the [Printing Function3] screen, click [Add...] to display [PDF Direct Print Prop-
erties].

D Select the driver for this printer, click [OK], and then click [Next >] repeated-
ly until [Finish] is displayed.
Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

A Right-click the icon that is added to the task bar, and then click [Properties..]
to display the Properties screen.

B Click the [Contents] tab, select the [PDF Direct Print] check box at the center,
and then click [OK].
The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

PDF Direct Printing

Use the method below to print PDF files directly.

A Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

B [Output File List- PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.
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Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

A In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

BWhen [Extended Features Wizard] appears, select [Start], and then click [Next >]
repeatedly until the [Printing Function3] screen appears.

C On the [Printing Function3] screen, click [Properties...] to display [PDF Direct Print
Properties].

D Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].
Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

EMove the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

F [Output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click
[OK].

G The [PDF Direct Print Properties] screen opens.
Enter the password for the PDF file you want to print in the [PDF password:]
field at the bottom right of the screen, and then click [OK].
The password-protected PDF file is printed.

Important
❒ Before printing a password-protected PDF file, perform one of the following:

• Enter the PDF password in the PDF Direct Printing Properties screen
• Specify a PDF password by selecting [Change PDF Password] in the [PDF

Menu] menu on the control panel of this printer
❒ If a [PDF Group Password] for the [PDF Menu] menu is assigned to either

DeskTopBinder Lite or the control panel of this printer, a same group pass-
word needs to be assigned to the other.
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PDF Direct Print Properties

1. Setting name:
Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...
Change the icon displayed on the tool bar.

3. Printer:
Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex
Print on both sides of sheets.

5. Layout
Print multiple pages on a single sheet.

6. Punch
Punch holes in output sheets.
You cannot select this function on this printer.

7. Staples
Staple together output sheets.
You cannot select this function on this printer.

8. Display this dialog box before printing
Appears in PDF direct printing mode if
this check box is selected.

9. Orientation:
Specify the original's orientation.

10. Number of copies
Specify the number of copies to print.

11. Collate
Use to sort prints.

12. Range
Specify the print area on each page.

13. Color/Black and White::
Specify color or black-and-white printing.

14. Resolution:
Specify a print resolution.

15. PDF password:
If the PDF file is password-protected, en-
ter the password in this field. Otherwise,
the file cannot be printed.

16. Group password:
If a group password is assigned to Desk-
TopBinder Lite and this printer, enter the
group password in this field. Otherwise,
printing cannot start.

Using Commands
Under Windows and UNIX, you can print PDF files directly, using commands
such as “ftp” “sftp” and “lpr”.

Reference
For details about printing using commands under Windows, see p.267 “Print-
ing Files Directly from Windows”.
For details about UNIX commands, see UNIX Supplement.
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Unauthorized Copy Control

You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [Mask type:].

Important
❒ This function is designed to discourage copying of confidential documents; it

does not prevent unauthorized use of information.

Opening the Unauthorized Copy Control Window

A In the RPCS printer driver, open the [Printing Preference...] window.

B Click [Add/Change Custom Settings...].

C Select the [Unauthorized copy...] check box.

D Click [Control Settings...].

E A confirmation message appears. Click [OK].
The Unauthorized Copy Control window appears.

Note
❒ For details, see the printer driver Help.

Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

❖ Setting [Data security for copying] in the printer driver
• Select the [Data security for copying] checkbox. You can also enter the text in

the [Text:] box.
• You cannot select the [Mask type:] checkbox at the same time.
• To print a document protected by gray overprint, the printer must be set

up correctly. Consult an administrator.
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❖ Printing a document using [Data security for copying]

1. The pattern and text you have set
is printed.

2. The document is copied in copi-
ers/multifunction machines which
the supplier's optional Copy Data
Security unit is installed.

3. The document is blanked by gray
overprint.

Note
❒ When printing a document that is set with [Data security for copying], the print-

er does not require the optional Copy Data Security unit to be installed. The
Copy Data Security unit is required when copying or storing a document pro-
tected by gray overprint.

❒ Only the RPCS printer driver is supported.
❒ You cannot partially embed a pattern and text in a document.
❒ Use 182 × 257 mm (71/4 × 101/2 in.) or larger paper.
❒ Use ordinary or recycled paper of at least 70% whiteness.
❒ Duplex printing may interfere with this function as a result of text and pat-

terns being visible through the paper.
❒ The optional Copy Data Security Unit is for the supplier's copiers/multifunc-

tion machines. It cannot be installed on this printer.

Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

❖ Setting [Mask type:] in the printer driver
• Select a pattern from [Mask type:], and then enter text in the [Text:] box.
• You can select overprint colour from [Black], [Cyan], or [Magenta] in the

[Color:] list.

Note
❒ You can set only [Text:], but [Mask type:] and [Text:] must be set together.

❖ Printing a document using [Mask type:]

1. The pattern and text you have set
is printed palely.

2. The document is copied in copi-
ers/multifunction machines.

3. The pattern and text you have set
appear clearly.

Note
❒ Only the RPCS printer driver is supported.
❒ You cannot partially embed patterns and text strings in a document.
❒ To make the embedded pattern clear, set the character size at least 50 pt (pref-

erably 70 to 80 pt) and character angle to between 30 and 40 degrees.
❒ Printing with background patterns and text may be slower than normal printing.

AJL031S

N

g No Copy

ng No Copying N

ying No Copying No

pying No Copying No

opying No Copying N

opying No Copying

Copying No Copying

o Copying No Copyin

pying No Copy

No Cop

No C

g No Copying

ng No Copying No C

ying No Copying No

pying No Copying No

opying No Copying N

Copying No Copying

Copying No Copyin

Copying No Copyi

ing No Copy

Cop



Other Print Operations

84

3

Reference
For details about setting [Mask type:], see the printer driver Help.

Important Notice

• The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the printer model and settings.

• The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print patterns.
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Using the Print Job Function

This describes how to print files stored in the printer.
Print files stored in the printer can be printed. You can select the print files from
the Job List or User ID screen.
You can print or delete the print jobs saved in the printer which is sent from com-
puters. 
The following types of printing can be selected using the printer driver: Sample
Print, Locked Print, Hold Print, and Stored Print.

If you press [Prt.Jobs] on the Printer screen, a screen prompting to select the type
of print job appears. After selecting a type, you can select print files in the list by
pressing:
• [Job List]

Displays the Job List screen.
• [User ID]

Displays the User ID screen. 
If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the printer are deleted after printing is completed. If you select Stored Print, the
files remain in the printer even after printing is finished. 
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❖ Job List
If you press [Job List] when selecting the type of print jobs after [Prt.Jobs] is
pressed in the printer screen, the following screen appears:

1. The type of print jobs
Displays the type of the print job you
select.

2. Page number
Displays the current page number.
Each time pressing the {T} or {U}
key, the screen switches.

3. User ID, Date/Time, and File
Name display

Displays the time when the instruc-
tion to print the stored files was en-
tered, User ID, and the file names.
Locked Print file is displayed as
“****”.

4. [Print]
Prints a selected file. 

5. [Change]
Changes or clears the password of a
file if a password is set. To change the
password of a Locked/Stored Print
job, press [Change], enter the current
password, and then enter the new
password on the confirmation screen.
To clear the password, press [Change],
leave the entering/confirming a new
password box blank, and then press
the {OK} key.
You can also set passwords to the
Stored Print files that do not currently
have passwords.

6. [Delete]
Deletes a selected file.

Note
❒ When you press [Change] to change or clear a password, you must first en-

ter the existing password. If the password you entered is incorrect, you
cannot change or clear any current passwords.

❒ You can use [Change] to set or clear passwords only Stored Print files are
saved in the printer.

AQC501S
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❖ User ID
If you press [User ID] when selecting the type of print jobs after [Prt.Jobs] is
pressed in the printer screen, the following screen appears:

1. The type of print jobs
Displays the type of the print job you
select. 

2. Page number
Displays the current page number.
Each time pressing the {T} or {U}
key, the screen switches.

3. User ID
Displays the User IDs who sent files to
the printer.

4. [PrintAll]
Prints all selected type of files sent by
the user ID.

5. [Job List]
Switches the screen to the [Job List]
screen.
Displays the print jobs of the selected
user only.

Note
❒ To cancel selecting a file, press the {Job Reset} key.
❒ The display is not updated if a new file is stored while the list of stored files

is displayed. To update the display, press the {Menu} key to return to the ini-
tial screen, and then press [Prt.Jobs] again.

❒ If a large number of print jobs are stored in the printer, processing may slow
temporarily, depending on which functions are used.

Reference
For details about printing each type of print job, see the followings:
p.89 “Sample Print”
p.92 “Locked Print”
p.95 “Hold Print”
p.98 “Stored Print”

AQC502S
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Using Keys

This section explains how to read the display and using the selection key for the
initial display.

1. {Escape} key
Press to cancel an operation or return to
the previous display.

2. {OK} key
Press to set a selected item or entered nu-
meric value. 

3. Scroll keys
Press to move the cursor in each direc-
tion, step by step.
When the {U}, {T}, {V}, or {W} key ap-
pears in this manual, press the scroll key
of the same direction.

4. Selection keys
Correspond to the function items at the
bottom line on the display. 
Example: In the initial screen, when the
instruction “press [Option]” appears in
this manual, press the left selection key.

AQC061S
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Printing from the Print Job Screen

This section gives instruction about Sample Print, Locked Print, Hold Print, and
Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the print-
er's control panel. This can reduce misprints due to mistakes in content or settings.

Important
❒ To use this function, the optional hard disk must be installed on the printer.
❒ A Sample Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 9,000 pages in total.

Note
❒ If a Sample Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents in the printer remain.

However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings
are applied first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's [Print] dia-
log box, more prints than intended may be produced.

❒ If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
printer is deleted automatically.

❒ Sample Print files printed or deleted using Web Image Monitor, after you se-
lect [Sample Print Jobs] using the control panel will appear on the display pan-
el. However, an error message will appear if you try to print or delete those
Sample Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily.

Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.145 “HD Management”.
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Printing a Sample Print File

The following procedure describes how to print a Sample Print file with the PCL
6/5c, RPCS and PostScript 3 printer driver. 

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A From an application, select a command to print.
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C In the [Job type:] box, click [Sample Print].
When printing with the PostScript 3 printer driver, click [Sample Print] in the
[Job type:] box on the [Job Log] tab.

D In the [User ID:] box, enter a user ID using up to eight alphanumeric characters.
This is used to identify the user. The user ID can be entered using up to eight
alphanumeric (a-z, A-Z, 0-9) characters.

E Execute a command to print.
Make sure to set more than two copies.
The Sample Print job is sent to the printer, and the first set is printed.

F On the printer's control panel, press [Prt.Jobs].

G Select [Sample Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Sample Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].
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H Select the file you want to print using the {U} or {T}key, and then press
[Print].

Enter the new number of sets using the scroll keys. You can enter up to 999 sets.
Press the {Escape} key to correct any entry mistakes.

I Press [Print].
The remaining sets are printed.
Press [Cancel] to cancel printing.

Note
❒ When the number of set quantity is changed, the changed quantity is ap-

plied to all selected files.
❒ When printing is completed, the stored file will be deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.

Reference
For details about [User ID], see p.103 “Printing from the User ID Screen”.

Deleting Sample Print Files

If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

A Press [Prt.Jobs].

B Select [Sample Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Sample Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
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C Select the file you want to delete using the {U} or {T}key, and then press
[Delete].

The delete confirmation screen will appear.

D Press [Delete] to delete the file.
The selected file is deleted.

Note
❒ If you do not want to delete the file, press [Cancel].

Locked Print
Use this function to maintain privacy when printing confidential documents on
the printer over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this printer. When using Locked Print, it is not
possible to print unless a password is entered on the printer's display panel.
Your confidential documents will be safe from being viewed by other people.

Important
❒ To use this function, the optional hard disk must be installed on the printer.
❒ A Locked Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 9,000 pages in total.

Note
❒ If a Locked Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents remain. However, the

[Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied
first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application print dialog
box, more sets than intended may be printed.

❒ After the Locked Print file is printed, the job is automatically deleted.
❒ Locked Print files printed or deleted using Web Image Monitor, after you se-

lect [Locked Print Jobs] using the control panel will appear on the display pan-
el. However, an error message will appear if you try to print or delete those
Locked Print files.
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Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.145 “HD Management”.

Printing a Locked Print File

The following procedure describes how to print a Locked Print file with the PCL
6/5c, RPCS and PostScript 3 printer driver.

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure the Locked Print in the printer driver's properties.
For details about configuring the printer drivers, see the corresponding Help files.

B Start printing from the application's [Print] dialog box.
The Locked Print job is sent to the printer.

C On the printer's control panel, press [Prt.Jobs].

A list of print files stored in the printer appears.

D Select [Locked Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Locked Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].

E Select the file you want to print using the {U} or {T} key, and then press [Print].

The password screen appears.
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F Enter the password using the {U}, {T}, {W} or {V}key, and then press the
{OK} key.

The print confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Clear] to enter the password again.
If you forget your password, ask your network administrator for help.

G Press [Print].
The locked file is printed.
Press [Cancel] to cancel printing.

Note
❒ When printing is completed, the stored file will be deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.

Reference
For details about [User ID], see p.103 “Printing from the User ID Screen”.

Deleting Locked Print Files

A Press [Prt.Jobs].

B Select [Locked Print Jobs] using the {U} or {T}key, and then press [Job List].

A list of Locked Print files stored appears.
Depending on the security settings, certain print jobs may not be displayed.
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C Select the file you want to delete using the {U} or {T}key, and then press
[Delete].

The password screen appears.

D Enter the password using the {U}, {T}, {W} or {V} key, and then press the
{OK} key.

The delete confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [Clear] to enter the password again.
If you forget your password, ask your network administrator for help.

E Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].

Hold Print

Use this function to temporarily hold a file in the printer, and print it from the
computer or the printer's control panel later.

Important
❒ To use this function, the optional hard disk must be installed on the printer.
❒ A Hold Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 9,000 pages in total.
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Note
❒ If a Hold Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents in the printer remain.

However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings
are applied first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

❒ Hold Print files printed or deleted using Web Image Monitor, after you select
[Hold Print Jobs] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Hold
Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily.

❒ If you enter the document name on the printer driver's [Details...], that name
appears on the display panel.

Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.145 “HD Management”.

Printing a Hold Print File

The following procedure describes how to print a Hold Print file with the PCL
6/5c and the RPCS printer driver. For information about how to print a Hold
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement.

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure Hold Print in the printer driver’s properties.
For details about configuring the printer drivers, see the relevant Help files.

B Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a file name. The file name you set will be displayed on the
printer's Job List screen.

C Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the printer and stored.
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D On the printer’s control panel, press [Prt.Jobs].

E Select [Hold Print Jobs] using the {U} or {T} key, and then press [Job List]. 

 A list of a print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
You can print files also by pressing [User ID].

F Select the file you want to print using the {U} or {T} key, and then press
[Print].

The confirmation screen appears.

G Press [Print].
The Hold Print file is printed.
Press [Cancel] to cancel printing.

Note
❒ When printing is completed, the stored file is deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file is deleted.

Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Hold Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.
For details about [User ID], see p.103 “Printing from the User ID Screen”.
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Deleting Hold Print Files

A Press [Prt.Jobs].

B Select [Hold Print Jobs] using the {U} or {T}key, and then press [Job List].

A list of a Hold Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete using the {U} or {T} key, and then press [Delete].

The delete confirmation screen will appear.

D Press [Delete] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [Cancel].

Stored Print
Use this function to store a file in the printer, and then print it from the computer
or the printer's control panel later.
Jobs are not deleted after they are printed, so the same job need not be resent in
order to print multiple copies. 

Important
❒ To use this function, the optional hard disk must be installed on the printer.
❒ A Stored Print file cannot be stored if:

• the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the printer is over 100. (The maximum number varies depend-
ing on the volume of data in files.)

• the file contains over 1,000 pages.
• sent or stored files in the printer contain over 9,000 pages in total.
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Note
❒ If a Stored Print file has not been stored properly, check the error log on the

control panel.
❒ Even after you turn off the printer, stored documents remain. However, the

[Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied
first.

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

❒ Stored Print files deleted using Web Image Monitor, after you select [Stored
Print Jobs] using the control panel will appear on the display panel. However,
an error message will appear if you try to delete those Stored Print files.

❒ If stored files have similar and long file names, recognizing the file you want
to print on the display panel may be difficult. Print the file you want to print
either by checking the user ID or the time the file is sent, or by changing the
file name to something that can be recognized easily.

❒ If you enter the document name on the printer driver's [Details...], that name
appears on the display panel.

Reference
For details about the error log on the display panel, see p.110 “Checking the
Error Log”.
For details about the [Auto Delete Temporary Jobs] and [Auto Delete Stored Jobs],
see p.145 “HD Management”.

Printing a Stored Print File

The following procedure describes how to print a Stored Print file with the PCL
6/5c, RPCS and Postscript 3 printer driver. For information about how to print
a Stored Print file with the PostScript 3 printer driver, see Supplement included.

Important
❒ Applications with their own drivers, such as PageMaker, do not support this

function.

A Configure Stored Print in the printer driver’s properties.
You can select two ways for Stored Print:
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Normal Print] (or [Store and Print])

Prints the file at once and also stores the file in the printer.
For details about configuring the printer drivers, see the relevant Help files.
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B Click [Details...], and then enter a User ID in the [User ID:] box.
You can also set a password. The same password must be entered when print-
ing or deleting.
You can set a file name. The file name you set will be displayed on the print-
er's Job List screen.

C Start printing from the application’s [Print] dialog box.
The Stored Print job is sent to the printer and stored.

D On the printer's control panel, press [Prt.Jobs].

E Select [Stored Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Stored Print files stored in the printer appears.
You can print files also by pressing [User ID].

F Select the file you want to print using the {U} or {T} key, and then press
[Print].

The confirmation screen appears.
If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.

G Press [Print].
The Stored Print file is printed.
Press [Cancel] to cancel printing.
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Note
❒ When multiple files are selected without setting a quantity, one set less

than the minimum number of all settings is applied. If the least number of
settings is one set, all selected files will be printed at one set.

❒ When the number of set quantity is changed, the changed quantity is ap-
plied to all selected files.

❒ To stop printing after printing has started, press the {Job Reset} key. A
Stored Print file is not deleted even if [JobReset] is pressed.

❒ The Stored Print file that sent to the printer is not deleted unless you delete
a file or select [Auto Delete Stored Jobs].

❒ You can set or delete a password after sending files to the printer. Select
the file and press [Change] in the Print Job List screen. To set a password,
enter the new password. To delete the password, leave the password box
blank on entering or confirming the new password, and press the {OK}
key.

Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.
For details about the [Auto Delete Stored Jobs], see p.145 “HD Management”.
For details about [User ID], see p.103 “Printing from the User ID Screen”.

Deleting Stored Print Files

A Press [Prt.Jobs].

B Select [Stored Print Jobs] using the {U} or {T} key, and then press [Job List].

A list of Stored Print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.
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C Select the file you want to delete using the {U} or {T} key, and then press
[Delete].

The delete confirmation screen will appear.
If you set the password in the printer driver, enter the password to delete.
If you forget your password, ask your network administrator for help.

D Press [Delete] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Printing from the User ID Screen

This describes how to print the files saved in the printer from the User ID screen.

Printing the Selected Print Job

A On the initial screen, press [Prt.Jobs].

B Press [User ID].

A list of user IDs whose files are stored in the printer appears.

C Select the user ID whose file you want to print using the {U} or {T} key,
and then press [Job List].

The print job list of the selected user ID appears.

D Select the file you want to print using the {U} or {T} key, and then press
[Print].

The confirmation screen appears.

E Press [Print].
The selected file is printed.
To cancel printing, press [Cancel].
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Reference
For details about printing each type of print job, see the followings:
p.89 “Sample Print”
p.92 “Locked Print”
p.95 “Hold Print”
p.98 “Stored Print”

Printing All Print Jobs

A On the initial screen, press [Prt.Jobs].

B Select a type of print jobs you want to print using the {U} or {T} key, and
then press [User ID].

A list of user IDs whose files are stored in the printer appears.

C Select the user ID whose file you want to print using the {U} or {T} key,
and then press [PrintAll].

The confirmation screen appears.

D Press [Print].
The selected files are printed.
To cancel printing, press [Cancel].
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Note
❒ After printing is completed, Sample Print, Locked Print, and Hold Print

files are deleted.
❒ You cannot select a print job that is not stored under the selected user ID.
❒ If you select multiple Sample Print files and do not specify the number of

sets on the confirmation screen, one set less than the number specified on
the computer is printed for every selected document. If the number of sets
specified on the computer is “1”, one set each is printed for every docu-
ment.

❒ When printing multiple Stored Print files, and do not specify the number
of sets on the confirmation screen, the minimum number of set quantity
among all settings is applied.

❒ If you select Locked Print, enter the correct password. If there are multiple
passwords, the printer prints only files that correspond to the entered
password. 

❒ If you select Stored Print files, and some of these require a password, the
printer prints files that correspond to the entered password and files that
do not require a password.

Reference
For details about printing each type of print job, see the followings:
p.89 “Sample Print”
p.92 “Locked Print”
p.95 “Hold Print”
p.98 “Stored Print”
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Form Feed
This section gives instructions for operating the printer when there is no tray for
the selected paper size or type, or when paper loaded in the printer has run out.

Important
❒ The tray cannot be changed if the following functions are set:

• Duplex Print to a tray that does not support duplex printing
• Cover Sheet
• Slip Sheet

Note
❒ If form feed is selected for a tray with the following settings, you can change

the tray by canceling the settings:
• Duplex Print

Reference
If Auto Continue is selected, form fed paper is printed after a set interval. For
details, see p.152 “Auto Continue”.

Printing from a Selected Tray
If the printer does not have a tray for the selected paper size or paper type, or if
the selected paper loaded in the printer has run out, a caution message appears.
If this message appears, do the following procedure.

AWhen the caution message appears, press [FormFeed].

B Select the tray for form feed using the {U} or {T} key from those that ap-
pear on the display panel, and then press the {OK} key.
If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

The printer prints using the selected tray.

Note
❒ If a tray with a smaller paper size is selected, the print job may be cut short,

or other problems may occur.



Form Feed

07

3

1

Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form
feed appears.

A Press [JobReset].

B Press [Current].

The confirmation message appears.
To resume printing jobs, press [Resume].

C Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

Note
❒ If the printer is shared by multiple computers, be careful not to accidental-

ly cancel someone else's print job.
❒ Under Windows, If the printer is connected to the computer using a paral-

lel cable, sent print jobs may be canceled if [JobReset] is pressed while
“Waiting...” is displayed on the control panel. After the interval set in [I/O
Timeout] in Printer Features has passed, the next print job can be sent. A
print job sent from a different client computer will not be canceled in this
case.

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.

Reference
To stop data printing, see p.108 “Canceling a Print Job”.
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Canceling a Print Job

This section gives instruction to stop printing from the computer or the control
panel.

Canceling a Print Job Using the Control Panel

A Press the {JobReset} key.
A confirmation message appears.

B Press [Current].

To resume printing jobs, press [Resume].

C Press [Yes] to cancel the print job.

Press [No] to return to the previous display.

Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

A Double-click the printer icon on the Windows task tray.
A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

B Select the name of the job you want to cancel.

C On the [Document] menu, click [Cancel Printing].
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Note
❒ If the printer is shared by multiple computers, be careful not to accidental-

ly cancel someone else's print job.
❒ If the printer is connected to the computer using a parallel cable, sent print

jobs may be canceled if {JobReset} is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

❒ In Windows XP, Windows Server 2003, and Windows NT 4.0, click [Cancel]
on the [Document] menu.

❒ In Windows 95/98/Me/2000 or Windows NT 4.0, you can also open the
print job queue window by double-clicking the printer icon in the [Printers]
printer window (the [Printers and Faxes] window under Windows XP and
Windows Server 2003).

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.

Mac OS - Canceling a Print Job from the computer

A Double-click the printer icon on the desktop.
A window appears showing all print jobs that are currently queuing to be
printed. Check the current status of the job you want to cancel.
Under Mac OS X, start Print Center.

B Select the name of the job you want to cancel.

C Click the pause icon, and then click the trash icon.

Note
❒ If the printer is shared by multiple computers, be careful not to accidental-

ly cancel someone else's print job.
❒ If the printer is connected to the computer using a parallel cable, sent print

jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

❒ You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

❒ A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

Important
❒ The most recent 30 errors are stored in the error log. If a new error is added

when there are 30 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.
• Sample Print
• Locked Print
• Hold Print
• Stored Print

❒ If the main power switch is turned off, the log is deleted.

A Press the [Option] key.

B Select [Show Error Log] using the {U} or {T} key, and then press the {OK}
key.

C Select a type of print jobs using the {U} or {T} key, and then press the {OK}
key.
If you select [All], all error logs appears.
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D Select the error log you want to check using the {U} or {T} key.

Note
❒ Press the {Menu} key until the initial screen appears after checking the log.
❒ To print files that appear in the error log, resend them after stored files

have been printed or deleted.
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Collate

The Collate function allows you to print while sorting printouts into page-or-
dered sets, such as when printing multiple copies of meeting materials.

Important
❒ To use these functions, an optional memory unit of at least 256 MB or the op-

tional hard disk drive must be installed on the printer.
❒ Up to 150 pages can be sorted using RAM. If the optional hard disk drive is

installed, up to 1,000 pages can be sorted.

❖ Collate
Output can be assembled as sets in sequential order.

Note
❒ If Auto Continue occurs on the first set, Collate will be canceled.
❒ If forced printing occurs on the first set, Collate will be canceled.
❒ When setting Collate in the printer driver settings, make sure that a collate

option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

Reference
For details about printing method, see the printer driver Help.
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Spool Printing

With Spool Printing, the print data is saved in the hard disk before printing. To
use this function, set it from the menu. See p.222 “spoolsw”.

Important
❒ Do not turn off the printer or the computer when a print job is being spooled

and the Data In indicator is blinking. The print job will remain in the hard
disk and be printed when the printer is turned on. The setting can be changed
using the “spoolsw clear job” command on the telnet.

❒ The Spool Printing function is available when the optional hard disk is in-
stalled.

❒ The Spool Printing function is available for data received using diprint, lpr,
ipp, ftp, and sftp (TCP/IP (IPv6)).

❒ When using diprint, the Spool Printing function cannot be used with bidirec-
tional communication.

❒ The domain reserved for spool printing is about 1 GB.
❒ When Spool Printing is on, the size of a single print job cannot exceed 500 MB.
❒ When sending print jobs spooled from several computers, up to one diprint

job, 10 lpr jobs, one ipp job, one ftp job, one sftp job, and one smb job can be
spooled. Jobs exceeding this spooling capacity cannot be executed. It is neces-
sary to wait to add new jobs.

Note
❒ Printing the first page with Spool Printing will be slow.
❒ The computer requires less print processing time when large amounts of data

are spooled.
❒ Stored spool jobs can be viewed or deleted using Web Image Monitor.
❒ The list of spool jobs cannot be viewed from the printer's control panel.

Reference
For information about the “spoolsw clear job” command on the telnet, see
p.222 “spoolsw”.

Setting Spool Printing

Spool printing settings can be made using telnet or Web Image Monitor.
• Using Web Image Monitor

In [System] on the [Configuration] menu, click [Enable] in [Spool Printing].
• Using telnet

Enter “spoolsw spool on”.

Reference
For details about Web Image Monitor, see Web Image Monitor Help.
For details about “spoolsw spool on”, see p.222 “spoolsw”.
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Viewing or Deleting spooled jobs using Web Image Monitor

Follow the procedure below to check or delete spooled jobs using Web Image
Monitor.

A Open a Web browser.

B Enter “http://(printer's address)/” in the address bar to access the printer
whose settings you want to change.
Top Page of Web Image Monitor appears.

C Click [Login].
The window for entering the login user name and password appears.

D Enter the login user name and password, and then click [Login].
Contact your network administrator for information about the settings.

E In the menu area, click [Job].
A submenu will appear.

F On the [Printer] menu, click [Spool Printing].
A list of spooled jobs appears.

G To delete a job, select the check box of the job you want to delete, and then
click [Delete].
The selected job is deleted.

H Click [Logout].

I Quit Web Image Monitor.

Reference
For details, see Web Image Monitor Help.
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Cover

Using this function, you can insert cover and back sheets fed from a different
tray to that of the main paper, and print on them.

Important
❒ To use this function, Collate must be set.

Note
❒ The cover sheets should be the same size and orientation as the body of the

paper.
❒ If Auto Tray Select is set as the paper feed tray for the body paper, the paper

will be delivered from a tray containing paper from a tray containing paper
in the portrait direction. Therefore, if the cover paper is set to landscape ori-
entation, the orientation cover and body will be different.

Reference
For printing methods, see the printer driver Help.
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Memory Capacity and Paper Size

Additional memory apart from standard memory may be required depending
on the paper size and data type.

Note
❒ When printing from bypass tray, duplex printing will not be supported re-

gardless of the memory capacity, and only one-side will be printed.

One-sided printing (600 × 600 dpi)

❖ 256 MB (standard)
• A5, B5 JIS, A4, Letter, Legal and Postcard sized paper can be printed.
• 210 mm × 900 mm (8.2 in. × 35.4 in.) sized paper may not be printed, de-

pend on the printing data.

One-sided printing (1200 × 600 dpi)

❖ 256 MB (standard)
• A5 and Postcard sized paper can be printed.
• B5 JIS, A4, Letter, Legal and 210 mm × 900 mm (8.2 in. × 53.4 in.) sized pa-

per may not be printed, depend on the printing data.

❖ 384 MB (standard + 128 MB)
• A5, B5 JIS, A4, Letter, Legal, Postcard and 210 mm × 900 mm (8.2 in. × 35.4

in.) sized paper can be printed.

One-sided printing (1200 × 1200 dpi)

❖ 256 MB (standard)
• Postcard sized paper can be printed.
• A5, B5 JIS, A4, Letter and Legal sized paper may not be printed, depend on

the printing data.

❖ 384 MB (standard + 128 MB)
• A5, B5 JIS, A4, Letter, Legal and Postcard sized paper can be printed.
• 210 mm × 900 mm (8.2 in. × 35.4 in.) sized paper may not be printed, de-

pend on the printing data.

❖ 512 MB (standard + 256 MB)
• A5, B5 JIS, A4, Letter, Legal Postcard and 210 mm × 900 mm (8.2 in. × 35.4

in.) sized paper can be printed.
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Duplex printing (600 × 600 dpi)

❖ 256 MB (standard)
• A5, B5 JIS, A4, Letter, Legal and Postcard sized paper can be printed.

Duplex printing (1200 × 600 dpi)

❖ 256 MB (standard)
• Postcard sized paper can be printed.
• A5, B5 JIS, A4, Letter and Legal sized paper may not be printed, depend on

the printing data.

❖ 384 MB (standard + 128 MB)
• A5, B5 JIS, A4, Letter, Legal and Postcard sized paper can be printed.

Duplex printing (1200 × 1200 dpi)

❖ 256 MB (standard)
• A5 and Postcard sized paper can be printed.
• B5 JIS, A4, Letter and Legal sized paper may not be printed, depend on the

printing data.

❖ 384 MB (standard + 128 MB)
• A5, B5 JIS and Postcard sized paper can be printed.
• A4, Letter and Legal sized paper may not be printed, depend on the print-

ing data.

❖ 512 MB (standard + 256 MB)
• A5, B5 JIS, A4, Letter, Legal and Postcard sized paper can be printed.
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4. Direct Printing from a Digital
Camera (PictBridge)
19
1

What is PictBridge?

You can connect a PictBridge-compatible digital camera to this printer using a
USB cable. This allows you to print photographs taken using the digital camera
directly by operating the digital camera.

Before you can use this function, the printer requires the following options:
• USB host interface board
• Camera direct print card

Note
❒ Check your digital camera is PictBridge-compatible.
❒ Up to 999 images can be sent from the digital camera to the printer during one

print transaction. If an attempt is made to send more images, an error mes-
sage is sent to the camera and printing fails. 

❒ Since printing conditions are specified on the digital camera, specifiable pa-
rameters depend on the particular digital camera. For details, see your digital
camera's manual.

❒ This function is compatible with USB 1.1.

AQC047S
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PictBridge Printing

Follow the procedure below to start PictBridge printing on this printer.

Important
❒ Do not disconnect the USB cable while data is being sent. If you do, printing

will fail.
❒ The USB host interface board is supplied with a USB cable and a hook onto

which you can roll up and hang the cable.

A Attach the hook on the back of the printer near the USB connection slot.
Attach the hook where it will not interfere with printer operation and access.

B Check the printer and the digital camera are both switched on.

C Connect a USB cable between the optional USB host interface board in-
stalled on the printer and the digital camera.
The Data In indicator on the printer blinks for several seconds and “PctBrdg”
is displayed on the printer. This indicates the printer recognizes the digital
camera as a PictBridge device.

AQC050S

AQC063S
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D Secure the USB cable using the hook.

E On your digital camera, select the images you want to print, and specify the
printing conditions.

F The printer receives settings from the digital camera and starts printing.

Note
❒ Since printing conditions are specified on the digital camera, specifiable

parameters depend on the particular digital camera. For details, see the
digital camera's manual.

❒ Some digital cameras require settings for manual PictBridge operation. For
details, see your digital camera's manual.

Reference
To stop data printing, see p.108 “Canceling a Print Job”.

AQC049S
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What Can Be Done on This printer
This printer can perform the following functions using its PictBridge feature. 
The settings available for these functions are as follows:
• Single image printing
• Selected image printing
• All image printing
• Index printing
• Trimming
• Date and file name printing
• Paper size
• Image print size
• Multi-Image-Layout
• Printing quality
• Color matching
• Paper type specification
• Form printing
• Camera memo printing

Note
❒ This printer does not support the following settings: 

• DPOF printing 
• Margin-less printing

❒ The setting parameters and their names may vary depending on the digital
camera. For details, see your digital camera's manual.

Index Printing

❖ A4 (210 × 497)

❖ A5 (148 × 210)

❖ Letter (81/2 × 11)

Horizontal images × vertical images (in) Paper orientation

8 × 12 K

12 × 8 L

Horizontal images × vertical images (in) Paper orientation

5 × 8 K

8 × 5 L

Horizontal images × vertical images (in) Paper orientation

8 × 10 K

10 × 8 L
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Note
❒ Index printouts vary depending on the orientation of the paper placed on the

specified size tray.
❒ Depending on the digital camera, a form feed may be inserted after one set of

images belonging to one type ends.
❒ The number of images in each size of paper is fixed.

Trimming
Use this function to print only the inside of the trimming area specified on the
digital camera.

*1 -- Trimming area

Date and File Name Printing
Use this function to print the date and/or file name under the image.

In the above figure, “aaaaa” indicates the file name and “bbbbb” indicates the date.

Paper Size
Use this function to print on paper with the size specified on the digital camera.

Paper size name Actual size

Postcard 148 mm × 100 mm

AGZ007S

AGZ005S
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Note
❒ Specify Undefined Size for the A6, B5, and B6 sizes.
❒ For details about specifying undefined sizes, see Hardware Guide.

Image Print Size
Use this function to print images with the size specified on the digital camera.

-- indicates the image size specified on the camera.
You can specify the following image print sizes:

❖ Fixed size
• 3.25” × 2.5”
• 5” × 2.5”
• 6” × 4”
• 7” × 5”
• 10” × 8”
• 254 mm × 178 mm
• 110 mm × 74 mm
• 89 mm × 55 mm
• 148 mm × 100 mm
• 8 cm × 6 cm
• 10 cm × 7 cm
• 13 cm × 9 cm
• 15 cm × 10 cm
• 18 cm × 13 cm
• 21 cm × 15 cm
• 24 cm × 18 cm

Letter (8 1/2” × 11”) 279.4 mm × 216 mm (8 1/2 × 11)

A4 297 mm × 210 mm

A5 210 mm × 148 mm

A6 148 mm × 105 mm

B5 257 mm × 182 mm

B6 182 mm × 128 mm

Paper size name Actual size

AGZ008S
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Note
❒ An error occurs if the specified size is larger than the actual paper size.

Multi-Image-Layout
Use this function to print multiple images on the specified paper.

The number of images that can be printed on one page is as follows:

The number and arrangement of images that can be specified are as follows:

Note
❒ A form feed may be inserted between images depending on the digital camera in use.
❒ Printing in the specified way may not be possible depending on the specifica-

tion for the number of images to be printed.

Paper size Number of images that can be specified

Postcard 2, 4

Letter (81/2” × 11”) 2, 4, 8, 9, 16, 25, 32

A4 2, 4, 8, 9, 16, 25, 32

A5 2, 4, 8, 9, 16

A6 2, 4, 8

B5 2, 4, 8, 9, 16, 25

B6 2, 4, 8, 9

Number of images Vertical images × horizontal 
images

Paper orientation

2 2 × 1 K

4 2 × 2 L

8 4 × 2 K

9 3 × 3 L

16 4 × 4 L

25 5 × 5 L

32 8 × 4 K

AGZ002S
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Printing Quality
Use this function to print images at the selected printing quality.
If you select [Default] or [Normal], the printer prints in normal quality; if you select
[Fine], the printer prints in the best quality.

Color Matching
Use this function to optimize colors when printing images.
If you select [Default] or [OFF], the printer prioritizes gradation for color match-
ing, if you select [ON], the printer prioritizes saturation.

Paper type Specification
This function sends the printer's paper type information to the digital camera. The
names of paper types displayed on the digital camera's screen are different to the
names displayed on the printer. Use the table below to match the paper types.
To display a paper type name on the digital camera's screen, use the printer's
control panel to set the paper type of the printer correctly.

Form Printing
Use this function to print images in a predetermined layout format.

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the image.

The paper type detected by the digital cam-
era

The paper type of the printer

Default All type of paper

Plain Paper Plain or recycled paper

Fast Photo Paper Grossy paper

AGZ009S
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Exiting PictBridge

Follow the procedure below to quit the PictBridge mode.

Important
❒ Do not disconnect the USB cable while data is being sent to the printer. If you

do, printing will fail.

A Check the control panel of this printer is displaying the “Ready” state.

B Disconnect the USB cable from the printer.
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When PictBridge Printing Does Not Work

This section explains likely causes and possible solutions for problems that can
occur when PictBridge printing.

Problem Cause Solution

PictBridge is not available. There is a problem with the 
USB connection or the Pict-
Bridge settings.

Use the following procedure 
to check the connection and 
settings:

A Disconnect and then re-
connect the USB cable.

B Check the PictBridge set-
tings are enabled.

C Disconnect the USB cable, 
and then turn off the print-
er. Turn the printer back 
on. When the printer has 
fully booted up, reconnect 
the USB cable. 

When two or more digital 
cameras are connected, the 
second and subsequent cam-
eras are not recognized.

You have connected multiple 
digital cameras.

Connect one digital camera 
only. 

Do not connect multiple cam-
eras.

Printing is disabled. The number of originals ex-
ceeds the maximum number 
of pages that can be printed at 
a time.

The maximum specifiable 
print quantity at a time is 999. 
Respecify the quantity to 999 
or less, and then retry print-
ing.

Printing is disabled. There is no paper of the speci-
fied size remaining.

There is no paper of the speci-
fied size remaining.

If you have to use paper that is 
not of the specified size, per-
form Form Feed. To cancel 
printing, perform Job Cancel.

Printing is disabled. The paper size setting for this 
tray cannot be printed on the 
printer.

Select the paper size setting 
that can be printed on the 
printer.
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Other Reference Information

For further details about printing on this printer, see the following:

Reference
Fore details about paper size, paper type, or tray settings, see General Settings
Guide.
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5. Making Printer Settings
Using the Control Panel
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Menu Chart

This section explains how to change the default settings of the printer and pro-
vides information about the parameters included in each menu.

❖ Memory Erase Status
Displays data status inside the memory.

Note
❒ This menu can be selected only when the optional Data Overwrite Security

Unit is installed.

❖ Paper Input

❖ Maintenance

Menu

Paper Size:Bypass 

Paper Size:Tray 1

Paper Size:Tray 2

Paper Size:Tray 3

Paper Type:Bypass 

Paper Type:Tray 1

Paper Type:Tray 2

Paper Type:Tray 3

Auto Tray Select

Tray Priority

Menu

Quality Maintenance

General Settings

Timer Settings

HD Management
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❖ List/Test Print

❖ System

Note
❒ [Spool Printing] appear when the optional hard disk is installed.
❒ [RAM Disk] will not appear when the optional hard disk is installed.

Menu

Multiple Lists

Config. Page

Error Log

Network Summary

Supply Info List

Menu List

Colour Demo Page

PCL Config./Font Page

PS Config./Font Page

PDF Config./Font Page

Hex Dump

Menu

Print Error Report

Auto Continue

Memory Overflow

Printer Language

Sub Paper Size

Default Printer Lang.

Energy Saver

Memory Usage

B&W Page Detect

Spool Printing

RAM Disk

Notify by Email
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❖ Print Settings

❖ Security Options

❖ Host Interface

Note
❒ [IEEE 802.11b] appears when the optional IEEE 802.11b interface unit is installed.
❒ [USB Setting] appears when the optional USB Host interface board is installed.

❖ Language

Menu

Machine Modes

PCL Menu

PS Menu

PDF Menu

Menu

Extended Security

Service Mode Lock

Firmware Version

Network Security Level

Transfer Log Setting

Menu

I/O Buffer

I/O Timeout

Network

IEEE 802.11b

USB Setting

AQC801S



Making Printer Settings Using the Control Panel

134

5

Memory Erase Status Menu

Displays data status inside the memory.

A Press the {Menu} key/

The menu screen appears.

B Press the {U} or {T} key to display [Memory Erase Status], and then press the
{OK} key.

C Displays [Data to erase remaining.] if there is data remaining inside the mem-
ory, displays [Currently no data to erase.] if there is no data inside the memory,
and displays [Erasing data..] when the data is being deleted. 

D Press the {OK} key.
The initial screen appears.

AQC001S

YMCK
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Paper Input Menu

This section explains about paper settings on the Paper Input menu such as pa-
per sizes and types on each tray.

Changing the Paper Input Menu

Auto Tray Select

Follow the procedure below to set [Auto Tray Select].

A Press the {Menu} key.

The menu screen appears.

B Press the {U} or {T} key to display [Paper Input], and then press the {OK} key.

C Press the {U} or {T} key to display [Auto Tray Select], and then press the
{OK} key.

D Press the {U} or {T} key to display the tray you do not want to select, and
then press the {OK} key.

E Press the {U} or {T} key to display [On], and then press the {OK} key.
Wait one second. The [Auto Tray Select] screen appears.

F Press the {Menu} key.
The initial screen appears.

AQC001S

YMCK
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Tray Priority

Follow the procedure below to change the tray priority.

A Press the {Menu} key.

The menu screen appears.

B Press the {U} or {T} key to display [Paper Input], and then press the {OK} key.

C Press the {U} or {T} key to display [Tray Priority], and then press the {OK} key.

D Press the {U} or {T} key to select a tray you want to use.

E Press the {OK} key.
Wait one second. The [Paper Input] screen appears.

F Press the {Menu} key.
The initial screen appears.

Paper Input menu parameters

This section explains about parameters that can be set on the Paper Input menu.

❖ Paper Size: Bypass Tray
You can specify the paper size for Bypass Tray.
• : A4 (210 mm × 297 mm), A5 (148 mm × 210 mm), A6 (105 mm

× 148 mm), B5 JIS (182 mm × 257 mm), B6 JIS (128 mm × 182 mm), C5 Env.
(162 mm × 229 mm), C6 Env. (114 mm × 162 mm), DL Env. (110 mm × 220
mm), 81/2” × 14”, 81/2” × 13”, 8” × 13”, 71/4” × 101/2”, 51/2” × 81/2”, 41/8”
× 91/2”, 37/8” × 71/2”, 16K (195 mm × 267 mm), Custom Size

• : 81/2” × 14”, 81/2” × 13”, 81/2” × 11”, 81/4” × 13”, 8” × 13”, 71/4”
× 101/2”, 51/2” × 81/2”, 41/8” × 91/2”, 37/8” × 71/2”, A4 (210 mm × 257 mm),
A5 (148 mm × 210 mm), A6 (105 mm × 148 mm), B5 JIS (182 mm × 257 mm),
B6 JIS (128 mm × 182 mm), C5 Env. (162 mm × 229 mm), C6 Env. (114 mm
× 162 mm), DL Env. (110 mm × 220 mm), 16K (195 mm × 267 mm), Custom
Size

AQC001S

YMCK
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Note
❒ Default:

• : A4 (210 mm × 297 mm)
• : 81/2” × 11”

❖ Paper Size: Tray 1
You can specify the paper size for Tray 1.
• : AutoDetect (A4 (210 mm × 297 mm), A5 (148 mm × 210 mm),

A6 (105 mm × 148 mm), 81/2” × 14”, 81/2” × 11”, 71/4” × 101/2”), B5 JIS (182
mm × 257 mm), B6 JIS (128 mm × 182 mm), 81/2” × 13”, 51/2” × 81/2”, 8” ×
13”, 81/4” × 13”, 41/8” × 91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm),
C6 Env. (114 mm × 162 mm), DL Env. (110 mm × 220 mm), 16K (195 mm ×
267 mm), Custom Size

• : AutoDetect (A4 (210 mm × 257 mm), 81/2” × 14”, 81/2” × 11”,
51/2” × 81/2”, 71/4” × 101/2”), B5 JIS (182 mm × 257 mm), A5 (148 mm × 210
mm), B6 JIS (128 mm × 182 mm), A6 (105 mm × 148 mm), 8” × 13”, 81/2” ×
13”, 81/4” × 13”, 41/8” × 91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm),
C6 Env. (114 mm × 162 mm), DL Env. (110 mm × 220 mm), 16K (195 mm ×
267 mm), Custom Size

Note
❒ Default:
• : A4 (210 mm × 297 mm)
• : 81/2” × 11”

❖ Paper Size: Tray 2
You can specify the paper size for Tray 2.
• : AutoDetect (A4 (210 mm × 297 mm), A5 (148 mm × 210 mm),

81/2” × 14”, 81/2” × 11”, 71/4” × 101/2”), B5 JIS (182 mm × 257 mm), B6 JIS
(128 mm × 182 mm), 81/2” × 13”, 51/2” × 81/2”, 8” × 13”, 81/4” × 13”, 41/8”
× 91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm), C6 Env. (114 mm × 162
mm), DL Env. (110 mm × 220 mm), 16K (195 mm × 267 mm), Custom Size

• : AutoDetect (A4 (210 mm × 257 mm), 81/2” × 14”, 81/2” × 11”,
51/2” × 81/2”, 71/4” × 101/2”), B5 JIS (182 mm × 257 mm), A5 (148 mm × 210
mm), B6 JIS (128 mm × 182 mm), 8” × 13”, 81/2” × 13”, 81/4” × 13”, 41/8” ×
91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm), C6 Env. (114 mm × 162
mm), DL Env. (110 mm × 220 mm), 16K (195 mm × 267 mm), Custom Size

Note
❒ Default:
• : A4 (210 mm × 297 mm)
• : 81/2” × 11”
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❖ Paper Size: Tray 3
You can specify the paper size for Tray 3.
• : AutoDetect (A4 (210 mm × 297 mm), A5 (148 mm × 210 mm),

81/2” × 14”, 81/2” × 11”, 71/4” × 101/2”), B5 JIS (182 mm × 257 mm), B6 JIS
(128 mm × 182 mm), 81/2” × 13”, 51/2” × 81/2”, 8” × 13”, 81/4” × 13”, 41/8”
× 91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm), C6 Env. (114 mm × 162
mm), DL Env. (110 mm × 220 mm), 16K (195 mm × 267 mm), Custom Size

• : AutoDetect (A4 (210 mm × 257 mm), 81/2” × 14”, 81/2” × 11”,
51/2” × 81/2”, 71/4” × 101/2”), B5 JIS (182 mm × 257 mm), A5 (148 mm × 210
mm), B6 JIS (128 mm × 182 mm), 8” × 13”, 81/2” × 13”, 81/4” × 13”, 41/8” ×
91/2”, 37/8” × 71/2”, C5 Env. (162 mm × 229 mm), C6 Env. (114 mm × 162
mm), DL Env. (110 mm × 220 mm), 16K (195 mm × 267 mm), Custom Size

Note
❒ Default:
• : A4 (210 mm × 297 mm)
• : 81/2” × 11”

❖ Paper Type: Bypass Tray
No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2,
Special Paper 3, Colour Paper, Letterhead, Label Paper, OHP (Transparency),
Envelope, Glossy Paper, Coated Paper, Preprinted Paper, Bond Paper, Thin
Paper, Thick Paper 1, Thick Paper 2, Cardstock, Plain: Dup.Back, Thick 1:
Dup.Back, Thick 2: Dup.Back

Note
❒ Default : Plain Paper
❒ For details about the type of paper loaded in each tray, see Hardware

Guide.

❖ Tray 1
No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2,
Special Paper 3, Colour Paper Letterhead, Label Paper, OHP (Transparency),
Envelope, Glossy Paper, Coated Paper, Preprinted Paper, Bond Paper, Thin
Paper, Thick Paper 1, Thick Paper 2, Cardstock, Plain: Dup.Back, Thick 1:
Dup.Back, Thick 2: Dup.Back

Note
❒ Default : Plain Paper
❒ For details about the type of paper loaded in each tray, see Hardware

Guide.
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❖ Tray 2
No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2,
Special Paper 3, Colour Paper, Letterhead, Label Paper, OHP (Transparency),
Envelope, Glossy Paper, Coated Paper, Preprinted Paper, Bond Paper, Thin
Paper, Thick Paper 1, Thick Paper 2, Cardstock, Plain: Dup.Back, Thick 1:
Dup.Back, Thick 2: Dup.Back

Note
❒ Default : Plain Paper
❒ For details about the type of paper loaded in each tray, see Hardware Guide.

❖ Tray 3
No Display (Plain Paper), Recycled Paper, Special Paper 1, Special Paper 2,
Special Paper 3, Colour Paper, Letterhead, Label Paper, OHP (Transparency),
Envelope, Glossy Paper, Coated Paper, Preprinted Paper, Bond Paper, Thin
Paper, Thick Paper 1, Thick Paper 2, Cardstock, Plain: Dup.Back, Thick 1:
Dup.Back, Thick 2: Dup.Back

Note
❒ Default : Plain Paper
❒ For details about the type of paper loaded in each tray, see Hardware Guide.

❖ Auto Tray Select
You can select whether to assign each tray to automatically print the paper
size and type set by printer driver.

Note
❒ Default : Off
❒ When using custom size paper, if [On] is selected in [Auto Tray Select], the

size selected on the control panel has priority, if [Off] is selected, the size
selected from the printer driver has priority.

❒ Only installed trays appear on the display panel.
❒ You can select multiple trays.
❒ If you need to have a tray locked, you must select the tray using both print-

er driver and control panel.

❖ Tray Priority
You can set a tray to be checked first when [Auto Tray Select] is selected in [Pa-
per] tab from the printer driver. The tray selected here is used when no tray is
selected for a print job.

Note
❒ Default : Tray 1
❒ Only installed trays appear on the display panel.
❒ It is recommended that you load paper of the size and orientation you use

most frequently in the tray selected in [Tray Priority].

Note
❒ JIS stands for “Japanese Industrial Standard”.
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Maintenance Menu
You can set printing conditions such as density and calibration, and printer
management such as formatting the optional hard disk unit.

Changing the maintenance menu

This section explains changing the maintenance menu using examples.

Auto Delete Temporary Jobs - HD Management

Follow the procedure below to set Auto Delete Temporary Jobs.

A Press the {Menu} key.

The menu screen appears.

B Press the {T} or {U} key to display [Maintenance], and then press the {OK} key.

C Press the {T} or {U} key to display [HD Management], and then press the
{OK} key.

D Press the {T} or {U} key to display [Auto Delete Temporary Jobs], and then
press the {OK} key.

E Press the {T} or {U} key to select [On], and then press the {OK} key.

F Press the {T} or {U} key to enter the timer of auto delete between 1 and 200 hour.

G Press the {OK} key.
Wait one second. The [HD Management] screen appears.

H Press the {Menu} key.
The initial screen appears.

Note
❒ The [HD Management] menu appears only when the optional hard disk is in-

stalled.

Reference
For details about the optional hard disk unit, see Hardware Guide.
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Maintenance menu parameters

This section explains about parameters that can be set on the Maintenance menu.

Quality Maintenance

❖ Colour Registration
You can specify Auto Adjust or Fuser Adjust for this feature.

❖ Colour Calibration
You can adjust the gradation of bright (highlighted parts) and medium areas
(middle parts) for printing.
• Adjust Auto Density

You can print the gradation of auto density.
• Print Sheet 1

You can print gradation correction sheet 1.
• Print Sheet 2

You can print gradation correction sheet 2.
• Reset Setting

You can reset the gradation correction value to default.

Reference
For details, see “Correcting the Color Gradation”, Hardware Guide.

❖ Registration
You can adjust the starting position of the printing page.
• Print Test Sheet

You can print the registration test sheet.
Tray 1, Tray 2, Tray 3, Bypass Tray, Duplex Back Side

Note
❒ Only the installed trays appear on the display panel.

• Adjustment
You can select the start position for printing on a page.
Horizontal : Tray 1, Horizontal : Tray 2, Horizontal : Tray 3, Horizontal :
Bypass Tray, Horizontal : Duplex Back, Vertical : Tray 1, Vertical : Tray 2,
Vertical : Tray 3, Vertical : Bypass Tray, Vertical : Duplex Back

Note
❒ Only the installed trays appear on the display panel.

❖ 4 Colour Graphic Mode
This mode adjusts levels of toner color overlap. If characters or lines blur, select-
ing [Text Priority] may make them clearer. Select [Photo Priority] for normal use.

Note
❒ Default: Photo Priority
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General Settings

❖ Plain Paper Setting
You can select plain paper mode for each tray.
• Tray 1

Plain Paper 1, Plain Paper 2
• Tray 2

Plain Paper 1, Plain Paper 2
• Tray 3

Plain Paper 1, Plain Paper 2

Note
❒ Default: Plain Paper 1

❖ Letterhead Setting
You can select the letterhead printing mode.
• Letterhead 1
• Letterhead 2
• Letterhead 3

Note
❒ Default: Letterhead 1

❖ Glossy Paper Setting
You can select the glossy paper printing mode.
• Glossy Paper 1
• Glossy Paper 2
• Glossy Paper 3
• Glossy Paper 4

Note
❒ Default : Glossy Paper 1

❖ Coated Paper Setting
You can select the coated paper printing mode.
• Coated Paper 1
• Coated Paper 2
• Coated Paper 3
• Coated Paper 4

Note
❒ Default : Coated Paper 1
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❖ Label Paper Setting
You can select the label paper setting printing mode.
• Label Paper 1
• Label Paper 2
• Label Paper 2

Note
❒ Default : Label Paper 1

❖ Envelope Setting
You can select the envelope printing mode.
• Envelope 1
• Envelope 2
• Envelope 3
• Envelope 4

Note
❒ Default : Envelope 1

❖ Replacement Alert
Use this function to specify when to warn the user about each replacing sup-
plies. 
• Photoconductor Unit

Notify Sooner, Normal, Notify Later

Note
❒ Default: Normal

• Intermediate Transfer Unit
Notify Sooner, Normal, Notify Later

Note
❒ Default: Normal

• Maintenance Kit
Notify Sooner, Normal, Notify Later

Note
❒ Default: Normal

❖ Supply End Option
You can select whether or not to continue printing, when the supply ends.
• Continue Printing
• Stop Printing

Note
❒ Default : Continue Printing
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❖ Display Supply Info
You can select whether or not to display supply status on the initial screen.
• On
• Off

Note
❒ Default : On

❖ Unit of Measure
You can specify the unit of measurement in “mm” or “inch” for the custom
paper size.
• mm
• inch

Note
❒ Default value is destination dependant.

❖ Panel Key Sound
 You can select whether or not to sound the beeper when the control panel is
pressed.
• On
• Off

Note
❒ Default : On

❖ Warm-up Beeper
You can select whether or not to sound the beeper when the warming up is
completed.
• On
• Off

Note
❒ Default: On

❖ Display Contrast
You can specify the density of the display.

❖ Key Repeat
You can specify whether or not to scroll the display panel when the {U} or
{T} key is held down. You can also specify the scroll speed (When "Long" is
selected, scroll speed will be slow).
• Do not Repeat
• Normal
• Repeat Time: Medium
• Repeat Time: Long

Note
❒ Default: Normal
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Timer Settings

❖ Auto Reset Timer
Specify whether to revert to the initial configuration at certain interval. This
also specifies the interval to reset the configuration.
• On
• Off

Note
❒ Default : On (60 seconds)

❖ Set Date
Set the date for the internal clock using the {U} or {T} key.

❖ Set Time
Set the time for the internal clock using the {U} or {T} keys.

HD Management

Specify the settings on deleting data on the hard disk when the optional hard
disk is installed.

❖ Delete All Temporary Jobs
This appears on the menu only when the hard disk is installed.
Use this function to delete all temporarily saved documents (Sample Print,
Locked Print and Hold Print data) at once.

❖ Delete All Stored Jobs
This appears on the menu only when the hard disk is installed.
Use this function to delete all saved documents (Stored Print data) at once.

❖ Auto Delete Temporary Jobs
This appears on the menu only when the hard disk is installed.
Specify whether to automatically delete temporarily saved documents (Sam-
ple Print, Locked Print and Hold Print data), such as sample print documents
or confidential documents. Also specify the time period to elapse before de-
letion.
• On
• Off

Note
❒ Default : Off
❒ If you select [On], enter a number of hours when the temporarily saved

documents will be automatically deleted. (Default : 8 hours)
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❖ Auto Delete Stored Jobs
This appears on the menu only when the hard disk is installed.
Specify whether to automatically delete saved documents (Stored Print data).
Also specify the elapse time in days before deletion.
• On
• Off

Note
❒ Default : Off
❒ If you select [On], enter a number of days when the saved documents will

be automatically deleted. (Default : 3 days)
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List/Test Print Menu

You can print lists of configurations on printer or the paper printings.
Also, you can check the types and characters of all the printable fonts.

Printing a Configuration Page

Follow the procedure below to print the configuration page.

Important
❒ The configuration page is printed on A4 or Letter (8 1/2 × 11) size paper, so

load them in the same paper tray.

A Press the {Menu} key.

The menu screen appears.

B Press the {T} or {U} key to display [List/Test Print], and then press the {OK} key.

C Press the {T} or {U} key to display [Config. Page], and then press the {OK} key.
The configuration page is printed. The [List/Test Print] menu screen returns on
completion of printing.

D Press the {Menu} key.
The initial screen appears.
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Interpreting the configuration page

❖ System Reference

❖ Unit Number
The serial number assigned to the board by its manufacturer is displayed.

❖ Total Counter
The total number of pages printed by the printer to date is displayed.

❖ Total Memory
The total amount of SDRAM installed on the printer is displayed.

❖ Firmware Version
• Printer

The version number of the printer controller firmware is displayed.
• Engine

The version number of the printer engine firmware is displayed.
• NIB

The version number of the network interface board is displayed.

❖ Device Connection
The items are displayed when the device options are installed.

❖ HDD: Font / Macro Download
You can print the hard disk status when the optional hard disk when the
optional hard disk is installed.

❖ Printer Language
The version number of the printer language is displayed.

❖ Connection Equipment
The options installed are displayed.

❖ Paper Input
Settings made on the [Paper Input] menu are displayed.

Reference
For details, see p.136 “Paper Input menu parameters”.

❖ Maintenance
Settings made on the [Maintenance] menu are displayed.

Reference
For details, see p.141 “Maintenance menu parameters”.
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❖ System
Settings made on the [System] menu are displayed.

Reference
For more information, see p.152 “System menu parameters”.

❖ Machine Modes
Setting made on the [Machine Modes] menu are displayed.

❖ PCL Menu
Settings made on the [PCL Menu] are displayed.

Reference
For details, see p.158 “PCL Menu”.

❖ PS Menu
Settings made on the [PS Menu] are displayed.

Reference
For details, see p.161 “PS Menu”.

❖ PDF Menu
Settings made on the [PDF Menu] are displayed.

Reference
For details, see p.162 “PDF Menu”.

❖ Host Interface
Settings made on the [Host Interface] menu are displayed.
When DHCP is active on the network, the IPv4 address, subnet mask and
gateway address appear in parentheses on the configuration page.

Reference
For details, see p.167 “Host Interface menu parameters”.

❖ Interface Information
Interface information is displayed.
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List/Test Print menu parameters

This section explains about parameters that can be set on the List/Test Print
menu.

❖ Multiple Lists
You can print the configuration page and error log, network summary and
supply list.

❖ Config. Page
You can print the current configuration of the printer.

❖ Error Log
You can print an error report.

❖ Network Summary
You can print the network device status.

❖ Supply Info List
You can print the supply status.

❖ Menu List
You can print a menu list showing all available menus.

❖ Colour Demo Page
You can print a Color Demo Page.

❖ PCL Config./Font Page
You can print the current configuration and installed PCL font list.

❖ PS Config./Font Page
You can print the current configuration and installed PostScript font list.

❖ PDF Config./Font Page
You can print the current configuration and installed PDF font list.

❖ Hex Dump
You can print the data sent by the computer using Hex Dump.
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System Menu

You can set basic functions required to use the printer. The printer can be used
on factory default, but the configuration can be changed depending on the con-
dition of the user. The changed condition holds even if the printer is turned off.

Changing the system menu

Follow the procedure below to change the settings for Energy Saver Timer.

A Press the {Menu} key.

The menu screen appears.

B Press {U} or {T} key to display [System], and then press the {OK} key.

C Press {U} or {T} key to display [Energy Saver], and then press the {OK} key.

D Press the {U} or {T} key to select [Energy Saver Timer], and then enter {OK} Key

E Press {U} or {T} key to select the lead time needed to switch to the Energy
Saver mode.

F Press the {OK} key.
Wait one second. The [Energy Saver] screen appears.

G Press the {Menu} key.
The initial screen appears.
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System menu parameters

This section explains about parameters that can be set on the System menu.

❖ Print Error Report
You can select [On] or [Off] to have an error report printed when a printer error
or memory error occurs.
• Off
• On

Note
❒ Default: Off

❖ Auto Continue
You can make the Auto Continue setting. When set to on, printing continues
after a system error occurs.
• Off
• Immediate
• 1 minute
• 5 minutes
• 10 minutes
• 15 minutes

Note
❒ Default: Off
❒ When set to on and certain errors occur, the current job may be canceled,

and the printer automatically perform the next queued job.

❖ Memory Overflow
You can specify whether or not to print a memory overflow error report.
• Not Print
• Error Report

Note
❒ Default: Not Print

❖ Printer Language
You can specify the printer language.
• Auto
• PCL
• PS
• PDF

Note
❒ Default: Auto
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❖ Sub Paper Size
You can select [Off] or [Auto] to enable the Sub Paper Size function. When you
select [Auto], the printer uses an alternative paper size if the currently speci-
fied paper is not loaded. When you select [Off], the printer uses any size paper
in the current specified paper tray.
• Auto
• Off

Note
❒ Default: Off

❖ Default Printer Lang.
You can specify the initial printer language if the printer cannot detect the
printer language.
• PCL
• PS
• PDF

Note
❒ Default: PCL

❖ Energy Saver
You can specify the number of minutes Energy Saver mode is applied.

❖ Energy Saver On/Off
You can specify whether or not to switch Energy Saver.
• On
• Off

Note
❒ Default: On
❒ When the printer switches to Energy Saver mode, the Power indicator

is unlit, but the Online indicator remains lit.

❖ Energy Saver Timer
You can select the lead time needed to switch to the Energy Saver mode.
The Energy Saver mode reduces electric power consumption.
• 1 minute
• 5 minutes
• 15 minutes
• 30 minutes
• 45 minutes
• 60 minutes

Note
❒ Default: 30 minutes
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❖ Memory Usage
You can select memory to be used from "Font Priority" or "Frame Priority".
• Font Priority
• Frame Priority

Note
❒ Default : Frame Priority

❖ B&W Page Detect
Specify whether to recognize black-and-white images. Use the black-and-
white recognition function to print all monochrome pages in monochrome
mode even if color printing is specified.
• Per Page
• Per Job

Note
❒ Default: Per Page

❖ Spool Printing
You can select whether all of the print data is spooled to the hard disk drive
before printing.
• On
• Off

Note
❒ Default: Off
❒ Spooling stores a sent print job temporarily in the printer, and then prints it.
❒ This menu appears only when the optional hard disk is installed.

❖ RAM Disk
If the optional hard disk is not installed for PDF Direct Print, select a value of
2 MB or higher.
This menu appears only when the optional hard disk is not installed.
• 0 MB
• 2 MB
• 4 MB
• 8 MB
• 16 MB

Note
❒ Default: 4 MB

Important
❒ When the amount of SDRAM is small and RAM Disk is set to 16 MB, print-

ing may not be possible depending on the print job and duplex printing
may be canceled. If this happens, increase the amount of SDRAM, or set
RAM Disk to 8 MB or less.

Reference
For details about the optional SDRAM module, see Hardware Guide.
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❖ Notify by Email
You can specify whether or not to send an error message to a preset e-mail ad-
dress when an error occurs in the printer.
• On
• Off

Important
❒ After changing the setting, turn off the power of the printer briefly, and

then turn it on again.

Note
❒ Default: On

Reference
For information, see Web Image Monitor Help.
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Print Settings Menu

You can set conditions for printing.

Changing the Print Settings Menu

Follow the procedure below to change the Bypass Tray Priority.

A Press the {Menu} key.
The menu screen appears.

B Press the {U} or {T} key to display [Print Settings], and then press the {OK} key.

C Press the {U} or {T} key to display [Machine Modes], and then press the {OK} key.

D Press the {U} or {T} key to display [Bypass Tray Priority], and then press the
{OK} key.

E Press the {U} or {T} key to select the priority, and then press the {OK} key.
Wait one second. The [Machine Modes] menu appears.

F Press the {Menu} key.
The initial screen appears.

Print Settings menu parameters

This section explains parameters that can be set on the Print Settings menu.

❖ Machine Modes

❖ Copies
You can specify the number of pages to print.
This setting is disabled if the number of pages to print is specified by com-
mand or the printer driver.
• 1-999

❖ Page Size
You can specify the default paper size.

: A4 (210 mm × 297 mm), B5 JIS (182 mm × 257 mm), A5 (148
mm × 210 mm), B6 JIS (128 mm × 182 mm), A6 (105 × 148), 16K (195 mm ×
267 mm), 41/8 × 91/2, 37/8 × 71/2, C5 Env (162 mm × 229mm), C6 Env (114
mm × 162 mm), DL Env (110 mm × 220 mm), Custom Size.

: 81/2” × 14”, 81/2” × 11”, 51/2” × 81/2”, 71/4” × 101/2”, 8” × 13”,
81/2” × 13”, 81/4” × 13”, A4 (210 mm × 297 mm), B5 JIS (182 mm × 257 mm),
A5 (148 mm × 210 mm), B6 JIS (128 mm × 182 mm), A6 (105 mm × 148 mm),
16K (195 mm × 267 mm), 41/8 × 91/2, 37/8 × 71/2, C5 Env (162 mm ×
229mm), C6 Env (114 mm × 162 mm), DL Env (110 mm × 220 mm), Custom
Size.
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Note
❒ Default:

• : A4 (210 mm × 297 mm)
• : 81/2” × 11”

❒ The initial paper size is applied when the paper size is not specified in
the print data.

❖ Edge to Edge Print
You can print on the complete area of a sheet leaving no border on any
edge.
• Off
• On

❖ Duplex
You can specify whether or not to print on both sides of a sheet.
• Off
• Short Edge Bind
• Long Edge Bind

Note
❒ Default: Off
❒ This menu appears only when the optional duplex unit is installed.

❖ Rotate by 180 Degrees
You can select whether or not to rotate the image by 180 degrees when
printing.
• On
• Off

Note
❒ Default: Off

❖ Blank Page Print
You can specify whether or not to print blank pages.
• Do not print
• Print

Note
❒ Default: Print
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❖ Letterhead Setting
You can select the letterhead printing mode.
• Off
• Auto Detect
• On (Always)

Note
❒ Default: Off

❖ Bypass Tray Priority
When the different paper size or type is specified from the driver, you can
specify which setting is given priority to, printer setting or command.
• Driver/Command
• Machine Settings

Note
❒ Default: Driver/Command

❖ Tray Switching
Specify the printer to change printing to the suitable tray, when printer
driver specifies different paper size or type from the current tray.
• Off
• On

Note
❒ Default: Off

❖ PCL Menu
You can set conditions when using PCL for printing.

❖ Orientation
You can select the page orientation.
• Portrait
• Landscape

Note
❒ Default: Portrait

❖ Form Lines
You can specify the number of lines per page between 5 and 128.

Note
❒ Default:

• : 60
• : 64
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❖ Font Source
You can set the location of the default font.
• Resident
• RAM
• HDD
• SD
• SD Font Download

Note
❒ Default: Resident
❒ When you select [RAM], you can select only fonts downloaded to the

printer RAM.
❒ When you select [HDD], you can select only fonts downloaded to the op-

tional hard disk.
❒ When you select [SD], you can select only fonts for downloaded to the

SD card.
❒ When you select [SD Font Download], you can select only fonts for down-

loaded to the SD card without the optional hard disk.

❖ Font Number
You can specify the ID of the default font you want to use.
• 0 to 63 (Internal)
• 1 to 63 (Download)

❖ Point Size
You can specify the point size you want to use for the default font between
4 and 999.75 in 0.25 increments.

Note
❒ Default: 12.00 points
❒ This setting is effective only for a variable-space font.

❖ Font Pitch
You can specify the number of characters per inch you want to use for the
default font between 0.44 and 99.99 in 0.01 increments.

Note
❒ Default: 10.00 pitch
❒ This setting is effective only for fixed-space fonts.
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❖ Symbol Set
You can specify the character set for the default font. Available sets are as
follows:
Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-
TK, Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ,
Math-8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO
17, ISO 21, ISO 60, ISO 69, Win 3.0

Note
❒ Default: PC-8

❖ Courier Font
You can select a courier-type font.
• Regular
• Dark

Note
❒ Default: Regular

❖ Ext. A4 Width
You can extend the width of the printable area of A4 sheets reducing side
margin width.
• Off
• On

Note
❒ Default: Off

❖ Append CR to LF
You can specify whether or not to append a CR code to each LF code to
print text data clearly.
• Off
• On

Note
❒ Default: Off

❖ Resolution
You can specify the print resolution in dots per inch.
• 300 dpi
• 600 dpi

Note
❒ Default: 600 dpi
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❖ PS Menu
You can set conditions when using Postscript for printing.

❖ Data Format
You can select the data format.
• Binary
• TBCP
This setting is effective when using a parallel, USB, or EtherTalk connection.
When you use a parallel or USB connection, the print job is canceled if bi-
nary data is sent from the printer driver.
When you use an Ethernet connection, the print job is canceled if:
• The printer driver data format is TBCP and the data format selected us-

ing the control panel is Binary Data.
• The printer driver data format is binary and the data format selected us-

ing the control panel is TBCP.

Note
❒ Default: TBCP

❖ Resolution
You can select the resolution.
• 600dpi Fast
• 600dpi Standard
• 1200dpi

Note
❒ Default: 600dpi Fast

❖ Colour Setting
You can make an RGB setting.
• None
• Fine
• Super Fine

Note
❒ Default: Super Fine

❖ Colour Profile
You can select the color profile.
• Auto
• Presentation
• Solid Colour
• Photographic
• User Setting

Note
❒ Default: Auto
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❖ PDF Menu
You can set conditions when using PDF printing.

❖ Change PDF Password
You can specify the password for the PDF file executing PDF Direct Print.

Important
❒ If you do not set a PDF password, this menu does not appear.

Note
❒ The password can be set using Web Image Monitor, but must be sent

through the network. For increased security, use this menu on the con-
trol panel to set the password directly.

❖ PDF Group Password
You can set a group password specified using DeskTopBinder Lite.

Important
❒ If you do not set a PDF group password, this menu does not appear.

Note
❒ When you use a group password, the optional data protection unit must

be installed.
❒ The password can be set using Web Image Monitor, but must be sent

through the network. For increased security, use this menu on the con-
trol panel to set the password directly.

❒ Default: no password set

❖ Resolution
You can select the resolution for the PDF file executing PDF Direct Print.
• 600dpi Fast
• 600dpi Standard
• 1200dpi

Note
❒ Default: 600dpi Fast

❖ Colour Setting
You can make an RGB setting for the PDF file executing PDF Direct Print.
• None
• Fine
• Super Fine

Note
❒ Default: Super Fine
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❖ Colour Profile
You can select the color profile for the PDF file executing PDF Direct Print.
• Auto
• Presentation
• Solid Colour
• Photographic
• User Setting

Note
❒ Default: Auto
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Security Options Menu
You can specify security settings.
Depending on the security settings, certain items may not be displayed.

Changing the Security Options menu
Follow the procedure below to change the Erase All Memory.

A Press the {Menu} key.

The menu appears.

B Press the {U} or {T} key to display [Security Options], and then press the {OK} key.

C Press the {U} or {T} key to display [Extended Security], and then press the {OK} key.

D Press the {U} or {T} key to display [Erase All Memory], and then press the {OK} key.

E Press the {U} or {T} key to select the erase method, and then press the {OK} key.
When you select [Random Numbers], enter overwrite times.
All memories will be erased.

FWhen the confirmation screen appears, press the {Exit} key.
Message appears.

G Turn off the power.

Security Options menu parameters
This section explains parameters that can be set on the Security Options menu.

❖ Extended Security

❖ Driver Encryption Key
You can specify the driver encryption key.

❖ Encrypt Address Book
You can select whether or not to encrypt the data in the address book.

AQC001S
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❖ Service Mode Lock
You can select whether or not to enter into service mode.
• On
• Off

Note
❒ Default: Off

❖ Firmware Version
Displays the firmware version installed on this printer.

❖ Network Security Level
You can specify the network level.
• Level 0
• Level 1
• Level 2

Note
❒ Default: Level 0

❖ Auto Erase Memory Setting
This function is available when the Optional Overwrite Security Unit is in-
stalled. Selects whether or not to automatically delete memory, and select de-
letion method and time when you do.
• On

HD Erase Method: NSA, DoD, Random Numbers
No. of Overwrites: between 1 - 9

• Off

❖ Erase All Memory
Deletes all data inside the memory. Select the deletion method, and then set
the overwrite times.

❖ HD Erase Method
• NSA
• DoD
• Random Numbers

❖ No. of Overwrites
between 1 - 9

❖ Transfer Log Setting
You can select whether or not to send the log.
• On (Only available from the log collection server.)
• Off

Note
❒ Default: Off
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Host Interface Menu

You can set configurations about network connections and communication
when using parallel connection between the printer and the computer. The
changed configuration holds even if the printer is turned off.

Changing the Host Interface menu

Follow the procedure below to change the I/O Timeout.

A Press the {Menu} key.

The menu screen appears.

B Press the {U} or {T} key to display [Host Interface], and then press the {OK} key.

C Press the {U} or {T} key to display [I/O Timeout], and then press the {OK} key.

D Press the {U} or {T} key to select the lead time needed to end a printing op-
eration, and then press the {OK} key.
Wait one second. The [Host Interface] menu appears.

E Press the {Menu} key.
The initial screen appears.
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Host Interface menu parameters

This section explains parameters that can be set on the Host Interface menu.

❖ I/O Buffer
You can select the size of I/O Buffer. Normally it is not necessary to change
this setting.
• 128 KB
• 256 KB

Note
❒ Default: 128 KB

❖ I/O Timeout
You can set how many seconds the printer should wait before ending a print
job. If printing operation is frequently interrupted by data from other ports,
you can increase the timeout period.
• 10 seconds
• 15 seconds
• 20 seconds
• 25 seconds
• 60 seconds

Note
❒ Default: 15 seconds

❖ Network
You can make network-related settings.

Important
❒ This menu appears only when the optional 802.11 interface unit is in-

stalled.

Reference
For details, see “Configuration”, Hardware Guide.
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❖ Machine IPv4 Address
You can select whether to set the IPv4 address automatically or manually.
• Auto-Obtain (DHCP)

When DHCP is set to on, the IPv4 address cannot be changed. To
change it, set DHCP to off. Contact your network administrator for in-
formation about the network configuration.

• Specify
You can specify the IPv4 address.

Note
❒ Default: 011.022.033.044

• Sub-net Mask
You can specify the subnet mask.
When DHCP is set to on, the subnet mask cannot be changed. To change
it, set DHCP to off. Contact your network administrator for information
about the network configuration.

Note
❒ Default: 000.000.000.000

• Gateway Address
You can specify the gateway address.
When DHCP is set to on, the gateway address cannot be changed. To
change it, set DHCP to off. Contact your network administrator for in-
formation about the network configuration.

Note
❒ Default: 000.000.000.000

❖ IPv6 Stateless Setting
You can enable or disable IPv6.
• Effective
• Invalid

Note
❒ Default: Effective

❖ NW Frame Type 
You can select the frame type for NetWare.
• Auto Select
• Ethernet II
• Ethernet 802.2
• Ethernet 802.3
• Ethernet SNAP

Note
❒ Default: Auto Select
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❖ Effective Protocol
You can select the effective protocol.
• IPv4

Effective, Invalid

Note
❒ Default: Effective

• IPv6
Effective, Invalid

Note
❒ Default: Invalid

• NetWare
Effective, Invalid

Note
❒ Default: Effective

• SMB
Effective, Invalid

Note
❒ Default: Effective

• AppleTalk
Effective, Invalid

Note
❒ Default: Effective

❖ Ethernet Speed
You can select the network speed to operate the printer.
• Auto Select
• 10Mbps Half Duplex
• 10Mbps Full Duplex
• 100Mbps Half Duplex
• 100Mbps Full Duplex

Note
❒ Default: Auto Select

❖ LAN Type
You can select Ethernet or IEEE 802.11b for LAN Type.
This menu appears only when the optional 802.11 interface unit is in-
stalled.
• Ethernet
• IEEE 802.11b

Note
❒ Default: Ethernet
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❖ IEEE 802.11b
You can make settings for wireless LAN. This menu appears only when the
optional 802.11b interface unit is installed.

❖ Communication Mode
You can select the transmission mode for IEEE 802.11b.
• 802.11 Ad hoc
• Infrastructure
• Ad hoc

Note
❒ Default: 802.11 Ad hoc
❒ Communication Mode can also be set using a Web Image Monitor. For

details, see Web Image Monitor Help.

❖ SSID Setting
You can set an SSID in the infrastructure mode and the 802.11 Ad hoc
mode.

Note
❒ Default: blank (ASSID)
❒ Select [?] to enter [/] for the SSID. Also, [¥] appears when printing the

configuration page, read it as [/].
❒ Characters used are ASCII 0x20-0x7e (32 bytes).
❒ An SSID is set automatically to the nearest access point if no SSID has

been set.
❒ If no SSID has been set for the 802.11 ad hoc mode, an SSID is set auto-

matically and the same SSID is used for the 802.11 ad hoc mode and the
infrastructure mode.

❒ If blank is specified in SSID for 802.11b adhoc mode or adhoc mode,
“ASSID” appears.

❒ An SSID can also be set using Web Image Monitor. For details, see Web
Image Monitor Help.

❖ Channel
You can select channels: 1-14 ( )/1-11 ( ).

Note
❒ Default: 11 (  and )
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❖ Security Method
You can enable or disable encryption. You can also specify the security
type when the encryption is enabled.
• Off
• WEP

Hex:10/26,ASCII:5/13 Digits
• WPA

Encryption Method (TKIP, COMP(AES)), Authentication Method
(WPA-PSK, WPA(802.1X))

Note
❒ Default: Off
❒ The WEP key can be entered using a hexadecimal number or an ASCII

character sequence.
❒ The WPA-PSK can be entered using an ASCII character sequence.
❒ When using 64 bit WEP, up to 10 hexadecimal or 5 ASCII characters can

be entered. When using 128 bit WEP, up to 26 hexadecimal or 13 ASCII
characters can be entered.

❒ The WEP key can also be set using Web Image Monitor. For details, see
Web Image Monitor Help.

❖ Wireless LAN Signal
You can check the signal strength when using LAN.

❖ Communication Speed
You can select the transmission speed for IEEE 802.11b.
• Auto
• 11Mbps Fixed
• 5.5Mbps Fixed
• 2Mbps Fixed
• 1Mbps Fixed

Note
❒ Default: Auto

❖ Restore Defaults
Reset the wireless LAN to default.

❖ USB Setting
You can make setting for USB Host interface.
This menu appears only when the optional USB Host interface unit is in-
stalled.
• Auto
• Full Speed

Note
❒ Default: Auto
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Language Menu

You can set language displayed on the menu.

Changing the language menu

Follow the procedure below to change the language.

A Press the {Menu} key.

The menu screen appears.

B Press the {U} or {T} key to display [Language], and then press the {OK} key.

C Press the {U} or {T} key to select the language, and then press the {OK}
key.
Wait one second. The [Language] menu screen appears.

D Press the {Menu} key.
The initial screen appears.

Language menu parameters

You can select the language you use. Available languages are as follows:
English, German, French, Italian, Dutch, Swedish, Norwegian, Danish, Spanish,
Finnish, Portuguese, Czech, Polish, Hungarian.

Note
❒ Default: English
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Using Web Image Monitor

Using Web Image Monitor, you can check the printer status and change settings. 

❖ Available operations
The following operations can be remotely performed using Web Image Mon-
itor from a client computer.
• Displaying printer status or settings
• Checking the print job status or history
• Interrupting currently printing jobs
• Resetting the printer
• Managing the Address Book
• Making printer settings
• Making e-mail notification settings
• Making network protocol settings
• Making security settings

❖ Configuring the printer
To perform the operations from Web Image Monitor, TCP/IP is required. Af-
ter the printer is configured to use TCP/IP, operations from Web Image Mon-
itor become available.

❖ Recommended Web browser
• Windows:

Internet Explorer 5.5 SP2 or higher
Firefox 1.0 or higher

• Mac OS:
Firefox 1.0 or higher
Safari 1.0, 1.2, 2.0(412.2) or higher
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Note
❒ Safari cannot be used on Mac OS X 10.4.1.
❒ If the previous versions of the Web browser above are used or JavaScript and

cookies are not enabled with the Web browser used, display and operation
problems may occur.

❒ If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

❒ The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

❒ Updating the printer information is not automatically performed. Click [Re-
fresh] in the display area to update the printer information.

❒ We recommend using Web Image Monitor in the same network. 
❒ You cannot access to the printer from outside the firewall.
❒ When using the printer under DHCP, the IPv4 address may be automatically

changed by the DHCP server settings. Enable DDNS setting on the printer,
and then connect using the printer's host name. Alternatively, set a static IPv4
address to the DHCP server.

❒ If the HTTP port is disabled, connection to the printer using the printer's URL
cannot be established. SSL setting must be enabled on this printer. For details,
consult your network administrator.

❒ When using the SSL encryption protocol, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the most
recent available version. We recommend Internet Explorer 6.0 or later.

❒ When you are using Firefox, fonts and colors may be different, or tables may
be out of shape.
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Displaying Top Page
This section explains the Top Page and how to display Web Image Monitor.

A Start your Web browser.

B Enter “http://(printer's address)/” in the address bar of a Web browser.
Top Page of Web Image Monitor appears.
If the printer's host name has been registered on the DNS or WINS server, you
can enter it.
When setting SSL, a protocol for encrypted communication, under environment
which server authentification is issued , enter “https://(printer's address)/”.
Every Web Image Monitor page is divided into the following areas:

1. Menu area
If you select menu, it's content will be
shown on the work area, or the sub area.

2. Tab area
Details about each menu appears.

3. Header area
The dialog box for switching to the
guest mode and administrator mode
appears, and each mode's menu will
be displayed. 
The link to help and dialog box for
keyword search appears.

4. Help
Use Help to view or download Help
file contents.

5. Display area
Displays the contents of the item se-
lected in the menu area.
Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser's
[Refresh] button to refresh the entire
browser screen.

Reference
For details the printer's host name has been registered on the DNS or
WINS server, see p.323 “Using DHCP”.
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When user authentication is set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

A Click [Login].

B Enter a login user name and pass word, and then click [Login].
For details about the login user name and password, consult your network
administrator.

Note
❒ For user code authentication, enter a user code in [User Name], and then

click [OK].
❒ The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Click [Logout] to log off.

Note
❒ When you log on and made the setting, always click [Logout].
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About Menu and Mode

There are two modes available with Web Image Monitor: guest mode and ad-
ministrator mode.
Displayed items may differ depending on the printers.

❖ About Guest Mode
In the gest mode, printer status, settings, and print job status can be viewed,
but the printer settings cannot be changed.

1. Home
The [Status], [Configuration], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Printer: Print Jobs
Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

3. Job
Display all print files.

4. Configuration
Display current printer and network
settings.

1
3 24
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❖ Administrator Mode
In the administrator mode, you can configure various printer settings.

1. Home
The [Status], [Configuration], [Counter],
and [Inquiry] tab are displayed. Details
of the tab menu are displayed on the
work area.

2. Printer: Print Jobs
Allows you to display list of Sample
Print, Locked Print, Hold Print, and
Stored Print jobs.

3. Job
Display all print files.

4. Address Book
User information can be registered,
displayed, changed, and deleted.

5. Configuration
Make system settings for the printer,
interface settings, and security.

6. Reset Device
Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

7. Reset Printer Job
Click to reset current print jobs and
print jobs in queue. This button is lo-
cated on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].
The dialog box for entering the user name and password appears.

B Enter your user name and password, and then click [OK].
For details about the login user name and password, consult your network
administrator.
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Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked “?” in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

Note
❒ By clicking [Help] in the header area, the contents of Help appear.
❒ By clicking “?”, the Help icon in the display area, Help for the setting items in

the display area appears.

Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decompress
the file.
To view the downloaded Web Image Monitor Help, set the path to the loca-
tion of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [Help URL] box, enter the URL of the help file.
For example, if you saved the file to a Web server, and the URL of the index file
is “http://a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

E Click [Apply].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

Important
❒ IPv6 cannot be used on this function.

❖ Protocol stack provided with Operating System
• Windows 95/98/Me

TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP
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❖ Available operations
The following functions are available:
• Printer Information function

• Display the network settings and detailed information of the printer.
• Display the number of pages printed under each user code.
• Display the status of print jobs sent from computers.
• Change the printer network settings.

• Device Settings function
• Lock some of the setting items on the control panel so that they cannot

be changed using the control panel.
• Select type of paper loaded in the paper trays.

• Energy Saver function
• Enable or disable the Energy Saver mode.

• System Status function
• Display the information such as when paper is depleted during printing

on a computer.
• Groups function

• Monitor multiple printers at the same time. When there are multiple
printers to manage, you can create groups and classify the printers to fa-
cilitate management.

• You can customize printer status according to groups, and send status
notification e-mail to a computer.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [SmartDeviceMonitor for Admin] installation, and then click [Next >].

E The software license agreement appears in the [License Agreement] dialog box.
After reading through its contents, click [I accept the agreement.] if you agree,
and then click [Next >].

F Follow the instructions on the screen.
A message appears when the installation is complete.
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G Click [OK].

Note
❒ Auto Run may not work under certain operating system settings. In this

case, launch “Setup.exe” located on the CD-ROM root directory.
❒ If you are required to restart the computer after installing SmartDevice-

Monitor for Admin, restart the computer and continue the configuration.
❒ SmartDeviceMonitor for Admin supports following languages: Czech,

Danish, German, English, Spanish, French, Italian, Hungarian, Dutch,
Norwegian, Polish, Portuguese , Finnish, Swedish, Chinese Simple and
Chinese Traditional.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3]. A list of printers using the selected protocol ap-
pears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.

C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the user name and
password for the Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your network
administrator.

F Configure settings using Web Image Monitor.

G Click [Logout].

H Quit Web Image Monitor.

I Quit SmartDeviceMonitor for Admin.

Reference
For details about Web Image Monitor, see p.173 “Using Web Image Mon-
itor”.
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Locking the Menus on the Printer's Control Panel

Follow the procedure below to lock the menus on the printer's control panel.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.

C Select a printer.

D On the [Tools] menu, point to [Device Settings], and then click [Lock Operation
Panel Menu].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

E Enter the user name and password, and then click [Login].
For details about the user name and password, consult your network admin-
istrator.
The [System] page of Web Image Monitor appears.

F Enter required setting items, click [OK].

G Click [Logout].

H Quit Web Image Monitor.

I Quit SmartDeviceMonitor for Admin.

Reference
For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.
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C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Select Paper Type].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.

E Enter the user name and password, and then click [Login].
For details about the login user name and password, consult your network
administrator.
The [Paper] page appears.

F Select a paper type in the [Paper Type] list for each tray.

G Enter required setting items, click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Reference
For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.
Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.

C In the list, select a printer you want to manage.

D On the [Tools] menu, click [User Management Tool].
The dialog box for entering the user name and password appears.
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E Enter the user name and password, and then click [OK].
For details about the user name and password, consult your network admin-
istrator.
User Management Tool starts.

Reference
For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
User Code.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.
The number of pages printed under each User Code appears.

C Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each User Code as a “.csv” file.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
User Code to 0.

A Start SmartDeviceMonitor for Admin .

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].
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E Select the check box of the items you want to reset, and then click [OK].
A confirmation message appears.

F Click [OK].
The number of pages printed is reset to 0.

G On the [Edit] menu, click [Apply Settings].
Changes are applied to information on the [User Counter Information] tab.

H Click [Exit] on the [File] menu to quit User Management Tool.

Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin.

B Click the [User Counter Information] tab of User Management Tooll.

C On the [Edit] menu of User Management Tool, click [Restrict Access To Device].

D Select the check box of the functions you want to restrict.

E Click [OK].
A confirmation message appears.

F Click [Yes].
The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin.

B Click the [Access Control List] tab of User Management Tool.

C On the [Edit] menu, click [Add New User].

D Enter the User Code and user name.

E Select the check box of the functions applicable to the new user.
If the check boxes are unavailable, there is no restriction to use that function.
For details, see SmartDeviceMonitor for Admin Help.

F Click [OK].
The new user is added.



Using SmartDeviceMonitor for Admin

87

6

1

G On the [Edit] menu, click [Apply Settings].
The settings are applied.

H Click [Edit] on the [File] menu to quit User Management Tool.

Reference
For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.

Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.

C Select the printer whose settings you want to make.
To make settings for all printers in the selected group, select no printer.

D On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected printer or point to [Set By Group] to
make the settings for all printers in the selected group, and then click [On]
or [Off].

E Quit SmartDeviceMonitor for Admin.

Reference
For details about the setting value for Energy Saver mode, see SmartDe-
viceMonitor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printers using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMPv3, enter the user authentication.
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C In the list, select a printer whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the user name and password, and then click [Login].
For details about the user name and password, consult your network admin-
istrator.
Top Page of Web Image Monitor appears.

F Click [Configuration].

G Click [Device Settings].

H Click [Program/Change Administrator], and then change the settings.

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Checking the Printer Status

Follow the procedure below to check printer status.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
The status of printers is indicated by icons in the list.
If you are using TCP/IP SNMPv3, enter the user authentication.

C To obtain status details, click the printer in the list, and then click [Open] on
the [Device] menu.
The printer status appears in the dialog box.

D Click [System] or [Printer].
The printer status appears in the dialog box.

E Quit SmartDeviceMonitor for Admin.

Note
❒ For details about status icons and items in the dialog box, see SmartDevice-

Monitor for Admin Help.
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Changing Names and Comments

Follow the procedure below to change the names and comments of the printer.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3]. A list of printers using the selected protocol ap-
pears.
Select the protocol of the printer whose configuration you want to change.
The status of printers is indicated by icons in the list.
If you are using TCP/IP SNMPv3, enter the user authentication.

C Select a printer in the list.

D On the [Tools] menu, click [NIB Setup Tool].
A Web browser opens and the dialog box for entering the password for the
Web Image Monitor administrator appears.
NIB Setup Tool starts when the network interface board is default. Follow the
instruction on the screen.

E Enter the user name and password, and then click [Login].
Top Page of Web Image Monitor appears.
For details about the login user name and password, consult your network
administrator.

F Click [Configuration].

G Click [System] on the [Device Settings] area, and then change the settings.

H Click [OK].
• In the [Device Name] box, enter a device name on the printer using up to 31

characters.
• In the [Comment] box, enter a comment on the printer using up to 31 char-

acters.

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.
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Viewing and Deleting Spool Print Jobs

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device<TCP/IP>], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].
A list of printer using the selected protocol appears.
Select the protocol of the printer whose configuration you want to change.
If you are using TCP/IP SNMP v3, enter the user authentication.

C Select a printer in the list, and then click [Spool Printing Job List(Printer)] on the
[Tools] menu.
A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.

D Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your network
administrator.
Spool Printing Job List appears in the Web Image Monitor.
To delete the Spool Printing Job, select the document you want to delete and
then click [Delete].

Note
❒ To display Spool Printing Job List, spool must be set to [Enable] on Web Im-

age Monitor in advance.
❒ For details, see Help in the Spool Printing Job List area.
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Using SmartDeviceMonitor for Client

To view the status of printers using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the printer using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, point to [Properties],
and then click [Option...].
The [SmartDeviceMonitor for Client -Options] dialog box appears.

B Select the printer you want to monitor, and then select the [To Be Monitored]
check box in the Monitoring Information Settings area.
To display the printer status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

C Click [OK].
The dialog box closes and the configured printer is monitored.

Note
❒ For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Printer Status

Follow the procedure below to check printer status using SmartDeviceMonitor
for Client.

A Start SmartDeviceMonitor for Client.

B For status details, right-click the SmartDeviceMonitor for Client icon, and
then click the printer.
The printer status appears in the dialog box.

Note
❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-

ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:
• The network printer can only receive one print job from SmartDeviceMonitor

for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the paused
status from the print queue window. SmartDeviceMonitor for Client will
resume access to the network printer. You can delete the print job from the
print queue window, but canceling a print job printed by the network printer
might cause the next job sent from another user to be incorrectly printed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentification is issued, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the printer using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].
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Printer Status Notification by E-Mail
Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is is-
sued to the registered addresses to notify the printer status.
For this notification, you can make the e-mail notification settings.
Notification timing and e-mail content can be set.
You can be notified of the following events:
• Service call.
• Toner cartridge is empty.
• Toner cartridge is nearly empty.
• Photoconductor unit needs replacing.
• Photoconductor unit will need replacing soon.
• Waste toner bottle is full.
• Waste toner bottle is nearly full.
• Stapler has no staples.
• Fusing unit needs replacing.
• Fusing unit will need replacing soon.
• Maintenance kit needs replacing.
• Paper has jammed.
• Open door is detected.
• Paper tray is empty.
• Paper tray error.
• Output paper tray is full.
• Unit connection error.
• Duplex unit error.
• Hard disk drive is full.
• Development Unit needs replacing.
• Development Unit will need replacing soon.
• Transfer Unit needs replacing.

A On the [System] menu, set [Notify by Email] to [On] using the control panel.
The default is [On].

B Open a Web browser, and then enter “http://(printer's address)/” in the address bar.
Top Page of Web Image Monitor appears.
When setting SSL, a protocol for encrypted communication, under environment
which server authentification is issued , enter “https://(printer's address)/”.

C Click [Login] on Top Page of Web Image Monitor.
The window for entering the login user name and password appears.

D Enter the user name and password, and then click [OK].
For details about the login user name and password, consult your network
administrator.
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E In the menu area, click [Configuration].

F Click [Device Settings], and then click [E-mail].

GMake the following settings:
• Items in the Reception column: Make the necessary settings for sending

and receiving e-mail.
• Items in the SMTP column: Configure the SMTP server. Check your mail-

ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

• Items in the E-mail Reception Port column: Configure the port to be used
for access to the mail server.

• Items in the E-Mail Notification Account column: Specify these items if
you want to use on-demand e-mail notification.

H Click [OK].

Reference
For details, see p.151 “System Menu”.

Auto E-mail Notification

A Click [Configuration] in the menu area, and then click [Auto E-mail Notification]
on the [Device Settings] area.
The dialog box for making notification settings appears.

BMake the following settings:
• Items in Notification Message column: You can set this according to your

needs, for example, the printer's location, service representative contact in-
formation.

• Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as printer status and error.
To make detailed settings for these items, [Edit] next to [Detailed Settings of
Each Item].

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.
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On-demand E-mail Notification

A Click [Configuration] in the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.
The dialog box for making notification settings appears.

B Click [Edit].

CMake the following settings:
• Notification Subject: Enter a text string to be added to the subject line of re-

turn e-mails.
• Items in Notification Message column: You can set this according to your

needs, for example, the printer's location, service representative contact in-
formation.

• Items in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

D Click [OK].

E Click [Logout].

F Quit Web Image Monitor.

Mail authentication
You can configure mail authentication to prevent illegal use of the mail server.

❖ SMTP Authentication
Specify SMTP authentication.
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password. This prevents illegal use of the SMTP server.
A In the menu area, click [E-mail]
B Make the following settings:

• SMTP Authentication: Enable or disable SMTP authentication.
• SMTP Auth. E-mail Address: Enter the e-mail address.
• SMTP Auth. User Name: Enter the SMTP account name.
• SMTP Auth. Password: To set or change the password for SMTP AUTH.
• SMTP Auth. Encryption: Select whether to encrypt the password or not.

[Encryption]-[Auto Select]: If the authentication method is PLAIN,
LOGIN, CRAM-MD5, or DIGEST-MD5.
[Encryption]-[Enable]: If the authentication method is CRAM-MD5 or DI-
GEST-MD5.
[Encryption]-[Disable]: If the authentication method is PLAIN or LOGIN.
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C Click [OK].
D Click [Logout].
E Quit Web Image Monitor.

❖ POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.
A In the menu area, click [E-mail].
B Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.
• POP E-mail Address: Enter the e-mail address.
• POP User Name: Enter the POP account name.
• POP Password: To set or change the POP password.
• Timeout setting after POP Auth.: Enter the time available before con-

necting to the SMTP server after logging on to the POP server. 
C Click [OK].
D Click [Logout].
E Quit Web Image Monitor.

Sending On-demand E-mail

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.
A In the menu area, click [E-mail].
B Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric
characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail no-
tification.

• E-mail Notification User Name: Enter the administrator's user name as the
mail originator name.

• E-mail Notification Password: Enter the password of the mail notification
user.

C Click [OK].
D Click [Logout].
E Quit Web Image Monitor.
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❖ Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message to
this printer.
Using your mail software, enter the following:

Note
❒ A mail message must be within 1 MB in size.
❒ E-mail may be incomplete if sent immediately after power on.

❖ Subject field
Format: devicestatus?parametername=parameter[&=parameter][&=parame-
ter]...

Note
❒  The Subject field is case-insensitive.
❒ Parameter names can be written in any order.

❖ Subject field coding examples

❖ Parameters

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For de-
tails, see the table below.

From (Referred to as From) Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.

Coding example Action

devicestatus?request=sysconfig&for-
mat=text&lang=en

The device's system configuration informa-
tion will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration informa-
tion will be sent in a preset format and lan-
guage.

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the for-
mat preset for each mail ad-
dress.

lang Language for mail body Mail will be sent in the lan-
guage preset for each mail 
address.
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❖ Parameters specifying the information to be obtained

❖ Parameters specifying the mail format

Note
❒ HTML and XML can be selected for subject field, but output is text only.

❖ Parameters specifying the language for mail body

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Mail format Parameter

Text text

HTML html

XML xml

Language for mail body Parameter

English en

French fr

German de

Italian it

Spanish es

Dutch nl

Danish da

Finnish fi

Norwegian no

Portuguese pt

Czech cs

Polish pl

Hungarian hu
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Remote Maintenance by telnet

Important
❒ Remote Maintenance should be password-protected so that access is allowed

to administrators only.
❒ The password is the same as the one of Web Image Monitor administrator.

When the password is changed using “mshell”, other passwords change also.
❒ Some commands cannot be used depending on your printer.

Using telnet

Follow the procedure below to use telnet.

Important
❒ Only one user at a time can log on to perform remote maintenance.

A Use the IP address or the host name of the printer to start telnet.
% telnet “IP_address”

B Enter your user name and password.
Contact your network administrator for information about the settings.

C Enter a command.

D Quit telnet.
msh> logout

The configuration message about saving the changes appears.

E Enter “yes” to save the changes, and then press the {OK} key.
If you do not want to save the changes, enter “no”, and then press the {OK}
key. To make further changes, enter “return” at the command line, and then
press the {OK} key.

Note
❒ If the message “Can not write NVRAM information” appears, the changes

are not saved. Repeat the procedure above.
❒ When the changes are saved, the network interface board is reset automat-

ically with that changes.
❒ When the network interface board resets, the print job in print process will

be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings
msh> access

❖ IPv4 Configuration
msh> access [×] range “start-address end-address”
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv4 addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range6 192.168.0.10 192.168.0.20

❖ IPv4 Configuration
msh> access [×] range “start-address end-address”
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv4 addresses between 192.168.0.10 and
192.168.0.20:
msh> access 1 range6

❖ IPv6 Configuration
msh> access [×] range6 “start-address end-address”
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv6 addresses between 2001:DB8::100 and
2001:DB8::200.
msh> access 1 range6 2001:DB8::100 2001:DB8::200

❖ IPv6 access mask Configuration
msh> access [×] mask6 “base-address prefixlen”
• [×] represents a target number between 1 and 5. (Up to five access ranges

can be registered and selected.)
Example: to specify accessible IPv6 addresses to 2001:DB8::/32 
msh> access 1 mask6 2001:DB8:: 32

❖ Access control initialization 
msh> access flush

• Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0” for IPv4, and “::” for IPv6.
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Note
❒ The access range restricts computers from use of the machine by IP address.

If you do not need to restrict printing, make the setting “0.0.0.0” for IPv4, and
“::” for IPv6.

❒ Valid ranges must be from lower (start address) to higher (end address).
❒ If you are running IPv4 or IPv6, up to five access ranges can be registered and selected.
❒ IPv6 can register and select the range and the mask for each access ranges.
❒ IPv6 mask ranges between 1 - 128 can be selected.
❒ Up to five access ranges can be specified. The entry is invalid if the target

number is omitted.
❒ You cannot send print jobs, or access Web Image Monitor and diprint from a

restricted IP address.

appletalk

Use the “appletalk” command to view and configure Appletalk parameters.

❖ View settings
msh> appletalk

• [2] means “active” and [0] means “inactive”.
• The default is [2].

❖ Changing PAP timeout configuration
msh> appletalk ptimeout value > 0

• Timeout value becomes effective.
msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.

autonet

Use the “autonet” command to view and configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:
msh> autonet

❖ Configuration
You can configure AutoNet settings.
msh> autonet {on|off}

• {on} means “active” and {off} means “inactive”.

❖ Current interface priority configuration display
msh> autonet priority
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❖ Interface priority configuration
msh> autonet priority “interface_name”

• You can give interface's AutoNet parameter priority.
• Priority settings are available when multiple interfaces are installed.
• wlan can be specified only when the IEEE 802.11b interface is installed.

Note
❒ If an interface is not selected, the current interface connection settings remain

in effect.

Reference
For details about AutoNet, refer to autonet parameters.

bonjour(rendezvous)
Use the “bonjour(rendezvous)” command to display bonjour(rendezvous)-re-
lated settings.

❖ View settings
Bonjour settings are displayed.
msh> bonjour

❖ Bonjour service name setting
You can specify the bonjour service name.
msh> bonjour cname “computer name”

• The computer name can be entered using up to 63 alphanumeric characters.

❖ Bonjour Installation location information setting
You can enter information about the location where the printer is installed.
msh> bonjour location “location”

• Information about location can be entered using up to 32 alphanumeric
characters.

❖ Setting order of priority for each protocol
• diprint

msh> bonjour diprint [0–99]

• lpr
msh> bonjour lpr [0–99]

• ipp
msh> bonjour ipp [0–99]

You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller
numbers indicate higher priority.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ IP TTL setting
msh> bonjour ip ttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass through). 

Note
❒ The default is 255.

❖ Resetting the computer name and location information
You can reset the computer name and location information.
msh> bonjour clear {cname | location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.

❖ Interface configuration
msh> bonjour linklocal “interface_name”

• If many types of interface are installed, configure the interface that com-
municates with linklocal address.

• If you do not specify an interface, the Ethernet interface is automatically se-
lected.

• wlan can be specified only when the IEEE 802.11b interface is installed.

btconfig

Use the “btconfig” command to make Bluetooth settings.

❖ View settings
Bluetooth settings are displayed.
msh> btconfig

❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.
msh> btconfig {private | public}

• The default is {public}.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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devicename

Use the “devicename” command to display and change the printer name.

❖ View settings
msh> devicename

❖ Printer name configuration
msh> devicename name “string”

• Enter a printer name using up to 31 alphanumeric characters.
• Set single names for each printer.

❖ Printer name initialization
msh> device name clearname

• Reset the printer name to its default.

dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.
msh> dhcp

❖ Configuration
You can configure DHCP.
msh> dhcp “interface_name” {on|off}

• Click {on} to enable DHCP. Click {off} to disable DHCP.
• If the DNS server address and domain name are obtained from DHCP, be

sure to click {on}.
• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Current interface priority configuration display
msh> dhcp priority

❖ Interface priority configuration
msh> dhcp priority “interface_name”

• You can select which interface has DHCP parameter priority.
• Priority settings are available when multiple interfaces are installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ DNS server address selection
msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user.

• To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”.

❖ Domain name selection
msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”.

diprint

The direct printing port enables direct printing from a network-connected computer.
Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:
msh> diprint
Example output:
port 9100
timeout=300(sec)
bidirect on
con multi
apl async

• The “port” specifies the port number of the direct printing port.
• The “bidirect” setting indicates whether the direct printing port is bidirec-

tional or not.

❖ Setting timeout
msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting
data from the network.

• The default is 300 seconds.

❖ Specifying the number of concurrent connections
msh> diprint conn {multi | single}

• The above command specifies the number of concurrent diprint connec-
tions. Specify “multi” for multiple connections or “single” for a single con-
nection.

• The default is “multi”.
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❖ Specifying the timeout and APL termination settings
msh> diprint apl {async | cync}

• Specifies whether or not to synchronize the timeout and APL termination.

dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:
msh> dns

❖ IPv4 DNS server configuration
The following command enables or disables the IPv4 DNS server address:
msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:
msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.
• You can register up to three IPv4 DNS server numbers.
• You cannot use “255.255.255.255” as the DNS server address.

❖ IPv6 DNS server configuration
The following command enables or disables the IPv6 DNS server address:
msh> dns “number” server6 “server address”

• You can register IPv6 DNS Server address.
• You can register up to three IPv6 DNS server numbers.

❖ Dynamic DNS function setting
msh> dns “interface_name” ddns {on|off}

• You can set the dynamic DNS function “active” or “inactive”.
• {on} means “active” and {off} means “inactive”.
• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Specifying the record overlap operation
msh> dns overlap {update|add}

• You can specify operations performed when records overlap.
• update

To delete old records and register new records.
• add

To add new records and store the old records.
• When CNAME overlaps, it is always changed, irrespective of settings.

❖ CNAME registration
msh> dns cname {on|off}

• You can specify whether to register CNAME.
• {on} means “active” and {off} means “inactive”.
• The CNAME registered is the default name beginning with rnp. CNAME

cannot be changed.

❖ A records registration
msh> dns arecord {dhcp|own}

• {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings
msh> dns interval “time”

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.

domainname

Use the “domainname” command to display or configure the domain name set-
tings.
You can configure the Ethernet interface or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:
msh> domainname
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❖ Interface domain configuration
msh> domainname “interface_name”

❖ Setting the Domain Name
msh> domainname “interface_name” name “domain name”

• A domain name can be entered using up to 63 alphanumeric characters.
• The Ethernet interface and IEEE 802.11b interface will have the same domain name.
• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Deleting the Domain Name
msh> domainname “interface_name” clear name

help

Use the “help” command to display the available command list and the proce-
dures for using those commands.

❖ Command list display
msh> help

❖ Display of procedure for using commands
msh> help “command_name”

hostname

Use the “hostname” command to change the printer name.

❖ View settings
msh> hostname

❖ IPv4 Configuration
msh> hostname “interface_name ” “printer_name”

• Enter the printer name using up to 63 alphanumeric characters.
• You cannot use a printer name starting with “RNP” or “rnp”.
• The Ethernet interface and IEEE 802.11b interface will have the same printer name.
• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Initializing the printer name for each interface
msh>hostname “interface_name” clear “name”

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

❖ View settings
msh> ifconfig

❖ IPv4 Configuration
msh> ifconfig “interface_name” “parameter” “address”

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

The following explains how to configure an IPv4 address 192.168.15.16 on
Ethernet interface.
msh> ifconfig ether 192.168.15.16

❖ IPv6 Configuration
msh> ifconfig ether inet6 “interface_name ” “prefixlen”
The following explains how to configure a IPv6 address to 2001:DB8::100 with
prefix length 64 on the Ethernet interface.
msh> ifconfig ether inet6 2001:DB8::100 64

❖ Netmask configuration
msh> ifconfig “interface_name” netmask “address”
The following explains how to configure a subnet mask 255.255.255.0 on Eth-
ernet interface.
msh> ifconfig ether netmask 255.255.255.0

❖ Broadcast address configuration
msh> ifconfig “interface_name” broadcast “address”

❖ Changing the Interface
msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11b Interface
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Note
❒ To get the above addresses, contact your network administrator.
❒ Use the default configuration if you cannot obtain setting addresses.
❒ The IP address, subnet mask and broadcast address are the same as that for

the ethernet interface and IEEE 802.11b interface.
❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.

If interfaces are changed, the new interface inherits the configuration.
❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, out-
put tray, and printer language.

❖ Printer information display
msh> info

Reference
For details about displayed contents, see p.231 “Getting Printer Information
over the Network”.

ipp

Use the “ipp” command to view and configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:
msh> ipp

❖ IPP timeout configuration
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.
msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is “off”.
msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.
• Use “off” to remove a user's authorization.
• If user authorization is specified, register a user name. You can register up

to 10 users.
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❖ IPP user configuration
Configure IPP users according to the following messages:
msh> ipp user
The following message appears:
msh> Input user number (1 to 10):
Enter the number, user name, and password.
msh> IPP user name:user1
msh> IPP password:*******
After configuring the settings, the following message appears:
User configuration changed.

ipv6

Use the “ipv6” command to display and configure IPv6 settings.

❖ View Setting
msh> ipv6

❖ IPv6 stateless address
msh> ipv6 stateless {on|off}

lpr

Use the “lpr” command to view and configure LPR settings.

❖ View Setting
msh> lpr

❖ Checking host name when deleting the job
msh> lpr chkhost {on|off}

netware

Use the “netware” command to configure the NetWare settings such as the print
server name or file server name.

❖ Netware Printer Server Names
msh> netware pname “character string”

• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names
msh> netware fname

• Enter the NetWare file server name using up to 47 characters.
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❖ Encap type
msh> netware encap {802.3|802.2|snap|ethernet2|auto}

❖ Remote Printer Number
msh> netware rnum {0–254}

❖ Timeout
msh> netware timeout {3–255}

❖ Printer server mode
msh> netware mode pserver
msh> netware mode ps

❖ Remote printer mode
msh> netware mode rprinter
msh> netware mode rp

❖ NDS context name
msh> netware context character string

❖ SAP interval
msh> netware “sap_interval”

❖ Setting login mode for file server
msh> netware login server

❖ Setting login mode for NDS tree
msh> netware login tree

❖ Setting login mode for NDS tree name
msh> netware tree “NDS name”

❖ File transfer protocol
msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

• If you do not specify the protocol, the current setting is displayed. 

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX
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passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password
msh> passwd

• Enter the current password.
• Enter the new password.
• Renter the new password to confirm it.

❖ Changing the Password of the administrators using the Supervisor
msh> passwd {Administrator ID}

• Enter the new password.
• Renter the new password to confirm it.

Note
❒ Be sure not to forget or lose the password.
❒ The password can be entered using up to 32 alphanumeric characters. Pass-

words are case-sensitive. For example, “R” is not the same as “r”.

prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display
msh> prnlog

• Displays 16 previous print jobs.
msh> prnlog “ID Number”

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

Note
❒ For details about displayed contents, see p.231 “Getting Printer Information

over the Network”.

route

Use the “route” command to view andcontrol the routing table.

❖ All route information display
msh> route get “destination”

• Specify the IPv4 address to destination.
“0.0.0.0” cannot be specified as destination address.
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❖ Enabling/disabling Specified IPv4 Destination
msh> route active {host|net} “destination” {on | off}

• You can turn the specified destination on or off. Host becomes the default
setting.

❖ Adding IPv4 Routing Table
msh> route add {host|net} “destination” “gateway”

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table.

• Specify the IPv4 address to destination and gateway.
• Host becomes the default setting.

❖ Setting Default IPv4 Gateway
msh> route add default gateway

❖ Deleting specified IPv4 destination from Routing Table
msh> route delete {host|net} “destination”

• Host becomes the default setting.
• IPv4 address of destination can be specified.

❖ Setting IPv6 Default Gateway
msh> route add6 default gateway

❖ Adding a specified IPv6 destination to Routing Table
msh> route add6 {destination} prefixlen gateway

• Specify the IPv6 address to destination and gateway.

❖ Deleting a specified IPv6 destination from Routing Table
msh> route delete6 {destination} prefixlen

• Specify the IPv6 address to destination and gateway.

❖ Display information about a specified IPv6 route information
msh> route get6 {destination}

• Specify the IPv6 address to destination and gateway.

❖ Enabling/disabling a specified IPv6 destination
msh> route active6 {destination} prefixlen {on | off}

❖ Route initialization
msh> route flush
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Note
❒ The maximum number of IPv4 routing tables is 16.
❒ The maximum number of IPv6 routing tables is 2.
❒ Set a gateway address when communicating with devices on an external net-

work.
❒ The same gateway address is shared by all interfaces.
❒ “Prefixlen” is a number between 1 and 128.

set

Use the "set" command to set the protocol information display "active" or "inactive".

❖ View settings
The following command displays protocol information (active/inactive).
msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Net-
ware, SCSI print, PictBridge and SMB appears.

msh> set parallel

msh> set usb

msh> set bluetooth

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs

msh> set rfu
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msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

❖ Configuration
• Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to "active" or "inactive".
msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http,
bonjour, and sftp

msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and
sftp6.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}

msh> set snmp {up | down}
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msh> set ssl {up | down}

msh> set ssl6 {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set ssh {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}

show

Use the “show” command to display network interface board configuration set-
tings.

❖ View settings
msh> show

• If “-p” is added, you can view settings one by one.

Reference
For details about the information displayed, see p.239 “Configuring the Net-
work Interface Board”.

slp

Use “slp” command to view and configure SLP settings.
msh> slp ttl “ttl_val”

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1 and Netware 6/6.5. Using the “slp” command, you can con-
figure the value of TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.
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smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.

❖ Computer Name settings
msh> smb comp “computer name”

• Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.

❖ Working Group Name settings
msh> smb group “work group name”

• Set workgroup name using up to 15 characters

❖ Comment settings
msh> smb comment “comment”

• Set comment using up to 31 characters

❖ Notify print job completion
msh> smb notif {on | off}

• To notify print job completion, specify “on”. Otherwise, specify “off”

❖ Deleting Computer Name
msh> smb clear comp

❖ Deleting Group Name
msh> smb clear group

❖ Deleting Comment
msh> smb clear comment

❖ View Protocol
msh> smb protocol 
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snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings
msh> snmp

• Default access settings 1 is as follows:
Community name:public
IPv4 address:0.0.0.0
IPv6 address:::
IPX address:00000000:000000000000
Access type:read-only
Effective Protocol:IPv4/IPv6/IPX

• Default access settings 2 is as follows:
Community name:admin
IPv4 address:0.0.0.0
IPv6 address:::
IPX address:00000000:000000000000
Access type:read-write
Effective Protocol:IPv4/IPv6/IPX

• If "-p" is added, you can view settings one by one.
• To display the current community, specify its registration number.

❖ Display
msh> snmp ?

❖ Community name configuration
msh> snmp “number” name “community_name”

• You can configure ten SNMP access settings numbered 1-10.
• The printer cannot be accessed from SmartDeviceMonitor for Admin or

SmartDeviceMonitor for Client if “public” is not registered in numbers 1-
10. When changing the community name, use SmartDeviceMonitor for
Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

❖ Deleting community name
msh> snmp “number” clear name
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❖ Access type configuration
msh> snmp “number” type “access_type”

❖ Protocol configuration
msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols “active” or “inactive”: If you
set a protocol “inactive”, all access settings for that protocol are disabled.

• Specify “ipv4” for IPv4, “ipv6” for IPv6, or “ipx” for IPX/SPX.
•  {on} means “active” and {off} means “inactive”.
• All protocols cannot be turned off concurrently.

❖ Configuration of protocol for each registration number
msh> snmp “number” active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, acti-
vating it here has no effect.

❖ Access configuration
msh> snmp “number” {ipv4|ipv6|ipx} “address”

• You can configure a host address according to the protocol used.
• The network interface board accepts requests only from hosts that have

IPv4, IPv6, and IPX addresses with access types of “read-only” or “read-
write”. Enter “0” to have network interface board accept requests from any
host without requiring a specific type of access.

• Enter a host address to deliver “trap” access type information to.
• To specify IPv4 or IPv6, enter “ipv4” or “ipv6” followed by a space, and

then the IPv4 or IPv6 address.
• To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-

lowed by a decimal, and then the MAC address of the network interface
board.

❖ sysLocation configuration
msh> snmp location

❖ Deleting sysLocation
msh> snmp clear location

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages
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❖ sysContact setting
msh> snmp contact

❖ Deleting sysContact
msh> snmp clear contact

❖ SNMP v1v2 function configuration
msh> snmp v1v2 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration
msh> snmp v3 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration
msh> snmp trap {v1|v2|v3} {on|off}

• Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration
msh> snmp remote {on|off}

• Specify “on” to enable, and “off” to disable the SNMP v1v2 setting.

❖ SNMP v3 TRAP configuration display
msh> snmp v3trap

msh> snmp v3trap {1-5}

• If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP
msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} “address”

❖ Configuring a sending protocol for SNMP v3 TRAP
msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

❖ Configuring a user account for SNMP v3 TRAP
msh> snmp v3trap {1-5} account “account_name”

• Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account
msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm
msh> snmp v3auth {md5|sha1}
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❖ Configuring SNMP v3 encryption
msh> snmp v3priv {auto|on}

• Set “auto” for automatic encryption configuration
• Set “on” for mandatory encryption configuration.

sntp

The printer clock can be synchronized with a NTP server clock using Simple Net-
work Time Protocol (SNTP). Use the “sntp” command to change SNTP settings.

❖ View settings
msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.
msh> sntp server “IP_address”

❖ Interval configuration
msh> sntp interval “polling_time”

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.
• If you set 0, the printer synchronizes with the NTP server only when you

turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖ Time-zone configuration
msh> sntp timezone “+/-hour_time”

• You can specify the time difference between the printer clock and NTP
server clock. The values are between –12:00 and +13:00.

spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.
You can only specify diprint, lpr, ipp, ftp, smband sftp protocol.
• The “spoolsw” command for configuring Job Spool settings is available only

when the optional hard disk is installed.

❖ View settings
The Job Spool setting appears.
msh> spoolsw

❖ Job Spool setting
msh> spoolsw spool {on | off}
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Note
❒ Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting
msh> spoolsw clear job {on | off}

• When the printer power is cut during job spooling, this determines wheth-
er to reprint the spooled job.

❖ Protocol configuration
msh> spoolsw diprint {on | off}
msh> spoolsw lpr {on | off}
msh> spoolsw ipp {on | off}
msh> spoolsw smb {on | off}
msh> spoolsw ftp {on | off}
msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, smb and sftp.

ssdp

Use the “ssdp” command to view and configure SSDP settings.

❖ View settings
msh> ssdp

❖ Setting effective time
msh> ssdp profile {1801–86400}
The default is 10800 seconds.

❖ Advertise packet TTL settings
msh> ssdp ttl {1–255}
The default is 4.

ssh

Use the “ssh” command to view and configure SSH settings.

❖ View settings
msh> ssh

❖ Data compression communication settings
msh> ssh compression {on|off}
The default is “on”.

❖ SSH/SFTP communication port setting
msh> ssh port {22, 1024–65535}
The default is 22.
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❖ SSH/SFTP communication timeout setting
msh> ssh timeout {0–65535}
The default is 300.

❖ SSH/SFTP communication login timeout setting
msh> ssh logintimeout {0–65535}
The default is 300.

❖ Setting an open key for SSH/SFTP
msh> ssh genkey {512|768|1024} "character string"
Create an open key for SSH/SFTP communication.
Usable characters are ASCII 0x20-0x7e (32 bytes) other than “0”.
The default key length is 1024, and the character string is blank.

❖ Deleting open key for ssh/sftp communication
msh> ssh delkey 

Note
❒ If you do not specify a character string, current setting is displayed.

status

Use the “status” command to display the printer status.

❖ Messages
msh> status

Reference
For details, see p.231 “Current Printer Status”.

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

❖ View message
msh> syslog

Note
❒ For details about the information displayed, see p.246 “System Log Informa-

tion”.
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upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display
msh> upnp url

❖ Public URL configuration
msh< upnp url “string”

• Enter the URL string in the character string.

web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings
msh> web

❖ URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify “1” or “2” for x as the number corresponding to the URL. Up to two
URLs can be registered and specified.
msh> web url http://”The URL or IP address you want to
register”/

❖ Deleting URLs registered as link destinations
msh> web x clear url
Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for [URL] that appears on Web Image Monitor.
Specify “1” or “2” for x as the corresponding number to the link name.
msh> web name “Name you want to display”

❖ Resetting URL names registered as link destinations
msh> web x clear name
Specify “1” or “2” for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.
msh> web help http://“Help URL or IP address”/help/

❖ Deleting Help URL
msh> web clear help
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wiconfig
Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings
msh> wiconfig

❖ View IEEE 802.11b settings
msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration
msh> wiconfig “parameter”

Parameter Value configured

mode {ap|adhoc|802.11adhoc} You can set the infrastructure mode (ap) , the 
802.11 ad hoc mode (802.11adhoc), or the ad 
hoc mode (adhoc).

The default is ad hoc mode.

ssid “ID value” You can make settings for the SSID in the in-
frastructure mode.

Usable characters are ASCII 0x20-0x7e (32 bytes).

An SSID value is set automatically to the 
nearest access point if no setting is made.

If no setting is made for the ad hoc mode, the 
same value as for the infrastructure mode or 
an ASSID value is automatically set. The de-
fault is blank.

channel frequency “channel no.” You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key. The default is “11”.

key “key value” val {1|2|3|4} You can specify the WEP key when entering 
in hexadecimal.

With a 64-bit WEP, you can use 10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key, the WEP 
specified by key phrase is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other. Put “0x”on the front 
of WEP key.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions. The default is blank.
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keyphrase “ phrase” val {1|2|3|4} You can specify the WEP key when entering 
in ASCII.

With a 64-bit WEP, you can use 10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key phrase, the 
WEP specified by key is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions.

encval {1|2|3|4} You can specify which of the four WEP keys 
is used for packet encoding. “1” is set if a 
number is not specified.

wepauth [open|shared] You can set an authorization mode when us-
ing WEP. The specified value and authorized 
mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The speed you specify here is the speed at 
which data is sent. You can receive data at 
any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc  {tkip|ccmp} You can specify WPA encryption key when 
using WPA encryption.

tkip: TKIP (default)

ccmp: CCMP (AES)

wpaauth {wpapsk|wpa} You can specify the WPA authentication 
mode when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA(802.1X) authentication

Parameter Value configured
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psk “character string” You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63 
bytes).

The default is blank.

eap {tls|ttls|leap|peap} {chap|msc-
hap|mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls 
are settings for the phase 2 method, and 
must be set when using EAP-TTLS or PEAP.

Do not make these settings when using other 
EAP authentication types. 

If you select EAP-TTLS, you can select chap, 
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 
or tls.

username “character string” You can specify the login user name for the 
Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes) 
other than “@”. The default is blank.

username2 “character string” You can specify the phase 2 username for 
EAP-TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 
bytes) other than “@”. The default is blank.

domain “character string” You can specify the login domain name for 
the Radius server.

Usable characters: ASCII0x20-0x7e (31 bytes) 
other than “@”. The default is blank.

password "character string" You can specify the login password for the 
Radius server.

Usable characters: ASCII 0x20-0x7e(128 
bytes). The default is blank.

srvcert {on|off} You can set the server certificate. The default 
is “off”.

imca {on|off} You can enable or disable the certificate 
when the intermediate certificate authority is 
present. The default is “off”.

srvid “character string” You can set the server ID and subdomain of 
the certificate server.

Parameter Value configured



Remote Maintenance by telnet

29

6

2

wins

Use the “wins” command to configure WINS server settings.

❖ Viewing settings
msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 ad-
dress, the DHCP address is the valid address.

❖ Configuration
msh> wins “interface_name” {on | off}

• {on} means “active” and {off} means “inactive”.
• Be sure to specify the interface.
• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Address configuration
Use the following command to configure a WINS server IP address:
msh> wins “interface_name” {primary|secondary} “IP ad-
dress”

• Use the “primary” command to configure a primary WINS server IPv4 ad-
dress.

• Use the “secondary” command to configure a secondary WINS server IPv4
address.

• Do not use “255.255.255.255” as the IPv4 address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.
msh> wins “interface_name” scope “scope ID”

• The scope ID can be entered using up to 31 alphanumeric characters.
• Be sure to specify the interface.
• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in Eth-
ernet board and optional IEEE 802.11b interface unit of this printer.
Using the SNMP manager, you can get information about the printer.

Important
❒ If you changed the printer's community name, change the configuration of

the connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB infor-
mation using these community names.

❖ Start SNMP Setup Tool
• Windows 95/98/Me, Windows 2000, Windows NT 4.0:

Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)
• MIB-II
• PrinterMIB
• HostResourceMIB
• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)
• MIB-II
• PrinterMIB
• HostResourceMIB
• RicohPrivateMIB
• SNMP-FRAMEWORK-MIB
• SNMP-TARGET-MIB
• SNMP-NOTIFICATION-MIB
• SNMP-USER-BASED-SM-MIB
• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the Network

This section explains details of each item displayed in the printer status and in-
formation.

Current Printer Status

The printer status can be checked using the following commands:
• UNIX: Use the “lpq” command and “rsh”, “rcp”, “ftp” and “sftp” parameters.
• mshell: Use the “status” command.

Messages Description

Access Restricted The job was canceled because user have no au-
thority.

Add staples (Booklet: Back) The staple of booklet finisher (back) is exhausted.

Add staples (Booklet: Both) The staple of booklet finisher is exhausted.

Add staples (Booklet: Front) The staple of booklet finisher (front) is exhausted.

Adjusting... The printer is initializing or calibrating.

Call Service Center There is a malfunction in the printer.

Canceled The job is reset.

Canceling Job... The job is being reset.

Key Card/Counter not inserted The printer is waiting for prepaid card or key.

Coin or amount not inserted The printer is waiting for coin to be inserted.

Coin/Key Counter not inserted The printer is waiting for coin or key counter.

Configuring... Setting is being changed.

Paper Misfeed: ADF The document feeder is open.

Cover Open: Duplex Unit The cover of the duplex unit is open.

Cover Open: Finisher The cover of Finisher is open.

Cover Open: Front The front cover is open.

Cover Open: Front/Left The front cover or left cover is open.

Cover Open: Top The top cover is open.

Data Size Error The data size error occurred.

Empty: Black Toner The black toner cartridge is almost empty.

Empty: Cyan Toner The cyan toner cartridge is almost empty.

Empty: Magenta Toner The magenta toner cartridge is almost empty.

Empty: Yellow Toner The yellow toner cartridge is almost empty.

Energy Saver Mode The printer is in Energy Saver Mode.

Error An error has occurred.
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Error at Printer: Red LED An error has occurred.

Error in Printer An error has occurred.

Error: Address Book An error has occurred in the data of the ad-
dress book.

Error: Command Transmission An error has occurred in the printer.

Error: DIMM Value A memory error occurred.

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Memory Switch A memory switch error has occurred.

Error: Optional Font An error has occurred in the font file of the printer.

Error: Optional RAM An error has occurred in the optional memory unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description 
language.

Error: USB Interface An error has occurred in the USB interface.

Error: Wireless Card Wireless card is not inserted during start up, 
or the IEEE 802.11b interface unit or the wire-
less card is taken out after start up.

Exceed Booklet Stapling Limit The printing has exceeded the stapling limit of 
the booklet finisher.

Full: Finisher Finisher tray is full.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Finisher Shift Tray 1, 2 The shift tray 1 and 2 of Finisher are full.

Full: Finisher Upper Tray The upper tray of Finisher is full.

Full: Hole Punch Receptacle Punch Chip receptacle for hole punch is full.

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode.

Immed. Trans. not connected It did not connect directly with the other party 
of the transmission.

Immediate Transmission Failed An error has occurred while transmitting directly.

In Use: Copier The copier is being used.

In Use: Fax The fax is being used.

In Use: Finisher Other functions is using Finisher.

In Use: Input Tray Other functions is using the input tray.

In Use: Staple Unit Other functions is using the staple unit.

Independent-supplier Toner Toner that is not recommended is set.

Key Card not inserted The printer is waiting for key card to be inserted.

Messages Description
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Key Card/Counter not inserted The printer is waiting for key card or key 
counter to be inserted.

Key Counter not inserted The printer is waiting for key counter to be left in it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or 
toner is almost running out.

Low: Cyan Toner The cyan toner cartridge is not set correctly, or 
toner is almost running out.

Low: Magenta Toner The magenta toner cartridge is not set correct-
ly, or toner is almost running out.

Low: Toner The black toner cartridge is not set correctly, or 
toner is almost running out.

Low: Yellow Toner The yellow toner cartridge is not set correctly, 
or toner is almost running out.

Malfunction: Booklet Processor There is a problem with booklet finisher.

Malfunction: Ext. Charge Unit There is a problem with external charge unit.

Malfunction: Finisher There is a problem with Finisher.

Malfunction: Interposer There is a problem with Interposer.

Malfunction: Output Tray There is a problem with output tray.

Malfunction: Staple Unit There is a problem with the staple unit.

Malfunction: Tray 1 There is a problem with tray 1.

Malfunction: Tray 2 There is a problem with tray 2.

Malfunction: Tray 3 There is a problem with tray 3.

Malfunction: Z-folding unit There is a problem with the Z-fold unit.

Memory Low: Copy Memory shortage has occurred while the copy 
was operating.

Memory Low: Data Storage Memory shortage has occurred while the doc-
ument was being accumulated.

Memory Low: Fax Scanning Memory shortage has occurred while trans-
mitting the fax.

Memory Low: Scanning Memory shortage has occurred while the scan-
ner was working.

Miscellaneous Error Other error has occurred.

Mismatch: Paper Size Indicated paper tray does not contain paper of 
selected size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of 
selected size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of 
selected type.

Near Replacing: Black PCU Prepare the new black photoconductor unit.

Messages Description
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Near Replacing: Color PCU Prepare the new color photoconductor unit.

Near Replacing: Develop. Unit C Prepare the new development unit (cyan).

Near Replacing: Develop. Unit K Prepare the new development unit (black).

Near Replacing: Develop. Unit M Prepare the new development unit (magenta).

Near Replacing: Develop. Unit Y Prepare the new development unit (yellow).

Near Replacing: Fusing Unit Prepare the new fusing unit.

Near Replacing: Maintenance Kit Prepare the new maintenance kit.

Near Replacing: Transfer Unit Prepare the new transfer unit.

Nearly Full: Waste Toner Waste toner bottle is nearly full.

Need more Staples Stapler has almost run out of staples.

No Paper: Interposer Tray There is no paper in interposer unit.

No Paper: Selected Tray There is no paper in specified tray.

No Paper: Tray 1 There is no paper in tray 1.

No Paper: Tray 2 There is no paper in tray 2.

No Paper: Tray 3 There is no paper in tray 3.

Not Detected: B2 Lever B2 lever is not correctly set.

Not Detected: Black Toner Black toner is not correctly set.

Not Detected: Cyan Toner Cyan toner is not correctly set.

Not Detected: Develop. Unit (C) The development unit (cyan) is not correctly set.

Not Detected: Develop. Unit (K) The development unit (black) is not correctly set.

Not Detected: Develop. Unit (M) The development unit (magenta) is not cor-
rectly set.

Not Detected: Develop. Unit (Y) The development unit (yellow) is not correctly set.

Not Detected: Duplex Feed Unit The duplex feed unit is not correctly set.

Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set.

Not Detected: Input Tray The paper feed tray is not correctly set.

Not Detected: Interposer Interposer unit is not correctly set.

Not Detected: Magenta Toner Magenta toner is not correctly set.

Not Detected: PCU (C) The photoconductor unit (cyan) is not correctly set.

Not Detected: PCU (K) The photoconductor unit (black) is not correctly set.

Not Detected: PCU (M) The photoconductor unit (magenta) is not correctly 
set.

Not Detected: PCU (Y) The photoconductor unit (yellow) is not correctly 
set.

Not Detected: Transfer Unit The transfer unit is not correctly set.

Messages Description
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Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Detected: Yellow Toner Yellow toner is not correctly set.

Not Detected: Z-fold'g Internal The Z-fold unit is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.

Not Reached, Data Stored Unreached job is preserved.

Offline Printer is offline.

Original on Exposure Glass The original remains on the exposure glass.

Panel Off Mode The printer is in Panel-Off mode.

Panel Off Mode>>Printing ava. The printer is in Control Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit.

Paper in Finisher The paper remains in Finisher.

Paper Misfeed: ADF The paper has jammed in Document Feeder.

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit.

Paper Misfeed: Input Tray The paper has jammed in the input tray.

Paper Misfeed: Internal/Output The paper has jammed inside the printer.

Paper on Finisher Shift Tray 2 The paper remains in Finisher Shift Tray 2.

Paper on FinisherShiftTray1, 2 The paper remains in Finisher Shift Tray 1 and 2.

Prepaid Card not inserted The printer is waiting for prepaid card to be in-
serted.

Print Complete The print was completed.

Printing Printing is in progress.

Processing Data is being processed.

RC Gate Connection Error Failed connection with RC Gate.

Ready The printer is ready to print.

Replace Black PCU It is time to replace the black photoconductor unit.

Replace Charger Kit It is time to replace the charger kit.

Replace Cleaning Web It is time to replace the Cleaning Web.

Replace PCU (Color) It is time to replace the photoconductor unit 
(color).

Replace Develop. Unit It is time to replace the development unit.

Replace Develop. Unit (Black) It is time to replace the development unit (black).

Replace Develop. Unit (Color) It is time to replace the development unit (color).

Replace Develop. Unit (Cyan) It is time to replace the development unit (cyan).

Messages Description
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Note
❒ For details about UNIX commands, see UNIX Supplement.
❒ Check the error contents that may be printed in the configuration page. For

details about printing a configuration page, see p.147 “List/Test Print Menu”.

Replace Develop. Unit (Magenta) It is time to replace the development unit (magenta).

Replace Develop. Unit (Yellow) It is exchange time of the development unit 
(yellow).

Replace Fusing Unit It is time to replace the fusing unit.

Replace Maintenance Kit It is time to replace the maintenance kit.

Replace PCU It is time to replace the photoconductor unit.

SD Card Authentication failed SD card authentication failed.

Setting Remotely The RDS setting is being processed.

Skipped due to Error Skipped the error.

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed.

Suspend / Resume Key Error Finisher stop button was pressed.

Transmission Aborted The transmission was interrupted.

Transmission Complete The transmission completion was completed.

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has oc-
curred because chaptering as well as the nor-
mal paper use the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex 
printing.

Unit Left Open: ADF Document feeder is opened.

Warming Up... The printer is warming up.

Messages Description
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Printer configuration

You can check the printer configuration using telnet.
This section explains the checking procedure for input/output tray and printer
language.
• UNIX: Use the “info” command and “rsh”, “rcp”, “ftp” and “sftp” parame-

ters.
• mshell: Use the “info” command.

❖ Input Tray

❖ Output Tray

❖ Emulation

Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.
❒ For details about mshell “info” commands, see p.210 “info”.

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

status Current status of the paper tray

• Normal:Normal

• NoInputTray: No tray

• PaperEnd:No paper

Item Description

No. ID number of the output tray

Name Name of the output tray

status Current status of the output tray

• Normal:Normal

• PaperExist:Paper exist

• OverFlow:Paper is full

• Error:Other errors

Item Description

No. ID number of the printer language used by the 
printer

Name Name of the printer language used in the 
printer

Version Version of the printer language
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Understanding the Displayed Information

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:
• UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters.
• mshell: Use the “info” command.

Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.
❒ For details about mshell “info” commands, see p.210 “info”.

Print Log Information

This is a record of the most recent 16 jobs printed.
Use the following command to display print log information:
• UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp” parameters.
• telnet : Use the “prnlog” command. See p.213 “prnlog”.

Item Description

Rank Print job status.

• active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed
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Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.
❒ For details about mshell prnlog commands, see p.213 “prnlog”.

Configuring the Network Interface Board

Use the following command to display network interface board settings:
• telnet : Use the “show” command.

Result Print Request Result

Communication Result

• OK
Print was completed normally. However, the print result may 
not be as required due to printer problems.

• NG
Printing was not completed normally.

• Canceled
An “rcp”, “rsh”, or “lpr” command print request was can-
celed, possibly due to the printing application. Not applicable 
to the “ftp” or “rprinter” command.

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.

Item Description

Common

 Mode

 Protocol Up/Down Protocol Settings

 AppleTalk 

 NetWare

 SMB

 SCSI print

 PictBridge

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Item Description
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Syslog priority

NVRAM version

Device name 

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk Settings

 Mode

 Net

 Object

 Type

 Zone

TCP/IP TCP/IP Settings

 Mode (IPv4)

 Mode (IPv6)

ftp

lpr

rsh

telnet

diprint

web

http

ftpc

snmp

ipp

autonet

Bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

Item Description
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 IPv4

DHCP

Address

Netmask

Broadcast

Gateway

 IPv6

Stateless

Manual

Gateway

 EncapType

 Host name

 DNS Domain

 Access Control Access Control Settings

  IPv4

   Access Entry [X] X cna be set between 1 and 5.

  IPv6

   Access Entry [X] X cna be set between 1 and 5.

 Time server Time Settings

 Time Zone

 Time server polling time

 SYSLOG server Websys Settings

 Home page URL1

 Home page link name1 URL of home page

 Home page URL2

 Home page link name2

 Help page URL

NetWare

 EncapType

 RPRINTER number 

 Print server name

 File server name

 Context name

 Switch

 Mode

Item Description
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 NDS/Bindery

 Packet negotiation 

 Login Mode

 Print job timeout

 Protocol

 SAP interval time

 NDS Tree Name NDS tree name

Transfer Protocol

SMB SMB Sttings

 Switch

 Mode

 Direct print 

 Notification

 Workgroup name 

 Computer name

 Comment

 Share name[1] 

 Protocol

SCSI print

 Bidi

IEEE 802.11b IEEE 802.11b Settings

 Host name 

 Communication Mode

 SSID

 Channel range

 Channel

 TX Rate

 Security

 WEP Authentication

 WEP Encryption key number

 WEP Encryption keys[X] X can be set setween 1 and 5.

 WPA Encryption

 WPA Authentication

 Pre-Shared Key

 User name

Item Description
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 Domain name

 EAP Type

 Password

 Phase 2 user name

 Phase 2 Method TTLS

 Phase 2 Method PEAP

Server cert 

 Intermediate CA

 Server ID

DNS DNS Settings

 IPv4

Server[X] X can be set between 1 and 3.

Select IPv4 DNS Server

 IPv6

Server[X] X can be set between 1 and 3.

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS Settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

Bluetooth Bluetooth Settings

Bluetooth mode

SSDP SSDP Settings

UUID

Profile

TTL

Item Description
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UPnP UPnP Settings

 URL

Bonjour Bonjour (Rendezvous) Settings

Computer Name (cname)

Local Hostname (ether)

Local Hostname (wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for Multi I/F:

SNMP SNMP Settings

SMNPv1v2

SMNPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remoto Setting

SNMPv3 Privacy

ssh ssh Settings

Compression

Port

Timeout

LoginTimeOut

AuthFree Authfree Settings

IPv4

AuthFree Entry[X] X can be set between 1 and 5.

IPv6

AuthFree Entry[X] X can be set between 1 and 5.

Parallel

USB

LPR

Iprm check host

Item Description
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Certificate

Verification

Shell mode Remote maintenance tool mode

Item Description
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Message List
This is a list of messages that appear in the printer's system log. The system log
can be viewed using the “syslog” command.

System Log Information
Use the following command to display the system log information:
• UNIX: Use the “syslog” command and “rsh”, “rcp”, “ftp”, and "sftp" parameters. 
• telnet : Use the “syslog” command.

Message Problem and solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In the print server mode) Login to the file 
server failed. Make sure that the print server is 
registered on the file server. If a password is 
specified for the print server, deleteit.

account is unavailable: Same account name be 
used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable: The authentication 
password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set, 
and only the encryption account is set.

account is unavailable: encryption is impossi-
ble.

Encryption is not possible and account is disa-
bled. This could be because:

• Security option is not installed.

• Encryption password has not been specified.

add_sess_IPv4: bad trap<IPv4 address>, com-
munity:<community name>

The IPv4 address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify the 
host IPv4 address for the TRAP destination.

add_sess_IPv6: bad trap<IPv6 address>, com-
munity:<community name>

The IPv6 address [::] is unavailable when the 
community access type is TRAP. Specify the 
host IPv6 address for the TRAP destination.

add_sess_IPv4: community<community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPv6: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPX: bad trap<IPX address>commu-
nity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_IPX: community <community-
name> already defined.

The same community name already exists. 
Use another community name.

Attach FileServer= <file servername> Connection to the file server as the nearest 
server has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the 
print queue.
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Authentication mode mismatch< SSID > Authentication mode is different to the AP. The 
required SSID is the SSID of the access point 
connected to when in infrastructure mode.

btd is disabled. Communication via Bluetooth is unavailable 
because btd is disabled in the security mode.

 Enable the btd in the security mode.

centrod is disabled. Communication via parallel connectionis una-
vailable because centrod is disabled in the se-
curity mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the 
file server has not been established. The 
number of file server users may have exceeded 
the maximum capacity of the file server.

Cannot find rprinter (<print server 
name>/<printer number>)

The printer with the number displayed on the 
print server does not exist. Make sure that the 
printer number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is re-
newed. To always assign the same IP address, 
set a static IP address to the DHCP server.

child process exec error! (process name) The network service failed to start. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representative.

Client password rejected The client's password was rejected. Check the 
client password.

Client tls certificate rejected The client's TLS certificate was rejected. Check 
the certificate.

Connected DHCP Server(<DHCP serverad-
dress>).

The IP address was successfully received from 
the DHCP server.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the 
file server has not been established. The file 
server has refused the connection. Check the 
file server configuration.

Could not attach to PServer<print server> (In the remote printermode) Connection to the 
print server has not been established. The 
print server has refused the connection. Check 
the print server configuration.

Current Interface Speed: xxxMbps Speed of the network (10Mbps, 100 Mbps, or 1Gbps).

Current IP address <currentIP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired.The printer tries 
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 
that the DHCP is on the network.

Message Problem and solutions
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dhcpcd start. The DHCPCD service (dhcp client service) has 
started.

dpsd is disabled. Communication via PictBridge is unavailable 
because PictBridge is disabled in the security 
mode. Enable PictBridge in the security mode.

Duplicate IP=<IP address>(from<MAC ad-
dress>).

The same IP address (IPv4, or IPv6 address) 
was used. Each IP address (IPv4, or IPv6 ad-
dress) must be unique. Check the address of 
the device indicated in [MAC address].

Established SPX Connection with PServer, 
(RPSocket=<socketnumber>, connID=<con-
nection ID>)

(In the remote printer mode) Connection to the 
print server has been established.

exiting The lpd service has ended and the system is 
exiting the process.

Exit pserver (In the print server mode) The print server 
function is disabled because the necessary 
print server settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used 
on NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays IEEE 802.11b communication mode.

inetd start. The inetd service has started.

Interface (interface name): Duplicate IP Ad-
dress (IP address).

The same IP (IPv4 or IPv6) address was used. 
Each IP address must be unique. Check the ad-
dress of the device indicated in [IP address].

< Interface > started with IP: < IP address > IP address (IPv4, or IPv4 address) has been set 
for the interface and is operating.

< Interface >: Subnet overlap. The same IP address (IPv, orIPv6 address) and 
the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 
user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renewtime>(sec).

The resource lease time received from the 
DHCP server is displayed in [lease time] in 
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name> 
(<IPX|IPv4|IPv6>,<NDS|BINDERY>) 

(In the print server mode)Login to the file serv-
er is in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained. 

Disconnect the USB cable, and then connect it.

Name registration success. WINS Serv-
er=<WINS server address> NetBIOS 
Name=<NetBIOS name> 

Name registration of <NetBIOS Name> to 
<WINS server address> was successful.

Message Problem and solutions
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Name registration success in Broadcast 
name=<NetBIOS Name> 

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Name registration failed. name=<NetBIOS 
name> 

Name registration of <NetBIOSName> failed. 
Change to different NetBIOS name. 

nbtd start. The nbtd service has started.

nprinter start (Netware) (In the remote printer mode) The NetWare 
service has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In the print server mode)The specified log file 
has been opened.

phy release file open failed. Replacing the network interface board is required. 
Contact your sales or service representative.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In the print server mode) The print queue 
cannot be established. Make sure that print 
queue exists on the specified file server.

Print server <print servername>has no print-
er.

(In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, 
assign the printer, and then restart it. 

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode)The print queue is not 
assigned to the printer. Using NWadmin, assign 
the print queue to the printer, and then restart it.

pserver start. (NetWare) (In the print server mode)The NetWare service 
has started.

Required file server (<file servername>) not 
found

The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started.The SAP packet 
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

server identity invalid The server ID is disabled. Check the server au-
thentication.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session <community name> already defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

Set context to <NDS contextname> An NDS context name has been set.

smbd start. (NETBIOS) The smbd service has started.

Message Problem and solutions
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SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-
tained. This could be because:

• The specified DNS server could not be found.

• No connection to the network has been es-
tablished.

• The specified DNS server could not be found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 
could not be found in the DNS server.

SMTPC: failed to connect smtp server. time-
out.

Connection to the SMTP server failed due to 
timeout. This could be because the specified 
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the 
network configuration is incorrect, so there is 
no response from the SMTP server. Check the 
SMTP server name, or the network connection 
and configuration. 

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 
could be because server other than the SMTP 
server has been specified, or the specified 
SMTP server port number is incorrect. Check 
the SMTP server name, port number, or the 
SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 
no response from SMTP. This could be be-
cause a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the SMTP 
server name, port number, or the SMTP server 
port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 
could be because no connection to the network 
has been established, or the network configura-
tion is incorrect, so there is no response from the 
SMTP server, or the specified SMTP server 
name is incorrect, or the specified SMTP server 
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the DNS Serv-
er's IP address and SMTP server's IP address, or 
the SMTP server name and SMTP port number, 
or the SMTP server's SMTP port number, or the 
network connection and configuration.

SMTPC: username or password wasn't correct. 
[response code] (information)

Connection to the SMTP server failed, because 
the specified SMTP user name is incorrect, or 
the specified SMTP password is incorrect. 
Check the SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is available.

Message Problem and solutions
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Note
❒ For details about UNIX commands and parameters, see UNIX Supplement.
❒ For details about “syslog” command, see p.224 “syslog”.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is available.

Snmp over IPX is ready. Communication over IPX with snmp is available.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The bonjour (rendezvous) function is enabled.

Terminated. The bonjour (rendezvous) function is disabled.

The print server received error <error number> 
during attempt to log in to the network. Access 
to the network was denied. Verify that the print 
server name and password are correct. 

Login to the file server failed. The print server 
is not registered or a password is specified. 
Register the print server without specifying a 
password.

too many pictures. PictBridge printing failed because too many 
image are sent during one print transacation. 
Reduce images at one print transaction.

trap account is unavailable. v3Trap cannot be sent. This could be because 
the Trap destination account is different from 
the account specified by the printer.

usbd is disable. Plug and Play function and printing is disabled 
because usbd is disabled in the security mode.

Enable usbd in the security mode.

WINS name registration: No response to serv-
er<WINS server address>

There was no response from the WINS server. 
Check the correct WINS server address is en-
tered. Alternatively, check the WINS server is 
functioning properly. 

WINS wrong scopeID=<Scope ID> An invalid scope ID was used. Use a valid scope ID.

wpa authentication Failed WPA authentication failed. Check the WPA 
configuration.

wpa authentication started WPA authentication has started.

wpa IEEE802.1X started WPA authentication has started.

wpa connecting to authenticator WPA is connecting to authenticator.

wpa link up WPA key exchange has finished, and commu-
nication has been terminated.

wpa probe response doesn't have IE. WPA probe response does not have IE.

wpa success authenticated WPA authentication was successful.

wpa success key received WPA key reception was successful.

wpa waiting for key Waiting for WPA key.

wpasupd start wpasupd has started.

wpasupd stop wpasupd has ended.

Message Problem and solutions
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Preparing Printer Server

This section explains how to configure the printer as a Windows network print-
er. The printer is configured to enabling network clients to use it. When the net-
work printer is connected via SmartDeviceMonitor for Client, you can set the
printing notification function to notify clients of the results of their print jobs.

Important
❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to

change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A Open the [Printers] window from the [Start] menu.
The [Printers] window appears.
Preparing Printer Server Server 2003, [Printers and Faxes] window appears.

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties]. The printer properties appear.

C On the [Sharing] tab, click [Shared as:].

D To share the printer with users using a different version of Windows, click
[Additional Drivers...].
If you have installed an alternative driver by selecting [Shared as:] during the
printer driver installation, this step can be ignored.

E Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the printer to use the printing notifica-
tion function of SmartDeviceMonitor for Client.

Setting the print server

Important
❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to

change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.



Using a Printer Server

254

7

A On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Print Server Setting].
The print server setting dialog box appears.

B Select the [Notify client PCs of printout/data-transmission ] check box, and then
click [OK].
After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].
Click [Cancel] to interrupt the procedure.
A dialog box appears for client setting. 

C A dialog box appears for client setting. Click [OK].
The print server setting is complete. Each client must be set to receive print
notification.

Note
❒ Current printing jobs restart from the beginning after the spooler pauses

briefly.
❒ When the expansion function is not used, the function is automatically set

as available.
❒ If you log on using an account that does not have Administrator privileges,

the client may not be notified.

Setting a Client

A On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Extended Features Settings].
A dialog box for setting the expansion function appears.

B Select the [Notify of printout/data-transmission when using print server] check box.

C Select the [Notify when using the print server] check box.

D Click [OK].
The dialog box for setting the expansion function closes.
The client setting is completed.

Note
❒ Set the printing notification function on the printer driver as well as on

SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the printer as a
“print server” or “remote printer”.

Important
❒  IPv6 cannot be used on this function.

❖ Setting procedure
• When using the printer as a print server
A Installing SmartDeviceMonitor for Admin
B Setting the network interface board.
C Turning the printer off and then back on.

• When using the printer as a remote printer
A Installing SmartDeviceMonitor for Admin.
B Setting the network interface board.
C Setting NetWare.
D Starting the print server.

Note
❒ This procedure assumes an environment is already prepared for normal Net-

Ware running the printing service setting.
❒ The procedure is explained with the following example settings:

• File server’s name …CAREE
• Print server’s name …PSERV
• Printer’s name …R-PRN
• Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin
To use the printer in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment.

Note
❒ The NetWare Client provided by Novell is required to set the printing en-

vironment using SmartDeviceMonitor for Admin under the following en-
vironments:
• NDS mode in Windows 95/98/Me
• NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

Reference
For details about installing SmartDeviceMonitor for Admin, see p.181 “In-
stalling SmartDeviceMonitor for Admin”.
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❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the printer you want to configure, print configuration
page, and then check the printer name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the printer as a print server using Net-
Ware 3.x.

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your network
administrator.

D Click [Configuration]] in the left area, and then click [NetWare].
• Print Server Name: Enter the NetWare print server name. To use the inter-

face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the specified
file server is searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.
• Print Server Protocol: Select the protocol for NetWare from the drop-down

menu.
• NCP Delivery Protocol: Select the protocol for NCP delivery.
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E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several before restarting Web Image
Monitor.

F Click [Logout].

Note
❒ To check that the configuration is made correctly, enter the following from

the command prompt.
F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details
about printing a configuration page, see p.147 “List/Test Print Menu”.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

Reference
For details about changing the printer's frame type (“NW Frame Type”),
see Hardware Guide.

Setting Up as a Print Server (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to connect the printer as a print server using Net-
Ware 4.x, NetWare 5/5.1, or NetWare 6.0.

Important
❒ When using the printer as a print server in NetWare 4.x, NetWare 5/5.1, or

NetWare 6.0, set it to the NDS mode.
❒ When using NetWare 5/5.1 or NetWare 6.0, set the printer as a print server.

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the login user name and password appears.

C Enter the login user name and password, and then click [Login].
For details about the login user name and password, consult your network
administrator.
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D Click [Configuration] in the left area, and then click [NetWare].
• Print Server Name: Enter the NetWare print server name. To use the inter-

face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the specified
file server is searched for. This item is mandatory. Use up to 47 characters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).

• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.
• Print Server Protocol: Select the protocol for NetWare from the drop-down menu.
• NCP Delivery Protocol: Select the protocol for NCP delivery.

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

Note
❒ To check that the configuration is made correctly, enter the following from

the command prompt.
F:> NLIST USER/A/B

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name with the configuration page printed from the printer. For details about
printing a configuration page, see p.147 “Printing a Configuration Page”.

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.
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Reference
For details about changing the printer's frame type (“NW Frame Type”),
see Hardware Guide.
When using the printer in a pure IP environment of NetWare 5/5.1 or Net-
Ware 6.0/6.5, see p.259 “Using Pure IP in the NetWare 5/5.1 or 6/6.5 En-
vironment”.

Using Pure IP in the NetWare 5/5.1 or 6/6.5 Environment

Follow the procedure below to connect the printer as a print server in a pure IP
environment of NetWare 5/5.1.

Important
❒ When creating a queued print server in a pure IP environment of NetWare

5/5.1 or NetWare 6.0, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

❒ To use the printer in a pure IP environment, set it to TCP/IP.

Setting up using NWadmin

A From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].
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L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].

P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

S In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click [OK].

W Check the settings, and then click [OK].

X Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To exit
CAREE: unload pserver

❖ To start
CAREE: load pserver “print_server_name”

Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.

C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your network admin-
istrator.

D Click [Configuration] in the left area, and then click [NetWare].
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E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.
F:> PCONSOLE

B Create a print queue.
When using the existing print queue, go to the procedure for creating a printer.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.

E Press {Esc} key to return to the [Available Options] menu.

F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then press
the {Enter} key.

H To create a new print server, press the {Insert} key, and then enter a print
server name.
For a currently defined print server, select a print server in the [Print Server] list.
Use the same printer name specified using NIB Setup Tool.

I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].
Use the same printer number specified as the remote printer number using
NIB Setup Tool.

L To change the printer name, enter a new name.
A name “Printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.
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M As type, select [Remote Parallel, LPT1].
The IRQ, Buffer size, Starting form, and Queue service mode are automatical-
ly configured.

N Press the {Esc} key, and then click [Yes] on the confirmation message.

O Press the {Esc} key to return to [Print Server Configuration Menu].

P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {Insert} key to select a queue serviced by the printer.
You can select several queues.

T Follow the instructions on the screen to make other necessary settings.
Following these steps, check that the queues are assigned.

U Press the {Esc} key until “Exit?” appears, and then select [Yes] to exit
PCONSOLE.

V Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To quit
CAREE: unload pserver

❖ To start
CAREE: load pserver “print_server_name”

Note
❒ If the printer works as configured, the message “Waiting for job” appears.

Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.

C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your network admin-
istrator.

D Click [Configuration] in the left area, and then click [NetWare].
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E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].

Setting Up as a Remote Printer (NetWare 4.x, 5/5.1, 6/6.5)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 4.x, 5/5.1 and 6.

Important
❒ To use the printer as a remote printer under NetWare 4.x/5/5.1, set it to NDS

mode.
❒ Do not use the printer as a remote printer when Pure IP is used.

Setting up using NWadmin

A From Windows, start NWadmin.
For details about NWadmin, see the NetWare manuals.

B Set up the network connection to a print queue. Select the object in which
the print queue is located in the directory tree, and then click [Create] on the
[Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].
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N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

P Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name] box, enter the print server name.
Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and then
click [Add] in the [Assignments] area.

U In the [Available objects] box, click the queue you created, and then click [OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer
Number].

W Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].
Use the same printer number specified as the remote printer number using
NIB Setup Tool.

X Start the print server by entering the following from the console of the Net-
Ware server.
If the print server is in operation, quit and restart it.

❖ To exit
CAREE: unload pserver

❖ To start
CAREE: load pserver “print_server_name”

Y Enter the printer server name as the context name, and then press the {OK} key.

Z Select the printer name on the context menu, and then press the {KO} key.

Setting up using Web Image Monitor

A Start Web Image Monitor.

B Click [Login].
A dialog box for entering the [Login User Name] and [Login Password] appears.
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C Enter the login user name and password, and then click [Login].
For details about the login name and password, consult your network admin-
istrator.

D Click [Configuration] in the left area, and then click [NetWare].

E Confirm the settings, and then click [OK].
Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

F Click [Logout].



Using a Printer Server

266

7



8. Special Operations under
Windows
67
2

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 95/98/Me
You can print files directly using “ftp” or “sftp” command.

❖ Windows 2000/XP, Windows Server 2003, Windows NT 4.0
You can print files directly using “lpr”, “rcp”, “ftp” or “sftp” command.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.
TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.
Consult the network administrator for the local setting information.

C To print under Windows 2000/XP, Windows Server 2003, or Windows NT
4.0, install “Printing service for UNIX” as the network application. To print
under Windows NT 4.0, install “Microsoft TCP/IP printing” as the network
application.

Reference
For details about setting up IPv4 address, see Hardware Guide.
For details about setting the IPv4 address of the printer using DHCP, see
p.323 “Using DHCP”.
This completes the setup for specifying a printer using an IPv4 address
when printing. When using a host name to specify a printer, proceed to
p.268 “Using a Host Name Instead of an IPv4 Address” and continue the
setup.



Special Operations under Windows

268

8

Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of
IPv4 address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

Reference
For details about printing a configuration page, see p.147 “Printing a Config-
uration Page”.

In other cases

Add the IPv4 address and host name of the network printer to the hosts file on
the computer used for printing. Methods of addition vary depending on operat-
ing systems.

Windows 95/98/Me

A Copy \WINDOWS\HOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

B Open the “\WINDOWS\HOSTS” file created using memo pad files, for
instance.

C Add an IP address and host name to the hosts file using the following format:
192.168.15.16 host  # NP

“192.168.15.16” is the IPv4 address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.

D Save the file.
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

A Open the hosts file using memo pad files, for instance.
The hosts file is in the following folder:
\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

“\WINNT” is the directory of the installation destination for Windows
2000/XP, Windows Server 2003, and Windows NT 4.0.

B Add an IPv4 address and host name to the hosts file using the following
format:
192.168.15.16 host  # NP

“192.168.15.16” is the IPv4 address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this format.

C Save the file.

Note
❒ When using a host name under Windows Server 2003 with IPv6 protocol,

perform host name resolution using an external DNS server. The host file
cannot be used.

Printing Commands

The following explains printing operations using the “lpr”, “rcp”, “ftp”, and
“sftp” commands.
Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:
• Windows 95/98

[Start] - [Programs] - [MS-DOS Prompt]
• Windows Me

[Start] - [Programs] - [Accessories] - [MS-DOS Prompt]
• Windows 2000

[Start] - [Programs] - [Accessories] - [Command Prompt]
• Windows XP, Windows Server 2003

[Start] - [All Programs] - [Accessories] - [Command Prompt]
• Windows NT 4.0

[Start] - [Programs] - [Command Prompt]
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Note
❒ Match the data format of the file to be printed with the emulation mode of the

printer.
❒ If the message “print requests full” appears, no print jobs can be accepted. Try

again when sessions end. For each command, the amount of possible sessions
is indicated as follows:
• lpr: 10
• rcp, rsh: 5
• ftp: 3
• sftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

Reference
The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

lpr

❖ When specifying a printer by IP address
c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass
name\file name

❖ When using a host name instead of an IP address
c:> lpr -Sprinter's host name [-Poption] [-ol] \pass
name\file name
When printing a binary file, add the “-ol” option (lowercase O, and lowercase
L).

When using a printer with the host name “host” to print a PostScript file named
“file 1” located in the “C:\PRINT” directory, the command line is as follows:
c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.
c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]

Note
❒ In file names, “*” and “?” can be used as wild cards.
❒ When printing a binary file, add the “-b” option.
When using a printer with the host name “host” to print a PostScript file named “file
1” or “file 2” located in the “C:\PRINT” directory, the command line is as follows:
c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS
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Reference
For details about registering the printer's host name in the hosts file, see p.268
“Using a Host Name Instead of an IPv4 Address”.

ftp

Use the “put” or “mput” command according to the number of files to be printed.

❖ When one file is printed
ftp> put \pass name\file name [option]

❖ When multiple files are printed
ftp> mput \pass name\file name [\pass name\file name...]
[option]

A Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the “ftp” command.
% ftp printer's IP address

B Enter the user name and password, and then press the {OK} key.
For details about the user name and password, consult your network admin-
istrator.
User:
Password:

CWhen printing a binary file, set the file mode to binary.
ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.
The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.
ftp> put C:\PRINT\file1 filetype=RPS
ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.
ftp> bye

Note
❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read

as option strings.
❒ For “mput” command, option can not be defined.
❒ For “mput” command, “*” and “?” can be used as wild cards in file names.
❒ When printing a binary file in ASCII mode, print may not come out cor-

rectly.
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sftp

To use the “sftp” command, a client software is required.
Use the client software that is compliant with ssh ver2. 

A Start the client software.
“psftp>open “host name”” appears.

B Enter the host name, and then press the {Enter} key.
“Login as: “user name”” appears.

C Enter the user name, and then press the {Enter} key.
When you access the “sftp” command initially , “Store key in cache? (y/n)”
message appears. Select whether or not to store the key and key information,
and then press the {Enter} key.
The entered “user name” and “host name” appears.

D Enter the password, and then press the {Enter} key.
The entered password will not appear.

Note
❒ Not all client can use this function.

Reference
For details, see the client software help or the manual help.



9. Mac OS Configuration
73
2

Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.
The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details.

Important
❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

Note
❒ The PostScript 3 printer driver is stored in the following folder on the CD-

ROM.
Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.
Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS 8 and 9] folder.

D Double-click the [PS Driver] folder.

E Double-click the folder of the language you use.

F Open [Disk1], and then double-click the installer icon.

G Follow the instructions on the screen.

PPD Files

A Double-click the CD-ROM drive icon.

B Double-click the [Mac OS 8 and 9] folder.

C Double-click the [Printer Descriptions] folder.
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D Double-click the folder of the language you use.

E Open the [Disk1] folder.

F Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

G Restart the Mac OS.

Setting Up PPD Files

Important
❒ Make sure that the printers are connected to an AppleTalk network before

performing the following procedure.

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

D Click [Create].

E Click the printer you want to use, and then click [Select].
A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.275 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.

Creating a Desktop Printer Icon

Important
❒ Make sure that printers are connected to the USB before performing the fol-

lowing procedure.
To use a printer connected by USB, create a desktop printer icon.

A Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

B Click [AdobePS] in [With], click [Printer (USB)] in [Create Desktop], and then
click [OK].

C Click [Change] in [USB Printer Selection].

D Select the model you are using in [Select a USB Printer:], and then click [OK].

E Click [Create].

F Enter the printer name, and then click [Save].
The printer icon appears on the desktop.

G Quit Desktop Printer Utility.
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Setting Up Options

A On the [Apple] menu, click [Chooser].

B Click the Adobe PS icon.

C In the [Select the PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

D Click [Configure].
A list of options appears.

E Select the option you want to set up, and then select an appropriate setting
for it.

F Click [OK].
The list of options closes.

G Click [OK].
The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Installing the ColorSync Profiles
ColorSync profiles enable a printer to print colors consistent with those on the
computer display. You must install the ColorSync profile to use this function.
Follow the procedure below to install the ColorSync profiles.

A Start a Mac OS.

B Double-click the hard disk icon, and then open the appropriate folder for
installing the ColorSync profiles.
The location of the appropriate folder may vary depending on the version of
the Mac OS. The following are examples:
• System: Preferences: ColorSync profiles
• System: ColorSync profiles

C Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

D Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.
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E Double-click the [Mac OS 8 and 9] folder.

F Double-click the [ColorSync Profiles] folder.

G Drag the file to the [ColorSync Profiles] folder under [System Folder].
The ColorSync profiles are installed.

Note
❒ The ColorSync profiles are consistent with color characteristics defined by

the International Color Consortium (ICC).
❒ For some computer displays, particular settings need to be created by Color-

Sync. For details, see the appropriate manuals for your computer display.

Installing Adobe Type Manager

Important
❒ Quit all applications currently running before installation. Install ATM after

you restart the computer.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.

C Double-click the CD-ROM drive con.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [ATM] folder.

F Double-click the ATM 4.6.2 installer icon.

G Follow the instructions on the screen.

HWhen the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

I On the [Apple] menu, open [Control Panel], and then click [~ATM].

J The ATM control panel opens.

Note
❒ For details about installation, see the operating instructions in the ATM

folder.



Mac OS

77

9

2

Installing Screen fonts
Follow the procedure below to install screen fonts.
The screen fonts described below can be found in the [Fonts] folder on the CD-ROM.

A Start a Mac OS.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

C Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS 8 and 9] folder.

E Double-click the [Fonts] folder.

F Double-click the [Screen font] folder.

G Double-click the [TrueType] or [Type1] folder.
Select the font type you want to use.

H Copy the fonts you want to install in [Fonts] under [System Folder].
A confirmation message appears.

I Click [OK].
The fonts are installed.

J Restart the Mac OS.

Changing to EtherTalk
Follow the procedure below to configure to a Mac OS to use EtherTalk.

A Open [Control Panel], and then double-click the AppleTalk icon.

B On the [Connect via:] pop-up menu, click [Ethernet].

C If you change zones, select a name on the [Current zone:] pop-up menu.

D Close the AppleTalk control panel.

E Restart the computer.

Note
❒ The procedures used to configure Mac OS may vary depending on the Mac

OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP.

Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk and USB.
Follow the procedure below to configure Mac OS X 10.1. If you are not using
Mac OS X 10.1, see the manual of the Mac OS X you are using for details.

Important
❒ For Mac OS X 10.1 or higher.

Note
❒ The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your network administrator.

A Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM drive icon.

C Double-click the [Mac OS X] folder.

D Double-click the [MacOSX PPD Installer] folder.

E Double-click the installer icon.

F Follow the instructions on the screen.

Setting Up the PPD File

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click [More Printers...]. Then select the zone from the second pop-up menu.

❖ Other Mac OS X
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.
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C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, select the printer you are using from the [Model
Name] popup menu.
A list of printer types appears.

D Select the PPD file for the model you are using, and then click [Add].

E Quit Printer Setup Utility.

Setting Up Options

A Start System Preferences.

B Click [Print & Fax].

C In the [Printer] list, click the name of the printer you want to use, and then
click [Printer Setup...].

D Select the option you want to set up, and then select an appropriate setting
for it.

E Click [Apply Changes].

Note
❒ If the option you want to select is not displayed, PPD files may not be set

up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Using USB Interface

Follow the procedure below to setup USB connection.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has “USB” indicated in the “Connection” column.

❖ Other Mac OS X
Click [USB] on the pop-up menu.
The connected printer appears.

C Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.
A list of printer types appears.
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D Select the connected printer from the list of printer models, and then click
[Add].

E Quit Printer Setup Utility.

Note
❒ When printing with a USB connection to a Macintosh computer, printer

language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS
X 10.2.3 or higher. Ethernet, wireless LAN connections can also be used.

A Start Printer Setup Utility.

B Click [Add].

❖ Mac OS X 10.4 or later
Click a printer that has “Bonjour” indicated in the “Connection” column.
If the zone is set, click [More Printers...], and then select the zone from the
second pop-up menu.

❖ Other Mac OS X
Click [Rendezvous] on the pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

C Select the name of the connected printer from the list of printer models, and
then click [Add].
Under Mac OS X 10.4 or later, Installable Options window appears. Select the
option you want to set up, and then select an appropriate setting for it, and
then [Continue].

D Quit Printer Setup Utility.

Note
❒ When printing with a Rendezvous connection to a Macintosh computer,

printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-
ing.
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Changing to EtherTalk

Follow the procedure below to configure a Mac OS X to use EtherTalk.

Important
❒ You need an administrator name and a password (phrase). For details, con-

sult your network administrator

A Open [System Preference], and then click the Network icon.

B Click [Built-in Ethernet] in the [Show:] list box.

C Click the [AppleTalk] tab.

D Select the [Make AppleTalk Active] check box.

E To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.

FWhen the settings are made, click [Apply Now].

G Quit [System Preference].

Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Using PostScript 3

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Normal Print
Select this for normal printing. The print job starts immediately after the print
command is given.

❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the printer. The saved job can be printed from the
printer's control panel. You can also delete the saved job.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Reference
p.285 “Using Sample Print”

❖ Locked Print
Use this function to save documents in the printer memory with a password,
and then edit and print them as you want.

Note
❒ The “User ID:” can contain to eight alphanumeric (a-z, A-Z, 0-9) charac-

ters. The “Password:” must be 4-8 digits.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Reference
p.287 “Using Locked Print”

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.
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❖ Hold Print
Use this function to temporarily hold a file in the printer, and print it from the
computer or the printer's control panel later.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Reference
p.289 “Using Hold Print”

❖ Stored Print
Use this function to store a file in the printer, and then print it from the com-
puter or the printer's control panel later.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password” must be 4-8 digits.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Reference
p.291 “Using Stored Print”

❖ Stored Print
Use this function to prints the file at once and also stores the file in the printer.

Note
❒ The “User ID:” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) char-

acters. The “Password” must be 4-8 digits.
❒ The “File Name” can contain to 16 alphanumeric (a-z, A-Z, 0-9) characters.
❒ You can assign a password to a saved document, but password assignment

is not mandatory.
❒ Entering the “User ID:” helps you distinguish your print job from others.

Reference
p.291 “Using Stored Print”
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Using Sample Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ To use this function, the optional hard disk must be installed on the printer.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 9,000 pages for Sam-
ple Print, Locked Print, Hold Print and Stored Print.

❒ Sample Print files will not appear on the display panel if they have already
been executed or deleted using the Web browser before you select “Sample
Print” from the control panel.

❒ Sample Print files printed or deleted using Web Image Monitor after you se-
lect [Sample Print] using the control panel will appear on the display panel.
However, an error message will appear if you try to print or delete those Sam-
ple Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, sample print jobs are automatically collated
by the printer driver. If the collate option is selected in the application print
dialog box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 9,000 pag-

es.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Set the number of copies to two or more.
The sample print job is sent to the printer, and one set is printed.

C In the pop-up menu, click [Job Log].

D On the [Job Type:] pop-up menu, select [Sample Print].

E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters.
The user ID associates the user with his/her jobs.

F Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining
sets.
If you want to delete a saved job, see “Deleting a Sample Print File”.

G On the printer's control panel, press [Prt.Jobs].
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H Select [Sample Print Jobs], and then press [Job List].
A list of sample print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

I Select the file you want to print by pressing it.
A list of print files stored in the printer appears.

J Press [Print] to change the number of sets to be printed.

K Enter the new number of sets using the number keys.
If you do not want to change the set quantity, perform the following steps.
You can enter up to 999 sets.
Press {Escape} to correct any entry mistakes.

L Press [Print].
The remaining sets are printed.

Note
❒ Press [Cancel] to cancel printing.
❒ When printing finishes, the stored file is deleted.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.
❒ If there is a print job outstanding, this is printed before the sample print

job.

Deleting a Sample Print File

If a printed document is not as required, you can delete the Sample Print file.

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Sample Print Jobs], and then press [Job List].
A list of sample print files stored in the printer appears.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted jobs again.
Only one file can be selected at a time.

D Press [Delete].
A confirmation screen appears.

E Press [Delete] to delete the file.
After the file is deleted the printer screen reappears.
Press [Cancel] to cancel the delete request.
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Using Locked Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ To use this function, the optional hard disk must be installed on the printer.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 9,000 pages for Sam-
ple Print, Locked Print and Hold Print.

❒ Locked Print files will not appear on the display panel if they have already
been printed or deleted using Web Image Monitor before you select [Locked
Print] using the control panel.

❒ Locked Print files printed or deleted using Web Image Monitor after you have
selected [Locked Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Locked Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, locked print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 9,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Locked Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
The user ID associates the user with his/her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see “Delete a Locked Print File”.

F On the printer's control panel, press [Prt.Jobs].
A list of print files stored in the printer appears.
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G Select [Locked Print Jobs], and then press [Job List].
A list of locked print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

H Select the file you want to print by pressing it.

I Press [Print].
The password screen appears.

J Enter the password using the scroll keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

K Press [Print].
The locked file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.

Deleting a Locked Print File

If a printed document is not as required, you can delete the Locked Print file.

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Locked Print Jobs], and then press [Job List].
A list of locked print files stored in the printer appears.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.
Only one file can be selected at a time.

D Press [Delete].
A password screen appears.

E Enter the password using the scroll keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will reappear if the password was entered incorrectly.
Press [Clear] to enter the password again.
When multiple files are selected, the printer deletes only files that correspond
to the entered password. The number of files to be deleted is displayed on the
confirmation screen.
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F Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.

Using Hold Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ To use this function, the optional hard disk must be installed on the printer.
❒ The number of pages the printer can save varies depending on the contents of

the print images. At most, the printer can save 100 jobs or 9,000 pages for Sam-
ple Print, Locked Print and Hold Print.

❒ Hold Print files will not appear on the display panel if they have already been
printed or deleted using Web Image Monitor before you select [Hold Print] us-
ing the control panel.

❒ Hold Print files printed or deleted using Web Image Monitor after you have
selected [Hold Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Hold Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, Hold print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 9,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Hold Print].

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters. File Name can also be set.
The user ID associates the user with his/her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see “Deleting a Hold Print File”.
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F On the printer's control panel, press [Prt.Jobs].
A list of print files stored in the printer appears.

G Select [Hold Print Jobs], and then press [Job List].
A list of Hold print files stored in the printer appears.
User ID, Date/Time and File Name also appear.

H Select the file you want to print by pressing it.

I Press [Print].
The Hold Print file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ To stop printing after printing has started, press the {Job Reset} key. The

file will be deleted.
❒ When printing is completed, the stored file is deleted.

Deleting a Hold Print File

If a printed document is not as required, you can delete the Hold Print file.

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Hold Print Jobs], and then press [Job List].
A list of Hold print files stored in the printer appears.
Depending on the security settings, certain print jobs may not be displayed.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.
Only one file can be selected at a time.

D Press [Delete].
A confirmation screen appears.

E Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.
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Using Stored Print

Important
❒ You need Mac OS X v10.2 or higher to use this function.
❒ To use this function, the optional hard disk must be installed on the printer.
❒ Stored Print files will not appear on the display panel if they have already

been printed or deleted using Web Image Monitor before you select [Stored
Print] using the control panel.

❒ Stored Print files printed or deleted using Web Image Monitor after you have
selected [Stored Print] using the control panel will still appear on the display
panel. However, an error message will appear if you try to print or delete
those Stored Print files.

❒ If the application has a collate option, make sure that it is not selected before
sending a print job. By default, Stored print jobs are automatically collated by
the printer driver. If the collate option is selected in the application print dia-
log box, more prints than intended may be printed.

❒ Print jobs are not saved on the hard disk in the following cases. You can check
the error log for jobs not saved.
• When there are 100 Sample Print, Locked Print, Hold Print and Stored

Print jobs saved on the hard disk.
• When the total number of pages saved on the hard disk exceeds 9,000 pages.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].

C On the [Job Type:] pop-up menu, click [Stored Print] or [Store and Print].
• [Stored Print]

Stores the file in the printer and print it later using the control panel.
• [Store and Print]

Prints the file at once and also stores the file in the printer.

D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-
Z, 0-9) characters, and then enter a 4-8 digit password in the [Password:] box.
File Name can also be set.
The user ID associates the user with his/her jobs.
You can assign a password to a saved document, but password assignment is
not mandatory.
The password must be entered when printing or deleting.

E After making the necessary settings, click [Print].
The document file is saved in the printer.
To print the document, perform the following steps.
To delete the document, see “Deleting Stored Print File”.
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F On the printer's control panel, press [Prt.Jobs].
A list of print files stored in the printer appears.

G Select [Stored Print Jobs], and then press [Job List].
A list of Stored print files stored in the printer appears.
User ID, Date/Time and File Name also appear.
Depending on the security settings, certain print jobs may not be displayed.

H Select the file you want to print by pressing it.

I Press [Print].
A confirmation screen appears.
If you have already set a password, proceed to the following step.

J Enter the password using the scroll keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
If you have not set the password, proceed to the following step.

K Press [Print].
The Stored file is printed.

Note
❒ Press [Cancel] to cancel printing.
❒ Stored Print files sent to the printer is not deleted unless you delete them

in the printer or select [Auto Delete Stored Print Jobs].

Deleting a Stored Print File

If a printed document is not as required, you can delete the Stored Print file.

A Press [Prt.Jobs].
A list of print files stored in the printer appears.

B Select [Stored Print Jobs], and then press [Job List].
A list of Stored print files stored in the printer appears.

C Select the file you want to delete by pressing it.
To cancel a selection, press the highlighted job again.

D Press [Delete].
A confirmation screen appears.
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E Enter the password using the scrool keys, and then press [OK].
A confirmation screen appears.
A confirmation screen will reappear if the password was entered incorrectly.
Press [OK] to enter the password again.

F Press [Delete].
After the file is deleted, the printer screen reappears.

Note
❒ Press [Cancel] to cancel the delete request.
❒ If you have already set a password in the printer driver, enter it to delete.

User Code

Use this to set a user code for print logging.
Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.
The following table shows the tabs or menus where you can select this function.

Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the paper sizes supported by this printer, see Hardware
Guide.

Mac OS Select the [Enable User Code] check box, and then enter a 
user code in the [User Code:] box on [Job Log] in the print 
dialog box.

Mac OS X Select the [Enable User Code] check box, and then enter a 
user code in the [User Code:] box on [Job Log] in the print 
dialog box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dia-
log box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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Fit to Paper

When the size of the document and paper size differ, set whether or not to print
according to paper size.

❖ Prompt User
Print is performed with the size of document to be printed unchanged.

❖ Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces the
print size.
If the paper size is larger than the size of document to be printed, print is not
to fit the paper size.

❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.

Input Slot

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the paper sources, see Hardware Guide.

Resolution

Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.

Reference
For more information about the resolution types, see Hardware Guide.

Mac OS [Fit to Paper] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Fit to Paper] on the [Features x] tab on [Printer Features] in 
the print dialog box.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Mac OS [Resolution] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Resolution] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Orientation Override

Use this to set the paper orientation.
The following table shows the tabs or menus where you can select this function.

You can select the following items:
• Off
• Landscape
• Portrait

Duplex Printing

Use this function to select duplex printing.

Important
❒ To use this function, the optional duplex unit must be installed on the printer.
The following table shows the tabs or menus where you can select this function.

❖ None
Disables duplex printing.

❖ Flip on Long Edge
Prints so you can open it to the long edge when bound along the long edge.

❖ Flip on Short Edge
Prints so you can open it to the short edge when bound along the short edge.

Mac OS [Orientation Override] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Orientation Override] on the [Features x] tab on [Printer Fea-
tures] in the print dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X • 10.3 or higher
The [Two Sided Printing] check box on [Layout] in the 
print dialog box.

• Other Mac OS X
The [Print on both Sides] check box on [Duplex] in the 
print dialog box.
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Color Mode

Use this function to select whether the document is printed in color or black and
white.
The following table shows the tabs or menus where you can select this function.

❖ Color
Prints color documents in full color.

Note
❒ Color images are printed using CMYK toner, Cyan, Magenta, Yellow, and

Black. CMYK represents the three primary subtractive colors.
❒ If you want to adjust the print color, use the settings in the Advanced dia-

log box accessed from the Advanced button on the [Print Quality] tab.

❖ Black and White
Prints everything, including color documents, in black and white. Black and
White printing is faster than Color. To stop black and white areas being print-
ed with CMYK toner, select [Black and White] in the printer driver as well as in
the application.

Gradation

Use this function to select a type of gradation suited to your requirements.
The following table shows the tabs or menus where you can select this function.

❖ Fast
Prints quickly but loses smoothness.

❖ Standard
Prints with good gradation.

Mac OS [Color Mode] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Color Mode] on the [Features x] tab on [Printer 
Features] in the print dialog box.

Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features x] tab on [Printer Fea-
tures] in the print dialog box.
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Color Profile

Use this function to select the color profile pattern.
The following table shows the tabs or menus where you can select this function.

❖ Auto
Use this setting to automatically configure the best color profile pattern based
on the appearance of the document to be printed.

❖ Photographic
Use this setting to enhance reproduction of photos and graphics that include
midtones.

❖ Presentation
Use this setting to enhance reproduction of documents containing text and
graphics. This CRD is best for printing colored charts, graphs, presentation
materials and so on. If you use this CRD for printing photographs, color and
gradation might not reproduce so well.

❖ Solid Color
Use this setting to print specific single colors, logos and so on.

❖ User Setting
Use this setting to print images using a CRD downloaded from your applica-
tion.

❖ CLP Simulation
Prints the output colors similar to the colors displayed on the computer
screen.

Note
❒ Use this function to select a color rendering dictionary (CRD). The CRD is re-

ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Fine] is selected for “Colour Setting”. The following items are available:
[Auto], [Photographic], [Presentation], and [Solid Color].

Mac OS [Color Profile] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer 
Features] in the print dialog box.
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Color Setting

Use this function to select the correction method used for color conversion.

Important
❒ The color rendering dictionary selected in the Color Profile setting is used.
The following table shows the tabs or menus where you can select this function.

❖ Off
No modification to the color setting.

❖ Fine
Select this setting to perform color matching based on the printer's built-in
color rendering dictionaries, and to perform CMYK conversion. This setting
performs printing at an output target of Monitor γ = 1.8.

❖ Super Fine
Select this setting to use a color rendering dictionary similar to the Fine set-
ting but is capable of producing output that is more vivid. Use this setting to
emphasize lighter colors. This setting performs printing at an output target of
Monitor γ = 2.2.

Note
❒ Use this function to select a color rendering dictionary (CRD). The CRD is re-

ferred to color matching, so you should select the appropriate CRD for the
document you are printing. The selected CRD is also referred to when [Fine]
or [Super Fine] is selected for “Color Setting”. The following items are availa-
ble: [Auto], [Photographic], [Presentation], and [Solid Color].

Toner Saving/Level Color

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Reference
For details about this function, see printer driver Help.

Mac OS [Color Profile] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer 
Features] in the print dialog box.

Mac OS [Toner Saving] on [Printer Specific Options] in the print dia-
log box.

Mac OS X [Toner Saving] on the [Features: Set x] tab on [Printer Fea-
tures] in the print dialog box.
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Collate

Use this function to enable collation. With this feature, the printer can efficiently
print collated sets of multiple-page documents.

Important
❒ To use this function, a memory unit of at least 192 MB or hard disk drive must

be installed on the printer.
❒ If you are using Mac OS or Mac OS X, make sure that the following check box-

es have not been selected.
• Mac OS

The [Collate] check box in the print dialog box.
• Mac OS X

The [Collate] check box on [Copies & Pages] in the printer dialog box.
The following table shows the tabs or menus where you can select this function.

Paper Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Reference
For details about the media type supported by this printer, see Hardware
Guide.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.
The following table shows the tabs or menus where you can select this function.

Mac OS [Collate] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Collate] on the [Features: Set x] tab on [Printer Feature] in 
the printer dialog box.

Mac OS [Paper Type] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Paper Type] on the [Features: Set x] tab on [Printer Features] 
in the print dialog box.

Mac OS [Black Over Print] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Black Over Print] on the [Features: Set x] tab on [Printer Fea-
tures] in the print dialog box.
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Image Smoothing

Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.

❖ Off
Disables image smoothing.

❖ On
Performs image smoothing unconditionally.

❖ Auto
Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

❖ Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

Note
❒ When [Auto] is selected, data processing may take a long time.
❒ When Image Smoothing is used for a mask image, this function may have an

undesired effect on the print result.

Separate into CMYK

Use this to select the print separation type.
You can separate the printing data into CMYK to specify a specific color combi-
nation.

Mac OS [Image Smoothing] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Image Smoothing] on the [Features: Set x] tab on [Printer 
Features] in the print dialog box.

Mac OS [Separate into CMYK] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Separate into CMYK] on the [Features: Set x] tab on [Printer 
Features] in the print dialog box.
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CMYK Simulation Profile

You can simulate the color tone of the printing ink.
You can select the printing ink standard from US OffsetPrint, Euroscale, Japan-
Color and PaletteColor.

Dithering

Use this function to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖ Auto
Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

❖ Photographic
Performs dithering using an appropriate pattern for photographs.

❖ Text
Performs dithering using an appropriate pattern for text.

❖ User Setting
Use this setting to print images set in half tone in your application.

Mac OS [CMYK Simulation Profile] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [CMYK Simulation Profile] on the [Features: Set x] tab on 
[Printer Features] in the print dialog box.

Mac OS [Dithering] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Dithering] on the [Features: Set x] tab on [Printer Features] 
in the print dialog box.
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Gray Reproduction

Use this function to select Black Color mode for text and line art.
The following table shows the tabs or menus where you can select this function.

❖ Black by K
Select this setting to use a black toner.

❖ Black/Gray by K
Black portions are printed in gray.

❖ CMY+K
Select this setting to use all toners.

❖ Black/Gray by K (Text only)
Prints black text in gray.

❖ Black by K (Text only)
Prints text using black toner.

Color Matching

Use this function to select whether or not you want the colors in the documents
to be adjusted before printing, so that the printed page matches the colors on the
screen closer.

❖ Image Color Control
Open the [Image Color Matching] dialog box, and then click this button to spec-
ify exactly how you want the colors on your screen adjusted before printing.

Mac OS [Gray Reproductions (Text/LineArt)] on [Printer Specific Op-
tions] in the print dialog box.

Mac OS X [Gray Reproductions (Text/LineArt)] on the [Features: Set x] 
tab on [Printer Features] in the print dialog box.
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Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Important
❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-

ity for Mac.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers

and Utilities”.
❒ Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1.

Mac OS X 10.0.x and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the printer.

A Start the Macintosh.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

C Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS 8 and 9] icon to open it.
Under Mac OS X, double-click the [Mac OS X] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer
Utility for Mac] file, and then drop it into the Macintosh hard disk.

F Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.

Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Driv-

ers and Utilities”.
❒ Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic

environment is supported.)
❒ Printer Utility for Mac cannot use Mac OS X (native mode).



Mac OS Configuration

304

9

Starting Printer Utility for Mac

Mac OS

Important
❒ Before starting Printer Utility for Mac, make sure the printer is selected in

[Chooser] on the Apple menu.

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].
Printer Utility for Mac will take a few seconds to start.

Mac OS X

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].

C In the [Available Printers:] box, select the printer you want to use.
If you change zones, select a name from [Available Network Zones:].
Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

D Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

E Click [Choose].
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Printer Utility for Mac Functions

Downloading PS Fonts

You can download the PS fonts to the printer memory or hard disk drive.

Important
❒ The following procedure to download the fonts assume that you are a system

administrator. If you are not, be sure to consult your system administrator.
❒ During the download, do not turn off the power switch, operate the panel or

open or close the cover.
❒ If the printer restarts, all the printer settings return to the defaults.
❒ Confirm that a Macintosh and the printer are connected with Appletalk.

A Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

C Select the desired font files, and then click [Open].
The list of selectable font names appears.

D After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

E Click [Download].
The fonts begin to download, and the download status is shown.

FWhen the completion message appears, click [OK].

G Click [Cancel].

Note
❒ Some fonts cannot be downloaded.
❒ Before downloading, read the documentation about the fonts you want to use.

Displaying Printer Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer memory and hard disk drive can be displayed.

A Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Click [OK].

Note
❒ The fonts displayed in italics are the default fonts.
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Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

Important
❒ You cannot delete the fonts displayed in italic.

A Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

C Select the fonts you want to delete.

D Click [Delete].
A confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

F Click [Continue], and then click [OK].

G Click [OK].

Initializing the Printer Disk

When initializing the printer hard disk, all the fonts downloaded to the printer hard disk
drive are deleted. Before initializing, be sure to check the fonts on the hard disk drive.

Important
❒ When initializing the printer hard disk drive from the control panel, all of the

data on the printer hard disk drive is deleted. Before initializing, be sure to
check the data on the hard disk drive.

❒ Do not turn off the power switch until initializing is completed, otherwise the
hard disk drive might be damaged.

A Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears. To cancel initialization, click [Cancel].

B Click [Execute].
Initializing starts.

CWhen the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

A Select [Page Setup...] on the [File] menu.

B Select the paper size.

C Click [OK].
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Printing Font Catalog

You can print the names of fonts available on the printer.

A Select [Print Fonts Catalog...] on the [File] menu.

B Click [Print].

Note
❒ The paper selected under [Page Setup] is used.

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

A Select [Print Fonts Sample...] on the [File] menu.

B Click [Print].

Note
❒ Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

Important
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G Select the printer whose name you changed, and then close the [Chooser] di-
alog box.
If there are several AppleTalk zones, select the zone the printer belongs to.
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Mac OS X

A On the [File] menu, click [Rename Printer...].

B In the [New Name:] filed enter a new name.

C Click [Rename].
The printer name is changed.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone for the Macintosh in use.

G In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.

A Select [Restart Printer] on the [File] menu.

B Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.
The fonts downloaded in the printer memory will be deleted.
If the printer restarts, all the printer settings return to the defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

A Select [Download PostScript File...] on the [Utility] menu.

B Select the file name to download, click the file name, and then click [Open].

C Type the log file name, and then click [Save].
The selected file is downloaded.
Errors are recorded in the log file.
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Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important
❒ Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone in which you want to locate the printer, and then click
[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the Apple menu, click [Chooser].

F Click the [AdobePS] icon.

G In the [AppleTalk zone:] list, select the zone you changed.

H In the [Select a PostScript Printer:] list, select the printer you want to use.

I Close the [Chooser] dialog box.

Mac OS X

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone which you want to locate the printer in, and then click
[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].

E On the [Printer Utility for Mac] menu, click [Choose Printer...].

F In the [Available Network Zones:] list, select the zone you changed.

G In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].
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Displaying the Printer Status

You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

B Confirm the current status of the printer.
You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs.

C Click [OK].

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

Important
❒ “Launch Dialogue Console” is recommended for users with an understand-

ing of PostScript.
❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

B Type the PostScript command in the editor screen.
To edit a PostScript file, select [Open] on the [File] menu to open it.
You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.
The PostScript file is sent to the printer.
The [Reply from Printer] box opens, depending on the PostScript file you sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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Using Authentication and Managing Users

This section explains how to improve this printer's security.
The setting can be done only by the administrator.

❖ Enabling Authentication
To control administrators’ and users’ access to the printer, perform adminis-
trator authentication and user authentication using login user names and
login passwords. To perform authentication, the authentication function
must be enabled.

❖ Specifying Authentication Information to Log on
Users are managed using the personal information managed in the printer’s
address book.
Enabling user authentication limits usage of printer to people registered in
the address book to use the printer. Users can be managed in the address
book by the user administrator.

❖ Specifying Which Functions are Available
This can be specified by the user administrator. Specify the functions availa-
ble to registered users. By making this setting, administrators can limit the
functions available to users.
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Preventing Information Leaks

❖ Guarding Against Unauthorized Copying (Unauthorized Copy Prevention)
Using the printer driver, mask and pattern can be embedded in the printed
document.

❖ Guarding Against Unauthorized Copying (Data security for copying)
Using the printer driver with the data security for the copying function, a doc-
ument can be printed with an embedded pattern of hidden text.
To gray out the copy or stored file of a copy-guarded document when the
document is copied or stored , the optional security module is required.

❖ Printing confidential files
Using the printer’s Locked Print, files can be stored in the printer as confiden-
tial files and then print them. Those file can be printed using the printer’s con-
trol panel and collected on the spot to prevent others from seeing it.

❖ Preventing Data Leaks Due to Unauthorized Transmission
You can specify in the address book which users are allowed to send files us-
ing the scanner or fax function.
You can also limit the direct entry of destinations to prevent files from being
sent to destinations not registered in the address book.

❖ Protecting Registered Information in the Address Book
This function allows administrator to specify which users have permission to
access the data in the address book. Usage of the data in the address book by
unregistered users can be prevented.
Administrator can also encrypt the data in the address book to protect the
data from unauthorized reading.

❖ Managing Log Files
Data security can by improved by deleting log files stored in the printer. By
transferring the log files, administrator can check the history data and identi-
fy unauthorized access.
To transfer the log data, the log collection server is required.

❖ Overwriting the Data on the Hard Disk
Before disposing of the printer, make sure all data on the hard disk is deleted.
Prevent data leakage by automatically deleting transmitted printer jobs from
memory.
To overwrite the hard disk data, the optional ipp unit is required.
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Limiting and Controlling Access

❖ Preventing Modification or Deletion of Stored Data
Users with access permission to stored files can be specified. Permit selected
users who have to access permissions to stored files to modify or delete the
files.

❖ Preventing Modification of Printer Settings
The printer settings that can be modified depend on the type of administrator
account.
Register the administrators so that users cannot change the administrator set-
tings.

❖ Limiting Available Functions
This function allows administrator to specify which users have accessibility
to each of the printer’s functions, to prevent unauthorized operation.
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Enhanced Network Security

❖ Preventing Unauthorized Access
Limit IP addresses or disable ports to prevent unauthorized access over the
network and protect the address book, stored files, and default settings.

❖ Encrypting Transmitted Passwords
Prevent login passwords, group passwords for PDF files, and IPP authentica-
tion passwords being revealed by encrypting them for transmission.
Also, encrypt the login password for administrator authentication and user
authentication.
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Configuring SSL Encryption

When accessing the printer using a Web Image Monitor or IPP, encrypted com-
munication can be established using SSL. When accessing the printer using an
application such as SmartDeviceMonitor for Admin, encrypted communication
can be established using SNMPv3 or SSL.
To protect data from interception, analysis, and tampering, install a server certifi-
cate in the printer, negotiate a secure connection, and encrypt transmitted data.

Important
❒ When using SSL, the optional hard disk or the data storage card are required.

❖ SSL (Secure Sockets Layer)

A To access the printer from a user’s computer, request for the SSL server cer-
tificate and public key.

B The server certificate and public key are sent from the printer to the user’s
computer.

C Create shared key from the user's computer, and then encrypt it using pub-
lic key.

D The encrypted shared key is sent to the printer.

AQC899S
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E The encrypted shared key is decrypted in the machine using private key.
F Transmit the encrypted data using the shared key, and then decrypt the

data at the machine to attain secure transmission.

Note
❒ To establish encrypted communication using SSL, the printer must have

the printer and scanner functions.
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Software and Utilities Included on the CD-ROM

The following softwares and utilities are included in the CD-ROMs that come
with the printer.

❖ Font Manager 2000
For installing new screen fonts, or organizing and managing fonts already in
the system. For details about Font Manager 2000, see the manual on the CD-
ROM labeled “Printer Drivers and Utilities”.

❖ SmartDeviceMonitor for Admin
For the system administrator to manage network printers.

Reference
SmartDeviceMonitor for Admin Help.

❖ DeskTopBinder - SmartDeviceMonitor for Client
For users to manage their network print status.

Reference
DeskTopBinder - SmartDeviceMonitor for Client Help.

❖ USB Printing Support
For connection to Windows 98 SE/Me computers via USB.

Viewing the contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

A Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Click [Browse This CD-ROM].
Explorer starts and displays the contents of the CD-ROM.
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Printer Drivers for This Printer

Printing requires installing a printer driver appropriate to your operating sys-
tem. The following drivers are included on the CD-ROM provided with this
printer.

❖ PCL 5c/6 printer driver
This printer driver allows the computer to communicate with the printer via
a printer language.
The following operating system is supported.
• Windows 95/98/Me, Windows 2000/XP, and Windows Server 2003

Note
❒ For Windows NT 4.0, Service Pack 6 or higher is required.

❖ RPCS printer driver
This printer driver allows the computer to communicate with the printer us-
ing a printer language. In addition to the conventional user interface, another
preset user interface is provided.
The following operating system is supported.
• Windows 95/98/Me, Windows 2000/XP, and Windows Server 2003

❖ PostScript Printer Drivers and PPD files
PostScript printer drivers and the PPD files are included on the CD-ROM pro-
vided with this printer. PostScript printer drivers allow the computer to com-
municate with the printer using a printer language. PPD files allow the
printer driver to enable specific printer functions.
The following operating system is supported.
• Windows 95/98/Me, Windows 2000/XP, Windows Server 2003, Mac OS,

and Mac OS X

Note
❒ The PostScript printer drivers and PPD files are included on the CD-ROM

labeled “Printer Drivers and Utilities”.
❒ For Mac OS, version 8.6 or higher is required. (Mac OS X Classic environ-

ment is supported.)

❖ PPD files
PPD files are included on the CD-ROM provided with this printer. PPD files
allow the printer driver to enable specific printer functions.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is an application that uses TCP/IP and IPX/SPX
to monitor network printers. It can monitor multiple network printers using IP
address. We recommend that network administrators use this application.

❖ File path
SmartDeviceMonitor for Admin is stored in the following folder on the CD-
ROM.
NETWORK\DEVMON\ADMIN\DISK1

❖ Available functions
SmartDeviceMonitor for Admin has the following functions to check:
• printer supplies such as paper or toner;
• results of print jobs executed from the computer.

Reference
For information about using SmartDeviceMonitor for Admin, see Smart-
DeviceMonitor for Admin Help.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98

Novell Client provided with Windows 95/98

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or Window NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Windows NT
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DeskTopBinder - SmartDeviceMonitor for Client
SmartDeviceMonitor for Client has the following functions. We recommend that
users install this application.
• Printing in a peer-to-peer network, using TCP/IP, and IPP from Windows

95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.
• Constantly monitoring the status of devices on the network using TCP/IP and IPX/SPX.

❖ File path
SmartDeviceMonitor for Client is stored in the following folder on the CD-ROM.
NETWORK\DEVMON\CLIENT\DISK1

❖ Available functions
SmartDeviceMonitor for Client has the following functions.
• Peer-to-peer print function

• Prints directly on the network printer without sending any data to a
print server.

• Prints on a substitute printer when there are too many jobs waiting on
the specified printer, or when an error disables printing (Recovery
Printing).

• Allocates multiple print jobs to multiple printers (Parallel Printing).
• Executes prior group registration of printers specified for Recovery

Printing or Parallel Printing.

Operating system Protocol stack

Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare Client provided with Windows 95/98/Me

Novell Client provided with Windows 95/98/Me

Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client provided with Windows 2000 or NT

Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client provided with Windows XP

Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

NetWare Client provided with Windows Server 2003

Novell Client provided with Windows Server 2003

Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client provided with Windows 2000 or Windows NT
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• Notification function
• Displays an error message when there is an error on the specified print-

er while transferring or printing data.
• Notifies a print completion. You can also be notified of the print condi-

tion, such as displaying the notice only when Recovery Printing is exe-
cuted.

• Monitoring function
• Checks printer supplies such as paper or toner.
• Simultaneously monitors multiple printers in use.
• Checks the printer's network settings and detailed information of print-

ers.
• Enables you to check the print job log using the user ID

Important
❒ For Recovery Printing or Parallel Printing, the options on the printers must

be the same. If a necessary option is not installed, a printer cannot be used
for Recovery Printing or Parallel Printing.

❒ For Recovery Printing or Parallel Printing, the paper loaded in the printers
must be the same. When a tray is selected for printing, load the same paper
in that tray in all printers.

❒ For Recovery Printing or Parallel Printing, the print results may be differ-
ent if the printers are not the same model or have exactly the same options.

❒ If you select Sample Print or Locked Print, you cannot select Recovery
Printing or Parallel Printing.

Reference
For details about using SmartDeviceMonitor for Client, see SmartDevice-
Monitor for Client Help.



Appendix

322

11
Cautions to Take When Using in a network

Connecting a Dial-up Router to a Network

When the NetWare file server and printer are on opposite sides of a router, pack-
ets are sent back and forth, causing communication charges to be incurred. Be-
cause packet transmission is a specification of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the printer instead.

Configuring the router

Filter packets so that they do not pass over the dial-up router.

Note
❒ The MAC address of the printer doing the filtering is printed on the printer

configuration page. For details about printing a configuration page, see p.147
“Printing a Configuration Page”.

❒ For details about configuring the printer if the router cannot be configured,
see the instructions below.

Configuring the printer with NetWare

A Following the setup method described earlier in this manual, configure the
file server.

B Set the frame type for NetWare environment.

Reference
For details about selecting a frame type, see p.168 “NW Frame Type”.

Configuring the printer without NetWare

AWhen not printing, the network interface board sends packets over the net-
work. Set NetWare to “inactive”.

Reference
For details about selecting protocols, see p.167 “Host Interface menu pa-
rameters”.



Cautions to Take When Using in a network

23

11
3

Using DHCP
You can use the printer in a DHCP environment. You can also register the print-
er NetBIOS name on a WINS server when it is running.
Note the following points when an Ethernet interface is simultaneously installed.

❖ When static IPv4 addresses are set for each interface
• IPv4 address: When set at the same value, the Ethernet interface is preferred.
• Subnet mask: When a value overlaps, the Ethernet interface is preferred.
• Gateway address: The value set is used. For the gateway address, set the

gateway address located in the subnetwork set by the interface. If the value
is outside the subnet range set by the interface, it operates as “0.0.0.0”.

❖ When obtaining addresses from the DHCP server
• IP Address, Subnet Mask: you can configure addresses assigned by a

DHCP server. If IPv4 addresses overlap or the same subnet IP addresses
are selected, the effective value is assigned only to the prioritized interface.
Ethernet has default interface priority.

• AutoNet: A temporary IPv4 address starting with 169.254 and not used on
the network, is assigned to the prioritized interface.

• Gateway Address, DNS Server Address, and Domain Name: You can con-
figure the addresses assigned by DHCP to the prioritized interface.
If the gateway address is beyond the range of the subnet selected for the
interface, the printer operates using "0.0.0.0".
Ethernet has default interface priority.

❖ When there are static IPv4 addresses and addresses assigned by DHCP
• IPv4 Address and subnet mask: if a static IPv4 address is the same as an ad-

dress assigned by DHCP, or the static subnet mask address and the subnet
mask address assigned by DHCP overlap, the printer uses the static IPv4 ad-
dress in terface. The interface with the DHCP setting is set by default.

• Gateway Address: operates using the address entered manually.
If a static address is not selected, or is set to 0.0.0.0, the interface using the
address assigned by DHCP is used.

Note
• NetBIOS name on a WINS server must be configured for the WINS server.
❒ Supported DHCP servers are Micontext macenu, and then press the

with Windows 2000 Server, Windows Server 2003, and Windows NT
4.0, and the DHCP server included with NetWare and UNIX.

❒ If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so the same IPv4 address is assigned every time.

❒ To use the WINS server, change the WINS server setting to “active” us-
ing the control panel.

❒ Using the WINS server, you can configure the host name via the remote
network printer port.

❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a
network via ISDN, it will result in increased line charges. This is be-
cause your computer connects to the ISDN line whenever a packet is
transferred from the printer.

❒ If there is more than one DHCP server, use the same setting for all servers.
The printer operates using data from the DHCP server that responds first.
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Using AutoNet

If the printer IPv4 address is not assigned by a DHCP server automatically, a
temporary IPv4 address starting with 169.254, which is not used on the network,
can be automatically selected by the printer.
You must change this setting to “on” to use AutoNet.

Note
❒ The IP address assigned by the DHCP server is given priority over that select-

ed by AutoNet.
❒ You can confirm the current IPv4 address on the configuration page.
❒ For more information about the configuration page, see p.148 “Interpreting

the configuration page”.
❒ When AutoNet is running, the NetBIOS name is not registered on the WINS server.
❒ The printer cannot communicate with devices that do not have the AutoNet

function. However, this printer can communicate with Macintosh computers
running Mac OS X 10.2.3. or higher.

Reference
See p.201 “autonet”.

Configuring the WINS Server
The printer can be configured to register its NetBIOS name with a WINS server
when the power is turned on. This enables the NetBIOS name of the printer to be
specified from SmartDeviceMonitor for Admin even in a DHCP environment.
This section explains configuring the WINS server.

Note
❒ The WINS server is supported with Windows NT 4.0 Server Service Pack 4 or

higher, and Windows 2000 Servers WINS Manager.
❒ For details about the WINS server settings, see Windows Help.
❒ If there is no reply from the WINS server, the NetBIOS name is registered by

broadcast.
❒ The NetBIOS name can be entered using up to 13 alphanumeric characters.

Using Web Image Monitor

A Start a Web browser.

B Enter “http://(printer's address)/” in the address bar to access the printer
whose settings you want to change.
Top Page of Web Image Monitor appears.

C Click [Login].
The dialog box for entering the user name and password appears.
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D Enter the user name and password, and then click [OK].
Contact your network administrator for information about the settings.

E In the left area, click [Configuration], and then click [Network].

F Click [TCP/IP].

G Check that [Enable] is selected for [WINS] in the [Ethernet+IEEE 802.11b] col-
umn, and then enter the WINS server IPv4 address in [Primary WINS Server]
and [Secondary WINS Server].

H Click [Apply].

I Quit Web Image Monitor.

Using telnet

See p.199 “Using telnet”.

Using the Dynamic DNS Function
Dynamic DNS is a function which dynamically updates (registers and deletes)
records (A record and PTR record) managed by the DNS server. When a DNS
server is part of the network environment to which this printer, a DNS client, is
connected, records can be dynamically updated using this function.

Updating

Updating procedure varies depending on whether the printer IP address is static
or acquired by DHCP.

Note
❒ When the dynamic DNS function is not used, records managed by the DNS

server must be updated manually, if the printer's IP address is changed.
❒ To update the record using the printer, the DNS server has to have one of the following:

• No security settings made.
• If security settings are made, an IP-specified client (this printer) permits updating.

❖ For a static IP setting
If the IP address or host name is changed, the A and PTR records are updated.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:
• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)
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❖ For DHCP settings
As a substitute for the printer, the DHCP server updates the record, and one
of the following occurs:
• When the printer acquires the IP address from the DHCP server, the

DHCP server updates the A and PTR records.
• When the printer acquires the IP address from the DHCP server, the print-

er updates the A record, and the DHCP server updates the PTR record.
If the A record is registered, CNAME is also registered. CNAMEs that can be
registered are as follows:
• Ethernet and IEEE 802.11b

RNPXXXXXX (XXXXXX represents the last 3 hexadecimal bytes of the
MAC address)

Important
❒ Dynamic update using message authentication (TSIG, SIG(0)) is not supported.

DNS servers targeted for operation

❖ For static IP setting
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003 features
• BIND 8.2.3 or higher

❖ For DHCP setup, when the printer updates the A record
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003 features
• BIND 8.2.3 or higher

❖ For DHCP setup, when the DHCP server updates records
• Microsoft DNS servers with standard Windows 2000 Server/Windows

Server 2003 features
• BIND 8.2.3 or higher
• DNS servers with standard NetWare 5 (or a higher version) features

DHCP servers targeted for operation

As a substitute for the printer, DHCP servers capable of updating the A record
and PTR record are as follows:
• Microsoft DHCP servers with standard Windows 2000 Server (Service Pack 3

or higher versions)/Windows Server 2003 features
• ISC DHCP 3.0 or higher
• DHCP server with standard NetWare 5 features

Setting the dynamic DNS function

Make settings with telnet using the “dns” command. For details, see p.206
“dns”.
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Installing Font Manager 2000

Important
❒ Under Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, install-

ing applications by Auto Run requires administrator permission. To install a
printer driver by Auto Run, log on using an account that has administrator
permission.

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.
The installer starts.

C Click [Font Manager 2000].

D Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT
4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker folder.
PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME
\(Language)\DISK1\” on the CD-ROM.
The “WIN9X_ME” folder inside the “PS” folder is for Windows 95/98/Me. Use
the folder at this level that is appropriate for the operating system you are cur-
rently using.
The third folder “(Language)” may be substituted by an appropriate language
name.
Copy the .ppd file to the PageMaker folder.
• For PageMaker 6.0 default installation

The directory is “C:\PM6\RSRC\PPD4”.
• For PageMaker 6.5 default installation

The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

• For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

Note
❒ If the driver is not set correctly after copying the “.ppd” file, printing may not

be performed properly.
❒ When using PageMaker, the optional features that can be selected by the

printer driver will not be active. The following procedure describes how to
activate the optional printer features.
A On the [File] menu, click [Print].

The [Print Document] dialog box appears.
B Make the necessary settings in the [Features] box.
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When Using Windows Terminal Service/
MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition with SP6 or higher
• MetaFrame 1.8 SP3/FR1+SP3/SP4
• MetaFrame XP 1.0 SP1/SP2/FR1

❖ Windows 2000 Server/Advanced Server
• MetaFrame 1.8 SP3/FR1+SP3/SP4
• MetaFrame XP 1.0 SP1/SP2/SP3/SP4/FR1/FR2/FR3
• MetaFrame Presentation Server 3.0
• Citrix Presentation Server 4.0

❖ Windows Server 2003
• MetaFrame XP 1.0 FR3
• MetaFrame Presentation Server 3.0
• Citrix Presentation Cerver 4.0

Supported Printer Drivers

❖ When Windows Terminal Service is operating
• PCL printer drivers
• PostScript 3
• RPCS drivers

Note
❒ Some RPCS printer driver functions do not work if Windows Terminal Serv-

ice is installed.

Limitations

The following limitations apply to the Windows Terminal Service environment.
These limitations are built in Windows Terminal Service or MetaFrame.
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❖ Windows Terminal Service
In an environment where Windows Terminal Service is installed, some printer
driver functions are unavailable, even if no Windows Terminal Service func-
tions are used. Use the install mode to install SmartDeviceMonitor for Client in
an environment where Terminal Service is running on a Windows NT Server
4.0 Terminal Server Edition or Windows 2000 Server family computer. The fol-
lowing are the two methods of installation using the install mode:
A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor

for Client.
B Enter the following command in the MS-DOS command prompt:

CHANGE USER /INSTALL
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt:
CHANGE USER /EXECUTE

Reference
For more information, see Windows Help.

❖ MetaFrame's [Auto-creating client printers]
Using [Auto-creating client printers], you can select a logical printer created by
copying the client's local printer data to the MetaFrame server. We strongly
recommend testing this function in your network environment before using
it for your work.
• The settings for optional equipment will not be stored in the server after

the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the following:
• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1

Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.

❖ MetaFrame's [Printer driver replication]
Using [Printer driver replication], you can distribute printer drivers across all
servers in a server farm. We strongly recommend testing this function in your
network environment before using it for your work.
• If the printer drivers are not properly copied, install them directly onto

each server.
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Cautions When Using Bluetooth Interface Unit

The optional Bluetooth interface unit operation mode is set to [Public] as default.
If the setting is changed to [Private], only registered computers can use this print-
er via the Bluetooth interface unit.
Check the operation mode settings using Web Image Monitor or telnet.

Reference
For details about using Web Image Monitor, see p.173 “Using Web Image
Monitor”. For details about setting items, see Web Image Monitor Help.
For details about making operation mode settings using telnet, see p.203 “bt-
config”.
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Copyright Information about Installed 
Applications

expat

Use of the software installed on this product, including the controller (hereinaf-
ter “software”) and the expat Version 1.95.2 application software (hereinafter
“expat 1.95.2”), is subject to the following conditions:
The product manufacturer provides warranty and support to the software of the
product including expat 1.95.2 and the product manufacturer allows the initial
developer of expat 1.95.2 to be free from these obligations.
Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd
and Clark Cooper
Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the “Software”), to deal in the
Software without restriction, including without limitation the rights to use,
copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, sub-
ject to the following conditions:
The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AU-
THORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAG-
ES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFT-
WARE.

Note
❒ Information on expat 1.95.2 is available at:

http://expat.sourceforge.net/

JPEG LIBRARY

• The software installed on this product is based in part on the work of the In-
dependent JPEG Group.
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NetBSD

Copyright Notice of NetBSD
For all users to use this product:
This product contains NetBSD operating system:
For the most part, the software constituting the NetBSD operating system is not
in the public domain; its authors retain their copyright.
The following text shows the copyright notice used for many of the NetBSD
source code. For exact copyright notice applicable for each of the files/binaries,
the source code tree must be consulted.
A full source code can be found at http://www.netbsd.org/.
Copyright © 1999, 2000 The NetBSD Foundation, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:
A Redistributions of source code must retain the above copyright notice, this list

of conditions and the following disclaimer.
B Redistributions in binary form must reproduce the above copyright notice,

this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

C All advertising materials mentioning features or use of this software must
display the following acknowledgment:
This product includes software developed by the NetBSD Foundation, Inc.
and its contributors.

D Neither the name of The NetBSD Foundation nor the names of its contribu-
tors may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND
CONTRIBUTORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMIT-
ED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTH-
ERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Authors Name List

All product names mentioned herein are trademarks of their respective owners.
The following notices are required to satisfy the license terms of the software
that we have mentioned in this document:
• This product includes software developed by the University of California,

Berkeley and its contributors.
• This product includes software developed by Jonathan R. Stone for the NetB-

SD Project.
• This product includes software developed by the NetBSD Foundation, Inc.

and its contributors.
• This product includes software developed by Manuel Bouyer.
• This product includes software developed by Charles Hannum.
• This product includes software developed by Charles M. Hannum.
• This product includes software developed by Christopher G. Demetriou.
• This product includes software developed by TooLs GmbH.
• This product includes software developed by Terrence R. Lambert.
• This product includes software developed by Adam Glass and Charles Hannum.
• This product includes software developed by Theo de Raadt.
• This product includes software developed by Jonathan Stone and Jason R.

Thorpe for the NetBSD Project.
• This product includes software developed by the University of California,

Lawrence Berkeley Laboratory and its contributors.
• This product includes software developed by Christos Zoulas.
• This product includes software developed by Christopher G. Demetriou for

the NetBSD Project.
• This product includes software developed by Paul Kranenburg.
• This product includes software developed by Adam Glass.
• This product includes software developed by Jonathan Stone.
• This product includes software developed by Jonathan Stone for the NetBSD

Project.
• This product includes software developed by Winning Strategies, Inc.
• This product includes software developed by Frank van der Linden for the

NetBSD Project.
• This product includes software developed for the NetBSD Project by Frank

van der Linden
• This product includes software developed for the NetBSD Project by Jason R.

Thorpe.
• The software was developed by the University of California, Berkeley.
• This product includes software developed by Chris Provenzano, the Univer-

sity of California, Berkeley, and contributors.



Copyright Information about Installed Applications

35

11
3

Samba(Ver 2.2.2-1.1)

Copyright © Andrew Tridgell 1994-1998
This program is free software; you can redistribute it and/or modify it under the
terms of the GNU General Public License as published by the Free Software
Foundation; either version 2 of the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTY; without even the implied warranty of MERCHANTABILI-
TY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public
License for more details. You should have received a copy of the GNU General
Public License along with this program; if not, write to the Free Software Foun-
dation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.

RSA BSAFE®

• This product includes RSA BSAFE® cryptographic or security protocol soft-
ware from RSA Security Inc.

• RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc.in the United States and/or other countries.

• RSA Security Inc. All rights reserved.
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Access Control,   200
appletalk

telnet,   201
AutoNet,   324
Autonet

telnet,   201

B

Black Over Print,   299
Bluetooth

telnet,   203
Bonjour,   202

C

Canceling a job
Windows,   108

canceling a print job
Mac OS,   109

Cautions When Using 
Bluetooth Interface Unit,   331

Changing the Network Interface Board 
Configuration

SmartDeviceMonitor for Admin,   182
Changing the Paper Type

SmartDeviceMonitor for Admin,   183
Changing to EtherTalk,   277, 281
CMYK Simulation Profile,   301
Collate,   112, 299
Color Matching,   302
Color Mode,   296
Color Profile,   297
Color Setting,   298
Configuring a WINS Server

Web browser,   324
Web Image Monitor,   324

Configuring SSL Encryption,   315
Configuring the Energy Saver Mode

SmartDeviceMonitor for Admin,   187
Configuring the WINS Server,   324
Control keys,   88
Control panel

hold print,   95
locked print,   92
sample print,   89
stored print,   98

Creating a Desktop Printer Icon
Mac OS,   274

D

Deleting a Hold Print File,   290
Deleting a Locked Print File,   288
Deleting a Sample Print File,   286
Deleting a Stored Print File,   292
Deleting Fonts,   306
DHCP,   204, 323
Dial-up Router,   322
Direct Printing from a Digital Camera,   119
Displaying Printer Fonts,   305
Displaying the Printer Status,   310
Displaying Web Image Monitor Help,   179
Dithering,   301
DNS,   206
dns

telnet,   206
Domain Name,   207
Downloading PostScript Files,   308
Downloading PS Fonts,   305
Duplex Printing,   295

E

Error log,   110

F

Fit to Paper,   294
Font Manager 2000,   327
Functions

Printer Utility for Mac,   305

G

Getting Printer Information over the 
Network,   231

Going to the Top Page
Web Image Monitor,   175

Gradation,   296
Gray Reproduction,   302

H

Hold Print,   283
Hold print

deleting,   98
printing,   96

Host Interface,   166
Host Name,   208
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I

IEEE 802.11b,   226
ifconfig,   209
Image Smoothing,   300
info,   210
information

Network Interface Board configuration,   
239

Network interface board configuration,   
217

print job,   238
print log,   238
system log,   224, 246

Initializing Printer Disk,   306
Input Slot,   294
Installing,   303

Printer Utility for Mac,   303
SmartDeviceMonitor for Admin,   181

Installing Adobe Type Manager
Mac OS,   276

Installing Screen fonts
Mac OS,   277

Installing the ColorSync Profiles
Mac OS,   275

Installing the PostScript 3 Printer Driver 
and PPD File

Mac OS,   273
Installing the PPD Files

Mac OS X,   278
Installing the Printer Driver

Quick Install,   1
Installing the Printer Driver Using USB

Windows 2000,   39
IPP,   210
ipv6,   211

J

Job Spool,   222
Job Type,   283

L

Language Menu,   172
Launching the Dialogue Console,   310
Level Color,   298
List Per User ID

printing all print jobs,   104
printing the selected print job,   103

List/Test Print,   147
Locked Print,   283
Locked print

deleting,   94
printing,   93

Locking the Menus on the Printer's 
Control Panel

SmartDeviceMonitor for Admin,   183
lpr,   211

M

Mac OS,   273, 285, 287, 289, 291, 295, 296, 
297, 298, 301, 302, 304

Mac OS X,   278, 295, 296, 297, 298, 301, 
302, 304

Maintenance Menu,   140
Managing User Information

SmartDeviceMonitor for Admin,   184
Memory Capacity and Paper Size,   116
Memory Erase Status Menu,   134
menu, changing,   172
Menu Chart,   131
message,   246
MIB,   230

N

netware,   211
NetWare 5/5.1,   257, 259
NetWare 6/6.5,   257, 259
Notify by e-mail function,   193
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PageMaker,   328
Page Setup,   306
Paper Input Menu,   135
Paper Settings Menu,   156
Paper Size,   293
Paper Type,   299
passwd,   213
Password,   213
PDF Direct Print,   77

Printing a PDF File Directly,   77
Printing Method,   77

PictBridge,   119
Camera Memo Printing,   126
Color Matching,   126
Date and File Name Printing,   123
Exiting PictBridge,   127
Form Printing,   126
Image Print Size,   124
Index Printing,   122
Other Reference Information,   129
Paper Size,   123
PictBridge Printing,   120
Printing Quality,   126
Print Number of Pages,   125
Trimming,   123
What Can Be Done on This printer,   122
What is PictBridge?,   119
When PictBridge Printing Does Not 

Work,   128
PostScript 3,   283
printer driver,   318
Printer Status Notification by E-mail

Notify by e-mail function,   193
Printer Utility for Mac,   303, 304, 305, 306, 

307, 308, 309, 310
Printing a Configuration Page,   147
Printing Commands

Printing Files Directly from Windows,   269
Printing Files Directly from Windows,   267
Printing Font Catalog,   307
Printing Font Sample,   307
Printing with Bluetooth Connection

Windows,   48
Printing with Parallel Connection

Windows 2000,   44
Print Job List,   85
prnlog,   213
Pure IP,   259

R

remote printer, setup
NetWare4.x, 5/5.1, 6/6.5,   263

Renaming the Printer,   307
Resolution,   294
Restarting the Printer,   308
route,   213

S

Sample Print,   283
Sample print

deleting,   91
printing,   90

Security Options,   164
Selecting the Zone,   309
Separate into CMYK,   300
set,   215
Setting a Password

SmartDeviceMonitor for Admin,   187
Setting Up as a Print Server,   259

NetWare3.x,   256
NetWare 4.x,   257

Setting Up as a Remote Printer
NetWare3.x,   261
NetWare4.x, 5/5.1, 6/6.5,   263

Setting Up Options
Mac OS,   275
Mac OS X,   279

Setting Up PPD Files
Mac OS,   274

Setting Up the PPD File
Mac OS X,   278

Setup
Printing Files Directly from Windows,   267

show,   217
slp,   217
SmartDeviceMonitor for Admin,   319

Installing,   181
SmartDeviceMonitor for Client,   320
smb,   218
SNMP,   230
snmp,   219
sntp,   222
spoolsw,   222
SSL (Secure Sockets Layer),   315
status

telnet,   224
Stored Print,   283
Stored print

deleting,   101
printing,   99

System Menu,   151
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TCP/IP address,   209
telnet,   199

Autonet,   201
WINS,   229

Toner Saving,   298
Types of Menu Configuration and Mode

Web Image Monitor,   177

U

Unauthorized copy control,   81
data security for copying,   81
mask type,   83

User Code,   293
Using a Host Name Instead of an IP 

Address
Printing Files Directly from Windows,   268

Using Hold Print,   289
Using Locked Print,   287
Using Rendezvous

Mac OS X,   280
Using Sample Print,   285
Using Stored Print,   291
Using the Dynamic DNS Function,   325
Using USB Interface

Mac OS X,   279

W

Web Image Monitor,   173
Windows

canceling a job,   108
Windows 2000

printer properties, PCL,   56
printer properties, PostScript 3,   71
printer properties, RPCS,   63

Windows 95/98/Me
printer properties, PCL,   55
printer properties, PostScript 3,   70
printer properties, RPCS,   62

Windows NT 4.0
document defaults, PCL 5c,   60
document defaults, PostScript 3,   75
document defaults, RPCS,   68
printer properties, PCL,   59
printer properties, PostScript 3,   74
printer properties, RPCS,   67

Windows Server 2003
printer properties, PCL,   58
printer properties, PostScript 3,   73
printer properties, RPCS,   65

Windows XP
printer properties, PCL,   58
printer properties, PostScript 3,   73
printer properties, RPCS,   65

WINS
telnet,   229
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